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1. INTRODUCTION

Mulberry is a powerful, easy to use electronic mail (email) and calendar program that
allows you to send, access, and manage email and calendars. Mulberry also helps you
manage other related information, such as contact information.

To ensure maximum compatibility with existing email servers, Mulberry uses Internet-
standard protocols: IMAP and POP3 for reading email messages, SMTP for sending email
messages, MIME for sending and receiving attachments within messages, IMSP and ACAP
for storage of preferences and address books on a remote server, and LDAP for address
lookups. It also uses http, WebDAV and CalDAV for storing and retrieving calendar data.

Mulberry has been designed to fully exploit the graphical user interface provided by the
Mac OS, Windows and Unix. For example, Mulberry supports drag and drop so that
selected items, such as messages, addresses, or any text, can be dragged onto other items
to facilitate copying of items from one location to another. Comprehensive ToolTips are
available throughout the program, as well as contextual menu support.
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2. GETTING STARTED

2.1 System Requirements

Hardware CPU

Mac OS X
Any PowerPC Mac OS X computer.

WINDOWS

Any x86 or Pentium based computer or
compatible that supports Windows NT 4,
Windows 2000 or Windows XP (or higher).

UNIX

Any x86 running linux or Solaris 8, any
PowerPC running linux, or any SPARC
running Solaris 8.

Memory

Mac OS X

Mulberry requires a minimum of 7Mb when
running.

WINDOWS

Mulberry typically requires 6Mb when
running.

UNIX

Mulberry typically requires 8Mb when
running.

Network

Mulberry will work with any network
hardware that provides access to TCP/IP
services: a direct Ethernet connection, TCP/IP
running over a wireless connection, or a
modem using a protocol such as PPP or SLIP.

System Software  Version

Mac OS X

OS X 10.3 or later.

WINDOWS

Mulberry is supported for Windows NT 4,
Windows 2000 and Windows XP.

UNIx

Mulberry is supported for linux RedHat 5.,
6.x, 7.x, LinuxPPC and Solaris 8.
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Networking MAac OS X

The standard TCP/IP stack provided with the
OS should suffice.

WINDOWS

Mulberry requires a Win32 TCP/IP stack. The
standard TCP/IP stack provided with the OS
should suffice.

UNIX

The standard TCP/IP stack provided with the
OS should suffice.

Speech Mulberry can read aloud incoming messages
if suitable “Text to Speech’ software is installed
on your system. If it is, Mulberry will display
a ‘Speech” menu items in the Edit menu. If it is
not installed, the ‘Speech’” menu items will not

appear.
Mac OS X

The standard “Text to Speech” software can be
used to enable speech support in Mulberry.

WINDOWS

Microsoft’s Speech SDK software version 4.0
or 5.0 is required.

UNIX
Speech is not currently supported on Unix.

2.2 Installing Mulberry

Mac OS X

To install Mulberry, simply double-click the ‘Mulberry Installer’ file on the
Mulberry CD-ROM, or the equivalent file that you downloaded from the
Internet. A standard installer will then run and give you options as to which
parts of the Mulberry distribution to install, as well as the location where it
will be installed. The “Easy Install’ option will install the application and all its
accompanying documentation. If you want to install other parts of the
distribution choose ‘Custom Install’ in the installer, and select the
components you want to install.

WinDOW

To install Mulberry, simply double-click the ‘Mulberry Setup.exe’ file on the
Mulberry CD-ROM, or the equivalent file that you downloaded from the
Internet. A standard installer will then run and give you options as to which
parts of the Mulberry distribution to install, as well as the location where it

Mulberry Reference Guide v4 17



will be installed. The ‘Typical” option will install the application and all its
accompanying documentation. If you want to install other parts of the
distribution choose ‘Custom’ in the installer, and select the components you
want to install.

UNIX

To install Mulberry copy the mulberry.tgz file suitable for your Unix
distribution from the CD-ROM, or the equivalent file that you downloaded
from the Internet, into your home directory. Decompress and untar it into
that directory. This will install the mulberry application into your home
directory, and also add the full set of plug-ins into the ~/.mulberry
directory.

2.3 Getting Help

Mac OS X

Mulberry makes extensive use of the Mac OS X help mechanism to provide
on-line help.

Mulberry also includes an online help facility to provide simple descriptions
of items while using the program. If the online help is not sufficient, then
consult this document for more detail.

WINDOWS

Mulberry makes extensive use Windows “ToolTips’ to display brief
information about controls in windows when the cursor is positioned and
held over the control for a short while.

Mulberry also includes a Windows online help facility to provide simple
descriptions of items while using the program. If the online help is not
sufficient, then consult this document for more detail.

UNIX

Mulberry makes use of “ToolTips’ for buttons and other controls in the main
windows. These are displayed when the cursor is positioned and held over
the control for a short while. Mulberry also includes a basic online help
system, available via the Help menu, that displays support information and
a few common frequently asked questions. If the online help is not sufficient,
then consult this document for more detail.

2.4  Starting Mulberry

Mac OS X
WINDOWS

Mulberry can be started in one of two ways.

* Double-click on an existing Mulberry preferences file. This has the same
effect as dropping the preferences file onto the application icon. The
application’s preferences are then taken from this file.

* Double-click the Mulberry application icon. If Mulberry is configured for
single-user mode, it will first look for a preferences file in the default
location. For Mac OS X, the default location is the Library directory in the
current user’s home directory. For Windows, the default location is the
Windows Registry. If no preferences file is found, Mulberry will present
you with an empty preferences dialog (see page 30), which must be
configured before Mulberry can be used. Please consult your network
supervisor or your Internet service provider (ISP) if you are unsure of
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the proper settings for Mulberry.

UNIX Mulberry can be started via the command line using the ‘mulberry’
command. Command line options can be used to launch it with documents
or URL information:

-h, --help
prints the list of command line options
-v, --version
prints the version number
-D <directory path>(default: user home directory)

location for .mulberry directory for default preferences and
local storage of mailboxes etc

-p <file path> (default: ~/.mulberry / preferences.mbp)
preference file to use on startup

-u <url>
mailto url to generate a draft message on startup

-d, --disconnect

prompt to start in disconnected mode if not already set to do
SO

If Mulberry is configured for multi-user mode, it will present a dialog (shown in Figure 1)
asking for personal details only. Your system administrator will have configured the other
preference information. After starting Mulberry in this mode, you can change the
preferences to suit your needs and save them in a file for later use.

Mulberry has been designed for use in either a single-user or multi-user environment. The
majority of this guide will describe the features and preference settings available in
Mulberry in its default, single-user state. Mulberry has a number of powerful
administrative options available to system administrators. These options are detailed in
the Mulberry Administrator’s Guide, which is distributed as part of the Mulberry
Administrator’s Toolkit package.

Note: If you are using a copy of Mulberry that has been pre-
configured by your system administrator or Internet service
provider, some of the features and preference settings described
in this guide may not be available to you.
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Version Mumber  4.0.0

Serial Number 51-000001
u rr Licensed to
Cyrus Daboo

Internet Mail from the Ground Up Cyrusoft International, Inc.

Login to Server:
imsp.cyrusoft.com

User ID: vince

Password: esssssss

Connection: Secure: S5L .___' Cancel '___. f OK }

Figure 1 The multi-user login dialog box

Note: The multi-user login dialog may appear slightly different or
not be displayed at all depending on the preference information
set by your system administrator or Internet service provider.

2.5 Drag and Drop

Dragging and dropping is the same process you use to manipulate files and folders in the
Finder (Mac OS X) or Windows Explorer (Windows), only in Mulberry (and other
applications that support it) it can be used to drag and drop other objects such as text or
graphics.

In Mulberry’s case, any text that you can copy or edit can be dragged and dropped to any
other text area, be it in the same window, a different window or even a window in another
application that supports text drag and drop. You can also drag and drop items such as
messages, addresses and groups, as well as incoming or outgoing file attachments. For
example, a message in a mailbox window can be dragged to another mailbox window to
copy it from one mailbox to another. There are many subtle uses of this feature in
Mulberry. For example, Mulberry can copy all the addresses in a message into an address
book if you drag the message to the address book window.

For each action which you can accomplish with drag and drop, there is always an
equivalent method to achieve the same results. For example, text can be copied and pasted
between different locations, and messages can be copied between mailboxes using a menu
command.
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2.6 Contextual Menus

Mulberry makes extensive use of contextual popup menus, which can be accessed by
holding down the control key and clicking the mouse button (Mac OS X), or by clicking
the right mouse button (Windows and Unix) in different areas of the main windows. Each
area has its own associated contextual menu that can be used as a shortcut to several
frequently used menu commands.

2.7 Using a Network Connection

If Mulberry is performing a time consuming network task (for example reading a large
message or opening a large mailbox), it will display a spinning ISI cursor (Mac OS X), or
‘hour-glass’ cursor (Windows and Unix). When this cursor is visible, you can cancel the
current network task by pressing either Escape or command-period (Mac OS X) on the
keyboard. However, this will completely terminate the network connection with the
server. In the case of IMAP servers (used to read email) or an IMSP server (used for
remote preferences and address books), Mulberry will attempt to automatically log you
back in and recover its previous state. In the case of an SMTP server, canceling the sending
of a message will leave the message window open. You can then attempt to send the
message again at a later time if you desire.
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3. BASIC CONCEPTS

Electronic mail messages are a means of communicating text and other multimedia
information between different computers. While this may sound straightforward, the
process of getting an email message from your computer to another person’s computer is
actually quite complex. In the past, Internet email was limited to text messages. However,
modern Internet email systems provide for the sending of complex non-textual
information such as documents, graphics, sound, and video.

Throughout this document, the terms ‘email client’ and ‘email server” will be used rather
frequently. An email client is simply a program, like Mulberry, that runs on your
computer and allows you to view and manipulate your email, as well as send messages to
other email users. An email server is a program that runs on another computer — most
often one controlled by your network administrator or Internet service provider. The
email server, among other things, collects new messages that have been sent to your email
address since the last time that you read your email. The server also takes care of routing
your outgoing email to the appropriate person.

The interaction between an email client and email server is governed by a number of
different complex sets of rules, or protocols. In order for you to access your email, an
email client must communicate with an email server on a regular basis. The email client
sends requests to the server (such as “send me a list of new messages”), and the server
sends a response to that request. In order for this system to work, it is essential that the
client and server speak the same “language”. It is the responsibility of companies that
write email clients and servers to adhere to the various email-related protocols that have
been established.

Similar considerations apply to managing calendaring data, and in particular sending
invitations between users to set up a meeting.

The next few sections will describe in more detail the various ways in which Mulberry
interacts with different types of servers, as well as the protocols that Mulberry utilizes to
help you read, send, and manage email and calendar data effectively.

3.1 Modes of Operation

Internet clients operate in three different ‘modes” when interacting with servers.

A client is said to operate in an online mode when it maintains a constant connection to a
server. In this scenario, a user’s mailboxes or calendars reside on the server. This mode of
operation requires that the client have constant access to a network connection. As such,
this mode of operation may not be ideal for certain situations, such as a mobile user trying
to access their data from a laptop while on an airplane. However, since the data is stored in
one central location, you can always access all of it from different locations or different
computers.

Offline mode is used when the data accessed and manipulated by the client is stored on a
local computer, such as a laptop or desktop PC. A client operating in an offline mode only
needs access to a network connection in order to contact the server and ask for new items.
If the server has new data available for that user, it can be downloaded and stored in the
appropriate local store and the network connection is terminated. This approach is
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advantageous for users who always access their data from the same computer, or who
frequently find themselves in situations where a network connection is not available.

Disconnected mode is a hybrid form of the online and offline modes described above. In a
disconnected mode scenario, the data exists both as on the server on a laptop or desktop
computer. The client can work in either an online mode, directly manipulating the data on
the server, or in an offline mode working with the local data. The key to disconnected
mode is that the client must also provide a means of synchronizing server data with their
local equivalents. Because the two data stores are kept synchronized, disconnected mode
operations provide all of the advantages of offline and online operations.

3.2 The IMAP and POP Protocols: Accessing your Email

There are two widely-used protocols for reading and manipulating Internet email. The
major difference between these two protocols lies in their support for the various modes of
operation, described in section 3.1. The IMAP protocol supports online, offline and
disconnected modes, while the POP protocol was designed to work only in an offline
mode.

3.2.1 The IMAP Protocol

The Internet Message Access Protocol (IMAP) is an Internet standard for the reading and
manipulation of electronic mail messages stored on a email server. An IMAP email client
such as Mulberry normally runs on a user’s personal computer, which contacts the IMAP
server and allows you to see and manipulate your email messages and mailboxes.

IMAP servers allow you to create and manipulate mailboxes. A mailbox is commonly a file,
stored on the IMAP server, which contains a set of messages. The IMAP server reads the
mailbox file and sends information about each message to the IMAP client, which then
displays the information to you in its own way. The IMAP server also allows a client to
read and manipulate messages in a mailbox.

Mailboxes are usually organized hierarchically on the IMAP server. This allows them to be
grouped logically according to topic. Mulberry allows you to specify different hierarchies
in which to look for mailboxes. This provides you with a method for quick access to
groups of interesting mailboxes.

3.2.1.1 Subscriptions

IMAP clients such as Mulberry have the ability to mark a set of mailboxes as ‘subscribed’
mailboxes. The IMAP client can send a specific request to the IMAP server to get the list of
subscribed mailboxes. It is up to the IMAP client to decide how to present this subscribed
mailbox list to you. Mulberry makes use of the subscribed mailboxes feature to allow you
to create a set of mailboxes that always appear at the top of the mailbox list. This is useful if
you have a set of mailboxes that you frequently use and want quick access to in the server
window.

3.2.1.2 Extensions to IMAP

Some IMAP servers support a variety of standardized extensions to the protocol. Among
the extensions Mulberry supports are access control for mailboxes, quota information for
mailboxes, and namespace information for display hierarchies.
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* Access Control for mailboxes allows you to share mailboxes with other people that
have access to your email server. You can set up privileges for mailboxes to determine
what levels of access users have.

* Quota information shows levels of resource usage on the server. For example, you
might be limited to a maximum amount of disk space or a maximum number of
messages in each mailbox.

* Namespace information allows Mulberry to detect all of the top-level display
hierarchies available on your email server. Mulberry has the ability to automatically list
these display hierarchies in the server window. Display hierarchies are discussed in
detail in section 5.4.4.4.

 Sort allows the client to have the server return the list of messages in sorted order,
without the need for the client to download the necessary sort information required to
do the sort itself. This is a major benefit for large mailboxes. Not all the sorting methods
provided by Mulberry are available on the server, so in some cases Mulberry will have
to do the sort itself, as it will if the server does not support sorting itself.

* Thread allows the client to have the server return the list of messages in a hierarchical
thread order. A ‘thread’ is a sequence of messages that are replies to an original
message. The thread sorting method groups messages in the same thread together, and
indicates, via indentation, which messages are in reply to others in the thread, allowing
the full “flow’ of conversation on topics to be followed. As with sorting, the server-side
threading is a big advantage for large mailboxes. If threading is not available on the
server, Mulberry will do threading itself.

3.2.1.3 Disconnected Mode

While IMAP email clients typically operate in an online mode, some IMAP email clients,
such as Mulberry, offer the ability to operate in disconnected mode as well. Mulberry
allows you to specify which mailboxes from an IMAP server should be synchronized when
switching between online and disconnected modes. Mulberry will automatically create the
appropriate local mailboxes to “mirror” the selected mailboxes on the IMAP email server,
as well as handle the synchronization of the local and server mailboxes automatically. Use
of disconnected mode in Mulberry is described in more detail in section 5.4.6.

3.2.2 The POP Protocol

The Post Office Protocol, version 3 (POP3) is a simpler Internet standard for downloading
email messages from a email server. As mentioned previously, POP3 was designed to
work only in offline mode. The only interaction that a POP3 client has with a POP3 email
server is in contacting the server and downloading new email messages to a local disk. As
such, POP3 mailboxes reside on your local computer rather than on the email server.

3.3 The MIME Protocol: Email is Not Just Text Anymore

Most users of modern email systems have received some sort of non-textual data with an
email message — an image, a word processing document, or some other type of file
attachment. The Multipurpose Internet Mail Extensions (MIME) protocol specifies a
method for encoding any data in such a way that it can be transmitted from one computer
to another.
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Mac OS X  Mulberry supports the use of MIME types and sub-types in conjunction with

Internet Config to ensure that files received via email are correctly mapped
to file types that the Mac OS X will recognize.

WINDOWS Mulberry supports the use of MIME types and sub-types in conjunction with

the Windows Registry to ensure that files received via email are correctly
mapped with file extensions recognized on the local machine.

UNIX Mulberry supports the use of MIME types and sub-types provided via

configuration files in the OS. Check the Unix faq webpage for the current
details on this: http:/ /www.mulberrymail.com /mulberry / unix/ faq.

3.4

The SMTP Protocol: Sending Email

The Simple Mail Transfer Protocol (SMTP) is the main Internet standard for the sending of
electronic mail messages. It does not provide any capability for a client to read email
messages. Mulberry uses SMTP to send email messages that you compose, regardless of
whether you're using IMAP or POP3 to access your messages.

3.4.1 Extensions to SMTP

Some SMTP servers support various extensions, some of which Mulberry can take
advantage of:

SMTP AUTH provides a way for an SMTP client such as Mulberry to authenticate with
the SMTP server. This allows the SMTP server to know who is trying to send email and
to configure itself appropriately. A number of SMTP servers are set to prevent
‘relaying’ — the sending of messages from someone outside of the ‘domain” of the SMTP
server to someone else also outside of the SMTP server ‘domain’. SMTP AUTH can be
used to verify outside senders as being legitimate users of that server and turn on
relaying for those users only.

Delivery Status Notifications provides a way for SMTP servers to notify the sender of a
message as to the status of that message. Status information is sent back to the original
sender of the message in the form of a special notification message that can include the
whole original message, or just the headers of the original message to help identify
which message is being referenced. Status information that can be returned is:

* ‘Success’ —indicates that the message was successfully delivered to a recipient’s in-
coming mailbox.

* ‘Failure’ - indicates that the message was rejected and not delivered to a recipient’s
mailbox.

* ‘Delay’ —indicates that the message has been delayed en-route to the recipient’s
mailbox.

SMTP SIZE provides a way for the client to indicate the size of a message about to be
submitted, and a way for the server to advertise the maximum size of message it will
allow. If the maximum size reported by the server is larger than the size Mulberry
calculates for the message, Mulberry will generate an error and the message will not be
sent.

Mulberry Reference Guide v4 25



3.5 The IMSP and ACAP Protocols: Remote Preference and Address Book
Storage

One of the many benefits of IMAP is that it allows you to access all of your email, stored on
a remote server, from different locations and computers. For users that operate in this
mode, it also makes sense to have other email-related information stored on a remote
server. For example, having your email client save its preferences on a remote server
rather than on your local machine ensures that it will have the same settings no matter
where you are. By saving your address books on a remote server, you can guarantee that
the names, email addresses, and contact information typically stored in your address book
will be available to you everywhere.

The Internet Message Support Protocol (IMSP) is used to store preference and address
book information on a remote server. If you store your preferences and address books on
an IMSP server, those resources will always be available to you, no matter what computer
you use to run Mulberry. This is particularly advantageous if you frequently use different
computers to read your email. Mulberry can be configured to use IMSP, if such a server is
available. If it is not available, preferences and address books have to be stored locally on
each computer used to run Mulberry.

In addition to storing addresses on a remote server, IMSP allows address books to be
searched on the server and shared among groups of users. Shared address books make it
easy to set up a centralized address book for a group of individuals or a workgroup, and
combined with server based searching, make it easy for co-workers to find addresses of
other people in their group.

The Application Configuration Access Protocol (ACAP) is an emerging, standardized
replacement for the IMSP protocol. Like IMSP, ACAP allows for the storage and retrieval
of information such as address books and preferences, but in a more efficient and reliable
manner. Additionally, ACAP is designed to be a more general-purpose solution than
IMSP; that is, non-email applications such as web browsers can take advantage of ACAP
for remote storage of information such as bookmarks or configuration options.

When operating in disconnected mode, Mulberry has the ability to synchronize
preferences and address books stored on IMSP and ACAP servers with the equivalent local
files.

3.6 The LDAP Protocol: Directory Assistance

The Lightweight Directory Access Protocol (LDAP) allows information about individuals
and institutions to be stored and accessed from a server. Mulberry allows you to perform
basic address lookups using one or more specified LDAP servers.

3.7 Calendar Access

3.7.1 Introduction

Mulberry now supports calendaring and scheduling features in addition to its email and
address book capability. Calendaring was added to provide a more complete PIM
(personal information manager) solution, as often schedules are managed through email.
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This combination of features in a client is now seen as essential in enterprise environments
to help manage activities.

As far as possible, the calendar support in Mulberry has been designed to be consistent
with the existing email and contacts design, to provide a familiar experience for existing
users.

Mulberry uses the iCalendar (RFC2445) data format for all local storage of calendar data,
and supplements that with XML metadata files as needed to maintain additional state
information, such as for disconnected synchronization etc. The iCalendar data files
produced by Mulberry can be used by any other calendar product that supports that
standard.

3.7.2 HTTP Web-Calendars

Mulberry supports access to calendars stored on a simple http server and accessed via http:
or webcal: URL schemes. These calendars are managed via a simple “publish /subscribe’
model. That is, each change to the calendar will overwrite the entire contents of the item
being changed, no synchronization of changes between the two will occur.

When webcal calendars are present, a “Web Calendars’ account item will automatically
appear in the calendar store list, below the local account. If web calendars have never been
used, then the account will not be present, but will automatically appear the first time a
web calendar is required.

Mulberry can set itself up as the default webcal URL handler on the local machine it is
running on, in the same manner it sets itself up as the default mailto URL handler.

3.7.3 WebDAV Calendars

Mulberry supports access to calendar hierarchies stored on a WebDAV server. Using
WebDAV it is possible to setup public, shared and private hierarchies of calendars on the
server to provide an “enterprise’ calendar solution.

Mulberry supports the WebDAV ACL (access control) capability to manage access to the
calendar files directly on the server allowing calendars to be easily shared with others, if
needed.

Mulberry will allow disconnected operations with WebDAV calendars, so that changes can
be made to a calendar whilst offline, and then sync’d up to the server the next time an
internet connection is available.

3.7.4 CalDAV Calendars

CalDAV is a new extension to WebDAYV that is currently being developed. It promises to
improve the performance of WebDAV stored calendars by using a new data layout (each
individual event etc is stored as a separate item on the server) and new options to do smart
searching, event range retrieval etc on the server.

In addition, CalDAV will support server-based scheduling options, removing the need to
use email-based scheduling when users reside on the same server.

Mulberry has support for CalDAYV, including the use of ACLs.
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Mulberry will allow disconnected operations with CalDAYV calendars, so that changes can
be made to a calendar whilst offline, and then sync’d up to the server the next time an
internet connection is available.

3.7.5 Sending and Receiving Invitations

Both events and tasks can be sent via email to other people in a standard format that
should allow them to automatically add those items directly to their own calendars,
provided the software they use allows that - if they use Mulberry it will!

3.7.6 Calendar Disconnected Mode

Mulberry will allow you to work with calendar data whilst offline. Of course calendars in
the Local calendar account are always stored locally and accessible no matter what. http
calendar account data is also stored locally and refreshed from the server as needed, either
automatically at some timed interval, or manually at the explicit request of the user.
However, this process does not involve synchronization of data — any changes result in the
entire calendar being overwritten.

Both WebDAYV and CalDAYV accounts support full two-way synchronization of data
between the client and server as needed. This is enabled by turning on the “Allow
Disconnected Operations’ option in the Options panel of the preferences for the account.
When this is on, all calendars in that account that are used (i.e. opened for display) will be
automatically synchronized as they are opened and used. This is different than the
approach used for email where each mailbox can be synchronized independently of the
others. Also, the new approach means that an explicit ‘synchronize now’ operation is no
longer needed as local data is always up to date with the server.

The new model for disconnected support now also allows individual accounts to be used in
an offline mode, even when others are online. The ‘Login’/’Logout’ toolbar button now
acts as a per-account connect/disconnect switch when the global state (as controlled via the
File menu commands) is connected. When the global state is disconnected, then all calendar
accounts are set to disconnected mode and the ‘Login’ /’"Logout’ toolbar button is disabled.

3.8 General Security Concepts

Many people don’t realize that common email protocols such as IMAP, POP3, and SMTP
dictate that personal information such as your username, password, and the text of your
email messages are transmitted over the Internet in clear text. A savvy Internet hacker has
the ability to intercept that information and use it for any number of illicit purposes. While
the chances of that happening are rare, it’s best to take advantage of security features
whenever possible. Mulberry offers security features in two important areas:
authentication, and PGP message security (via a separate PGP plugin). In addition, third-
party applications can be used to provide encrypted communications between Mulberry
and any servers.

3.8.1 Authentication Security

Authentication refers to the process by which a email client and server verify your identity.
Typically, you enter a username and password into a email client. The email client then
sends that information to the email server for verification. Unfortunately, this is
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commonly done using plain, unencrypted text. In addition to plain text, Mulberry offers
support for other popular authentication methods: Kerberos v4, GSSAPI (Kerberos v5),
CRAM-MDS5, DIGEST-MD5 and NTLM. When you use one of these authentication
methods, your password is never transmitted in clear text over the Internet, making it
difficult (if not impossible) for a hacker to obtain this information by monitoring the traffic
between the client and server.

Mulberry supports different authentication methods by a series of plugins. New
authentication methods can be added by simply adding a new plugin to the Mulberry Plug-
ins folder. They will then automatically be available for use in Mulberry the next time it
starts up.

These alternate authentication methods are available for all the different protocols listed in
the sections above. Note that in order to use any of these alternative authentication
methods, your server(s) must support that method. Contact your server administrator if
you’re not sure which authentication methods are supported by your email servers.

3.8.2 PGP Message Security

In conjunction with the Mulberry PGP or GPG Plugin, Mulberry offers seamless integration
with version 8 of PGP Corp.s” popular PGP software, and the freeware GNUpg software.
In the context of email, PGP allows you to perform several important security operations.
When sending email, PGP provides mechanisms to encrypt messages before sending them
as well as digitally “sign” messages so that the recipient can verify their authenticity. On
the receiving end, PGP allows you to decrypt messages and verify a PGP signature
attached to a message. When the Mulberry PGP plugin is installed, various menu
commands and buttons will appear to provide seamless access to the signing and
encryption capabilities of PGP.

3.8.3 S/MIME Message Security

In conjunction with the Mulberry S/MIME Plugin, Mulberry offers S/MIME cryptographic
capability. In the context of email, S/MIME allows you to perform several important
security operations. When sending email, S/MIME provides mechanisms to encrypt
messages before sending them as well as digitally “sign” messages so that the recipient can
verify their authenticity. On the receiving end, S/MIME allows you to decrypt messages
and verify an S/MIME signature attached to a message. When the Mulberry S/MIME
plugin is installed, various menu commands and buttons will appear to provide seamless
access to the signing and encryption capabilities of S/MIME.

3.8.4 Encrypted Network Traffic (SSL)

In conjunction with the Mulberry PGP Plugin (available separately), Mulberry supports the
Secure Sockets Layer (SSL) v3 protocol and the Transport Layer Security (TLS) v1
protocols. This is the equivalent of the network security provided in web browsers and
typically used to secure financial transactions on the web.

Third-party products that run on the client and server can also provide an encrypted
‘channel’” for sending data between a client program on one machine and a server program
on another. Such software uses a mechanism called ‘port-forwarding” which allows the
third-part software to interact with the client or server program without the need for those
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programs to be specifically modified to work with them. Mulberry supports port-
forwarding software of this kind.

3.9 Read Receipts Requests

Internet email offers a standard option for senders of email messages to request a receipt
message be sent back to them when the recipient of a message reads it. The sender must
explicitly turn that option on in order for it to be processed by the recipient. Mulberry
supports this directly from its Draft window.

Recipients of read receipt requests can choose at their option how to process them.
Typically there will be three choices: never send a read receipt back (users may choose this
if they have privacy concerns); always send a read receipt back; or provide a prompt each
time a read receipt request is detected, allowing the user to choose whether to send a
receipt back or not. Mulberry has preferences to allow you to choose either of these
options for read receipt processing.

Since the return of a receipt is solely at the discretion of the recipient, there is no absolute
guarantee that if you request one, one will be returned to you when the message is read.

3.10 Message Filtering

To cope with the large volumes of email that users receive these days, a popular
mechanism called filtering has been introduced and is in wide-spread use. Filtering is the
process whereby messages are automatically processed by some ‘agent’ based on their
content, and certain actions taken. For example, messages know to be important, can have
an important ‘flag’ or indicator added to them. Messages know to be worthless can be
immediately deleted and removed before the user has to see or download them. Other
messages can be automatically filed away into different mailboxes based on category.

The “agent’ that does the filtering is typically either the email client application, or some
process on the server. With client-side filtering, the client application has to download
enough information about the messages to be able to determine whether and how they
should be processed. With server-side filtering, a program on the server processes the
messages as they are being delivered. Server-side filtering takes place even when there is
no client connected to it. The advantage of this is that the client doesn’t have to waste any
of its time doing the filtering.

Mulberry supports both client- and server-side filtering, as described in full in Section 0.
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4. CONFIGURING MULBERRY

Mulberry has a number of flexible configuration options. For the basic email user, the
simple preferences panel allows quick configuration of a basic set of options necessary to
get Mulberry up and running. More advanced email users will want to explore the
advanced preferences panel, which gives you access to all of Mulberry’s powerful
configuration options — including multiple email servers, display fonts and styles, multiple
identities, and many other features.

The simple preferences panel is shown in Figure 2. The advanced preferences panel is
shown in Figure 3. For using the simple preferences consult the Mulberry QuickStart Guide.

Some of the controls in the various preferences panels may be disabled if Mulberry has
been pre-configured by your network administrator.

Preferences

Real Name: Vince Everrett]
Email Address:  vince@oyrusoft.com
User ID: vince

Mail Server: imap.cyrusoft.com

Server Type: @y mMaP () POP3 () Local

SMTP Server: smitp.cyruscft.com
Mew Mail Check: " | Save User ID
’: Mewver = Save Password
Ej Ewvery: 1 mins. f Login at Startup
| Use Alert Higrarchy
separator:

Set Signature

E Copy Outgoing Messages
Default: INBOX.sent-miail @

Figure 2 The preferences dialog in simple mode
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To save the current inthe System Folder,
preferences inafile, click here
click here

Figure 3 The preferences dialog in advanced mode

The advanced preferences dialog has two main areas:

* The central window pane is used for showing different panels that can be used to set

preferences.
MAc OS X To switch between panels, click on one of the buttons on the left hand
UNIX side of the dialog.
WINDOWS To switch between panels, click on one of the tabs at the top of the

dialog.
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* The right hand side of the dialog contains controls used to open and save preferences
files, as well as change some universal settings.

Mulberry supports storage of preferences either locally, on a local or shared hard drive, or
remotely on an IMSP or ACAP server. To switch between local and remote preferences,
click the Local or Remote radio buttons on the right-hand side of the dialog.

A set of preferences stored in a local file or remotely is called a “preference set’. You can
have as many preference sets as you like and switch between them by clicking the Open
button.

- For local preferences this will display a standard file dialog allowing you to choose a
local preference file to open.

- For remote preferences this will open a dialog showing you the available preference
sets on the remote server, and allow you to pick one to open.

One local and one remote preference set can be saved as the ‘default set’. The default
preference set is the one opened when launching Mulberry by double-clicking its icon. To
save the current preference set as the default preference set, you can click the Save
Default button.

Mac OS X  The default location for local preferences is the Library directory inside the
current user’s home directory.

WINDOWS The default location for local preferences is the Windows registry for the
current user.

UNIX The default location for local preferences is the ~/.mulberry directory.

Closing the preferences dialog by clicking the OK button will also save the current
preference set. In this case, the preference set will be saved in the same location from
which it was opened.

To save the current preference set under a different name, click the Save As... button.

- For local preferences this will bring up a standard file save dialog allowing you to
choose the name and location for the preference file.

- For remote preferences, this will open a dialog box listing the current preference
sets stored on the server, and allow you to enter a name for the new set.

Multiple preference sets allow you to quickly switch between sets of preferences while
Mulberry is running. When you load a new preference set while Mulberry is running, all of
your current server connections are terminated, and new connections are established for
the various accounts defined in the new preferences file. You can switch preference sets
while Mulberry is running in two ways. First, you can use the Open button in the
Preferences dialog to load a new local or remote preference file. You can also double-click a
local preferences file in the Finder (Mac OS X) or the Windows Explorer (Windows).

There are currently fourteen different panels to choose from in the advanced preferences
dialog, though some of these may not be present or are disabled depending on what
additional features are available to Mulberry. Each of these panels will be described in the
following subsections.
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4.1 Accounts Panel

Please check with your network supervisor or your Internet service provider (ISP) if you

are unsure of the proper settings for the Accounts panel.

Accounts Preferences

Account: imap .

Type: IMAP Mailbox

cerver: |[imap.cynusoft.com

| Authentication | Options | Extras |

Methad: | CRAM-MDS B

User ID: vince

: Save User ID
" | Save Password

Secure: | STARTTLS - TLSv] i+

| Use Client Certificate:

E Match User ID and Password

Figure 4 The Accounts preference panel

The following four settings are available regardless of the type of account chosen:

Account Selects an account for editing, creates a new account, renames or

deletes the account currently displayed.

Type The type of account currently being displayed (not editable).
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Server The internet address of the server should be entered here. This can be a
fully qualified name (e.g. imap.mulberrymail.com) or an IP address
(e.g. 206.31.218.196). To use a non-default port, add a “:" and the port
number (e.g. imap.mulberrymail.com:146). The default port numbers
for the various protocols used by Mulberry are:
* IMAP - 143 (993 with SSLv3 security)
* POP3-110 (995 with SSLv3 security)
* IMSP - 406 (906 with SSLv3 security)
» ACAP-674
e SMTP - 25 (993 with SSLv3 security)
* LDAP - 389 (636 with SSLv3 security)
* ManageSIEVE - 2000
* CalDAV -80 (443 with SSLv3 security)
* WebDAV -80 (443 with SSLv3 security)
Match User ID and To have Mulberry use the same password with a user ID that was used
Password before, turn this on. This allows you to enter your user ID and

password only once when the user ID is the same, even if logging in to
different types of servers.

Note: This option may produce undesirable results if
you use the same username but different passwords on
more than one server in the Accounts panel.

The remainder of the Accounts panel will vary depending on the type of account currently

being displayed.

4.1.1 IMAP Mailbox Account

4.1.1.1 Authentication Tab

The options available in the Authentication tab remain constant regardless of the account
type selected. The authentication methods described below are available for IMAP Mailbox
accounts and all other account types.
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[Authentic:atiun Options " Extras

Method: | CRAM-MDS _*]

User ID: vince

Save User 10
Save Password

Secure: | STARTTLS - TLSv] j

E

| Use Client Certificate:

4

Figure 5 The Authentication tab for authentication methods requiring just a
user id and password

Method To choose the authentication method to use with the current account,
click here. Mulberry currently supports Plain Text, CRAM-MD5,
DIGEST-MD5, Kerberos v4, and NTLM authentication methods. It also
supports ANONYMOUS login which does not require any additional
information.

Secure Allows you to choose between SSLv3 and TLSv1 network security
protocols to secure the entire communications between Mulberry and
the server. You need to check with your server administrator as to
which of these options is applicable in your case.

Use Client Allows you to choose an x509 personal certificate to use with SSL to
Certificate authenticate via the SSL protocol itself. When this choice is selected you
should also select ‘SSL Client Certificate’ in the Method popup.

The following options are only available when using an authentication method that
requires only a user id and password:

User ID The user ID required for you to log in to this server should be entered
here.

Save User ID To save the user ID in the preferences file so that it will be used the
next time Mulberry is launched with the current preferences file, turn
this on.
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Save Password To save the your password in the preferences file so that it will be used
the next time Mulberry is launched with the current preferences file,
turn this on.

WARNING: If this option is turned on, anyone with
access to your preferences file will be able to read your
email. Passwords are saved in encrypted form in both
local and remote preference sets.

| Authentication | Options " Extras

Method: ' Kerberos V4 ﬂ
E Use Default Server Principal
SErVer
Principal:

E Use Default User 1D
User ID:

Secure: | STARTTLS - TLSv] B

E

| Use Client Certificate:

4

Figure 6 The Authentication panel for Kerberos authentication

The following options are only available when using the Kerberos v4 authentication
method:

Use Default To have Mulberry discover the Kerberos server principal

Server Principal automatically, turn this on.

Server Principal =~ The Kerberos realm of the server should be entered here.

Use Default User  To use the default Kerberos user ID to login to the specified server

ID instead of the ID you specified in the “User ID” field, turn this on.
User ID The user ID required for you to log in to this server should be entered

here, if “Use Default User ID’ is turned off.
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4.1.1.2 Options Tab

Authentication | Options | Extras

Login at Startup

Hierarchy Separator:

Automatic Hierarchy List

E Allow Disconnected Operations

Figure 7 The Options tab for an IMAP Mailbox account

Login at Startup To automatically login to the selected server when you start Mulberry,
turn this on.

Directory The hierarchy separator character for mailbox hierarchies should be

Separator entered here (usually “/” or “."). If you do not fill in this field, Mulberry
will determine the correct separator.

Automatic To automatically list any display hierarchies returned by the server,

Hierarchy List turn this on. The display hierarchies will be shown in the server
window. This option only works if your server supports the IMAP
‘NAMESPACE’ extension. Please see section 5.4.4.4 for a detailed
description of display hierarchies.

Allow To enable disconnected operations with this account, turn this on.

Disconnected Disconnected mode allows you to read and manipulate email from an

Operations IMAP Mailbox account without being connected to your email server.
Please see section 5.4.6 for a full description of disconnected mode
operations.
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4.1.1.3 Extras Tab

The options available in the Extras tab are available for IMAP Mailbox accounts as well as
POP3 and Local Mailbox accounts.

Authentication | Options | E:tr:as]

Account ldentity:
E Tie to ldentity

E N3
Rl

Identity: Default

Figure 8 The Extras tab for an IMAP Mailbox account

Tie to Identity Check this option to tie one of your identities to the selected account.
For a complete description of identities, please see section 5.9.2.6.

This option allows you to specify an identity to use by default when
replying to or forwarding a message stored in a particular email
account.

Note: You can also tie an identity to a specific mailbox. In
this case, the identity tied to the mailbox will override the
identity tied to the email account containing that mailbox.
Please see section 5.4.5.1 for instructions on tying an identity
to a mailbox.
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4.1.2 POP3 Mailbox Account

4.1.2.1 Options Tab

Authentication | Options | Local " Extras

E Leave Mail on Server

" | Delete After: 0O days

| Delete after Local Expunge

" | Skip Messages Bigger than: 10 Kb

" Use APOP when Available

Figure 9 The Options tab for a POP3 Mailbox Account

Leave Email on
Server

To prevent Mulberry from deleting your messages from the POP3
server after downloading them, turn this on.

Delete After

If you select this option, Mulberry will remove messages from the
selected POP3 server after the specified number of days, rather than
deleting them immediately after downloading them.

Delete after Local
Expunge

If you select this option, Mulberry will remove a message from the
selected POP3 server only after the corresponding message has been
deleted and expunged from the local POP3 mailbox.

Skip Messages When this option is selected, Mulberry will not download messages

Bigger Than from the selected POP3 server that exceed the specified size.

Use APOP When To use the more secure APOP authentication mechanism, turn this on.

Available You must also have Plain Text selected as the authentication
mechanism for this POP3 server. APOP will only be used when the
server advertises that it is available.
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4.1.2.2 Local Tab

Authentication | Options | Local | Extras

: Use Default Lacation
@ specify Location:

IB Relative Path * Choose... |
: Absolute Path

Figure 10 The Local tab for a POP3 Mailbox account

Use Default To store POP3 mailboxes for this account in the default location, click

Location here. The default mailbox location is determined by a setting in the
Disconnected tab of the Mailbox preference panel (see section 4.5.3),
and can be either the Mulberry application folder or the user
documents folder defined by the operating system.

Specify Location ~ To store POP3 mailboxes in a folder other than the default location,

click here. You can type a path in the location box or use the Choose
button to select a directory.

Relative Path

If this item is selected, Mulberry interprets the pathname relative to the
default location. If you use the Choose button to select a directory,
Mulberry will determine whether relative or absolute is most
appropriate.

Absolute Path

If this item is selected, Mulberry interprets the pathname as an absolute
path. If you use the Choose button to select a directory, Mulberry
will determine whether relative or absolute is most appropriate.
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4.1.3 Local Mailbox Account

Local | Extras

") Use Default Location
(@) Specify Location:

IE,"‘I Relative Path  Choose... |
: Absolute Path

File Format: Automatic (== ]

Figure 11 The Local tab for a Local Mailbox account

Most of the options in the Local tab are identical to those in the Local tab for a POP3
Mailbox account (see section 4.1.2.2). However, there is one additional option available to
specify the format of the local mailboxes in this account type.

File Format Choose the mailbox format to use for mailboxes under this account.
Available options are Automatic, Mac OS, Windows, and UNIX. In
general, you will want to keep this set to Automatic. However, if you
set up the local mailbox account to access mailboxes on a shared disk
from a computer using a different operating system, you may need to
change the file format. Additionally, you can modify this setting if you
want to create local mailboxes in a format that will allow easy transport
to a computer running a different operating system.
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4.1.4 SMTP Send Email Account
4.1.4.1 Options Tab

Authentication Dptions Local

E Use Local Quewes for Sending
: Hold Messages when Added to Queue

Figure 12 The Options tab form an SMTP Send Email account

Use Local Queues  Select this option to enable SMTP queuing. When this option is on,

for Sending Mulberry will create a local mailbox to store outgoing email sent
through the selected SMTP account. Queued email is sent in the
background, allowing you to perform other operations within
Mulberry immediately after sending a message.

If you are operating in disconnected mode, the SMTP queue will hold
outgoing messages until the next time you connect to a network. You
can manipulate the contents of the SMTP queue via the Outgoing
Queue window, described in Section 5.6.

Note: In order to use the selected SMTP account in
disconnected mode, you must have this option checked.

Hold Messages When this option is selected, messages will be assigned a status of
when Added to “Hold” when added to the SMTP queue, causing them not to be sent
Queue immediately. For held messages to be sent, you must manually

change the status of the messages in the Outgoing Queue window,
described in Section 5.6.
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4.1.5 IMSP Options Account
4.1.5.1 Options Tab

Authentication Options Sets

E Use Eemote Preferences at Startup

Figure 13 The Options tab for an IMSP Options account

Use Remote Select this option to use the default preference set on the selected
Preferences on remote IMSP server instead of those stored in a local file when starting
Startup up Mulberry.
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4.1.5.2 Sets Tab

Authentication | Options | Satsl

Remate Preference Sats

docs

gales print invoice
Single

sales

Backup

“ Refresh ' [ Rename... | [ Delete

Figure 14 The Sets tab for an IMSP Options account

The Sets tab allows you to view and manipulate the different preference sets on the current
IMSP server. A listing of all available preference sets appears in the Remote Preference
Sets box. To update the listing of preference sets, click the Refresh button. The Rename
button allows you to change the name of the currently selected preference set. The Delete
button will delete the currently selected preference set(s) from the server.

4.1.6 ACAP Options Account

The options available for an ACAP Options account are identical to those available when
using an IMSP Options account.
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4.1.7 IMSP Address Books Account

4.1.7.1 Options Tab
Authentication | Dptions ]

" | Login at Startup

E Allow Disconnected Operations

Figure 15 The Options tab for an IMSP Address Book account

Login at Startup To set Mulberry to automatically login to the selected IMSP Address
Book server when you start the program, turn this on.

Allow To make address books in this account accessible while in disconnected
Disconnected mode, select this option. Please see section 5.4.6 for a full description of
Operations disconnected mode operations.

4.1.8 ACAP Address Books Account

The options available for an ACAP Address Book account are identical to those available
when using an IMSP Address Book account.

46 Mulberry Reference Guide v4



4.1.9 LDAP Address Search Account

4.1.9.1 Options Tab

Authentication | Options | Attributes 1 [ Attributes 2

: Use with Address Expansion
E Lse when Searching

Figure 16 The Options tab for an LDAP Address Search account

Use with Address  To use this LDAP server when expanding addresses in Drafts, turn this
Expansion on.

Use when To use this LDAP server when doing Address searches, turn this on.
Searching
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4.1.9.2 Attr.1Tab

Authentication [ Options | Attributes 1 | Attributes 2

Root:

Mame: cn
Email: mail
Mick-name:
Address:

Company:

Figure 17 The Attributes] tab for an LDAP Address Search account

Root Enter the root starting location for the LDAP search.

Name Enter the attribute value on the LDAP server that corresponds to the
name of the person being looked up. This will usually be “cn’.

Email Enter the attribute value on the LDAP server that corresponds to the
email address of the person being looked up. This will usually be ‘mail’.

Nick-name Enter the attribute value on the LDAP server that corresponds to the
nick-name of the person being looked up.

Address Enter the attribute value on the LDAP server that corresponds to the
postal address of the person being looked up.

Company Enter the attribute value on the LDAP server that corresponds to the
company of the person being looked up.
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4.1.9.3 Attr.2 Tab

Authentication [ Options [ Attributes 1 | Attributes 2 !

Phane Waork:

Fhone Home:

Fax:

LIRLs:

Motes:

Put All Attributes in Notes

Figure 18 The Attributes2 tab for an LDAP Address Search account

Phone Work

Enter the attribute value on the LDAP server that corresponds to the
work telephone number of the person being looked up.

Phone Home

Enter the attribute value on the LDAP server that corresponds to the
home telephone number of the person being looked up.

Fax Enter the attribute value on the LDAP server that corresponds to the
fax number of the person being looked up.

URLs Enter the attribute value on the LDAP server that corresponds to the
URL of the person being looked up.

Notes Enter the attribute value on the LDAP server that corresponds to the
Notes field of the person being looked up. This field is disabled if you
check the ‘Put Attributes in Notes” option below.

Put Attributesin ~ To have the full set of attributes returned by the LDAP server for an

Notes entry inserted into the address notes field, turn this on.

4.1.10 ManageSIEVE Filter Account

There are no options available for ManageSIEVE accounts.
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4.1.11 CalDAV Calendar Account

4.1.11.1 Options Tab

Authentication | Options | Extras

E Login at Startup

E Allow Disconnected Operations

Path: fslide/files/calendars

Figure 19 The Options tab for a CalDAV Calendar account

Login at Startup To set Mulberry to automatically login to the selected Calendar server
when you start the program, turn this on.

Allow To make calendars in this account accessible while in disconnected

Disconnected mode, select this option. Please see section 5.4.6 for a full description of

Operations disconnected mode operations.

Path Enter the URL root path to the location on the server that is the top of

the calendar hierarchy.

4.1.12 WebDAV Calendar Account

4.1.12.1 Options Tab

Same as CalDAYV accounts.
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4.2 Alerts

Alerts Preferences

{ Messages | Attachments .
Style: | Default -:]

o
MNewver
T

2 Once on Startup
@ Every: 1 mins.

(| Use Foreground Alert

| Use Background Alert

@ Flash lcon in Background

@ Play Sound: Glass f

aw
4

@ speak: # new messages in ™
| Open Mailbox Window

Alert when Mailbox Contains:

E} Mew Messages
2 Any Messages

Apply to Cabinet: = Check Favourites I

aw
3

Figure 20 The Alerts preference panel

The Alerts preference panel allows you to define several different alert styles to apply to
different groups of mailboxes. For example, you may want to check your INBOX for new
email every five minutes, and receive notification via a sound and foreground alert. You
may also want to check another group of mailboxes, such as your subscribed mailboxes,
less frequently and receive a different type of alert when new messages arrive in those
mailboxes.

Alert styles work in conjunction with cabinets. Each alert style you create has a cabinet
associated with it. New email checking and notification takes place for mailboxes within
that cabinet according to the settings specified within the associated alert style. For a
complete description of cabinets, please see section 5.4.4.6.
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Style

This popup allows you to choose among the different alert styles
you’ve created, as well as make changed to those styles. When you
select an alert style using this menu, the settings for that style are
displayed. The New... option allows you to create and name a new
alert style. The Rename... option allows you to rename the currently
selected alert style, and the Delete... option deletes the selected alert
style.

New Email
Checking

To enable automatic email checking, click the “Every ... minutes’ option
and enter a time in minutes to specify the interval between automatic
email checks. If ‘Never’ is selected, no automatic email checking will
take place. Selecting the ‘Once on Startup’ option causes mailboxes to
be checked only once, after you start Mulberry.

Use Foreground
Alert

To show an alert dialog when new email arrives and Mulberry is the
active application, turn this on.

Use Background
Alert

To show an alert dialog when new email arrives and Mulberry is in the
background, turn this on.

MAc OS X ONLY

Flash Icon in
Background

MAac OS X ONLY

To flash the application icon in the menu bar when new email arrives
and Mulberry is in the background, turn this on.

WINDOWS ONLY

Show Icon in Task
Bar

WINDOWS ONLY
To show the application icon in the taskbar, turn this on.

Play Sound To play a sound when new email arrives, turn this on. You can select
the sound from the list of installed system sounds using the popup
menu.

Open Mailbox To automatically open the mailbox window for any mailboxes that

Window contain new email, turn this on.

Alert when To present an alert only when a mailbox is checked and contains new

Mailbox Contains

messages, click the New Messages option. To present an alert when a
mailbox is checked and contains any type of message, click the Any
Messages option. The type of alert presented will depend on the
settings above.

Apply To Cabinet

Select the cabinet to associate with this alert style. Mailboxes in this
cabinet will be checked at the interval specified and you will be notified
of new messages according to the settings specified in the current alert
style.
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4.2.1 Attachments Tab

E

Messages | Attachments ]

Use Alert
Play Sound: Basso ﬂ
speak:

This message has an attachment

Figure 21 The Attachments tab in the Alert preference panel

Use Alert To show an alert box when a message with attachments is opened,
turn this on.

Play Sound To play a sound when a message with an attachment is opened, turn
this on. You can select the sound from the list of installed system
sounds using the popup menu.

Mac OS X & MAc OS X & WINDOWS ONLY

WINDOWS ONLY
Speak

To generate a spoken alert when a message with an attachment is
opened, turn this on. You can specify the text to be spoken in the box
below the check box.
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4.3 Display

Display Preferences

! Server | Maibox [ Messaga [ Labels [ Quotes [ Htyles .
Colowr: Bold ftalc Sheiee Under

Logged in: [N M O O O

Logged out: | R M O O O

5ewer:|:| E Colour Background
Eahinet::l @ Colour Background
Hierarch :-.r:|:| E Colour Background

.__' Reset Window Defaults '__. E Allow Single Key Shortcuts

Figure 22 The Display preference panel

In addition to the settings in the Display panel, Mulberry saves window position
information in your preferences. To facilitate easy use between different computers,
different sets of window positions are saved for different monitor resolutions and different
operating system types.

Reset Window Resets all window positions to their default values
Defaults

Allow Single Key To use single key shortcut commands in mailbox or message panes,
Shortcuts turn this on.
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WINDOWS ONLY

Multiple Taskbar
Items

WINDOWS ONLY

To have each individual Mulberry window appear as a separate entry
on the taskbar, turn this on. To have a single taskbar entry for all
Mulberry windows, turn this off. This option is not available if you do
not have the Independent Windows option turned on. Changes only
take effect after you quit and restart Mulberry.

4.3.1 Server Tab

The settings in this tab affect the text names of email servers, cabinets, and display
hierarchies appearing in the server window.

Logged In

To set the color for displaying the text name of servers in the server
window for which you are currently logged in, click the colored box.
To select a text style for the text names of logged in servers, turn the
appropriate checkbox on or off.

Logged Out

To set the color for displaying the text name of servers in the server
window for which you are not logged in, click the colored box. To
select a text style for the text names of logged out servers, turn the
corresponding checkbox on or off.

Server

To set the background color for servers in the server window, click the
colored box. To eliminate the background color, uncheck the ‘Color
Background’ box.

Cabinet

To set the background color for mailbox cabinets in the server
window, click the colored box. To eliminate the background color,
uncheck the “Color Background’ box.

Hierarchy

To set the background color for mailbox display hierarchies in the
server window, click the colored box. To eliminate the background
color, uncheck the “Color Background’ box.
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4.3.2 Mailbox Tab

All settings in this tab affect text names of mailboxes appearing in the server window.

Server | Maillbox | Messags . Labels . Quotes [ Styles

Colowr: Bald ftalc sS4 Under

Rl:—n:ent:- E
Llnseen:- E
open: [ T
Favnurite:- E
closec: [

E Use Recent State only for Recent and Unseen

Figure 23 The Mailbox tab in the Display preference panel

Recent To set the color for mailboxes with new messages, click the colored
box. To select a text style for mailboxes with new messages, turn the
corresponding checkbox on or off.

Unseen To set the color for mailboxes with unseen messages, click the colored
box. To select a text style for mailboxes with unseen messages, turn the
corresponding checkbox on or off.

Open To set the color for mailboxes that are currently open, click the colored
box. To select a text style for open mailboxes, turn the corresponding
checkbox on or off.

Favorite To set the color for mailboxes that are marked as ‘Favorites’ (those that
will be checked for new email), click the colored box. To select a text

style for favorite mailboxes, turn the corresponding checkbox on or
off.

Closed To set the color for ordinary mailboxes, click the colored box. To select
a text style for ordinary mailboxes, turn the corresponding checkbox
on or off.
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Use Recent State ~ To use the Recent style for messages that have both recent and unseen
only for Recent flags set, as opposed to those only having the Recent flag set, turn the
and Unseen corresponding checkbox on.

4.3.3 Message Tab

All settings in this tab affect message captions appearing in mailbox windows.

Server [ Mailbox | Message | Labels [ Quotes [ Styles |

Colowr: Baold  ftalc  Sheike Under
Llnseen:- @
seen: || (]
Answered: [ (]
Irnp-::urtant:- @
Deletec: [ |

<l
[

Multiple Addresses:

e . —

Hatched::l @ Colour Background

LUinmatched: "1 Colour Background

@ Display Dates Adjusted to Local Timezone

Figure 24 The Message tab in the Display preference panel

Unseen To set the color for new messages, click the colored box. To select a text
style for new messages, turn the corresponding checkbox on or off.

Seen To set the color for messages that have been seen, click the colored
box. To select a text style for seen messages, turn the corresponding
checkbox on or off.

Answered To set the color for messages that have been answered, click the
colored box. To select a text style for answered messages, turn the
corresponding checkbox on or off.

Important To set the color for important messages, click the colored box. To select
a text style for important messages, turn the corresponding checkbox
on or off.
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Deleted To set the color for messages that have been deleted, click the colored
box. To select a text style for deleted messages turn the corresponding
checkbox on or off.

Multiple Some messages in mailbox windows are addressed to multiple

Addresses recipients. To set a text style for displaying the address fields of such
messages, turn the corresponding checkbox on or off.

Matched To set the background color for messages that meet the current
‘Match’ criteria, click the colored box. To eliminate the background
color, uncheck the “Color Background’ box.

Unmatched To set the background color for messages that do not meet the current
‘Match’ criteria, click the colored box. To eliminate the background
color, uncheck the “Color Background’ box.

Display Dates To have dates displayed using the timezone you are currently in, turn

Adjusted to Local this checkbox on. To leave dates displayed using the timezone that

Timezone they were generated in, turn this checkbox off.

4.3.4 Labels Tab

All settings in this tab affect message captions appearing in mailbox windows.

Server [ Maidbox [ Message | Labels | Quotes [ Htyles .

Labeal Narme: Use Colowr: Use Bkgnd: Baold ftalc Shieilee Under

s FEEA®MC 10 O O C

Label2

Label3 E - — — — —
Labald E - — — — —
 abel 1 I= R gy
Labelf E - — — — —
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Label? E - — — — — —

Labeld

Figure 25 The Labels tab in the Display preferences panel
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Label Name Enter a name for one of the eight labels. Foreground and background
colors for messages having the corresponding label can be set by
turning them on with the appropriate checkbox and then choosing a
suitable color by clicking on the colored box. To set a text style for
displaying messages with the corresponding label, turn the
corresponding checkbox on or off.

4.3.5 Quotes Tab

All settings in this tab affect message text appearing in a message window.

S.er'.-er- Mailbox [ Message [ Labels | Quates | Styles

Colour: Baold ftalic  Under

sleve: R ) [ [

) Level:-
R Leuel:lzl
=»»xlevel: |:|
B Level:lzl

Recognised Quotes

E Use Multiple Colours

Figure 26 The Quotes tab in the Display preference panel

Level Click on the Color box to specify a color for each level of quoted text.
You can also use the checkboxes to the right of the first level to specify
different text styles for quoted text. Any selected text styles will apply
to all levels of quoted text.

Use Multiple To use different colors for each level of nested quotes, check this box.
Colors If this box is not selected, you will only be allowed to specify one color
for all quoted text.
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Recognized Mulberry uses the characters in this box to determine which lines in the

Quotes text of a message are quoted text. If a line of message text begins with
one of the listed characters, Mulberry assumes that line contains
quoted text and applies the specified colors and styles to that text.

4.3.6 Styles Tab

All settings in this tab affect message text appearing in a message window.

Server [ Mailbox [ Message [ Labels [ Quotes | St'_l,l'|-E5-!
Colour: Bold ftalc LUnder

LE e v
URL Seen:| [ ] |

Header:- E
Style Tags: [ |

L
[

Recognise URL Schemes
http:// +
https:// ¥
mailta:
ftp:ss
file://
imap:s s
acap:/s 'y
Idap:// 1

Figure 27 The Styles tab in the Display preference panel

URL To set the color for displaying active URLs, click the colored box. To
select a text style for URLs, turn the corresponding checkbox on or off.

URL Seen To set the color for displaying followed URLSs, click the colored box. To
select a text style for URLs, turn the corresponding checkbox on or off.

Header To set the color for displaying message header fields, click the colored
box. To select a text style for message header fields, turn the
corresponding checkbox on or off.

Style Tags To set the color for displaying styled text tags, click the colored box. To
select a text style for styled text tags, turn the corresponding checkbox
on or off.
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Recognize URL To have Mulberry recognize a particular type of URL and display it as
Schemes specified above, enter its scheme here. This should include any
required directory characters after the " (e.g. use ‘http:/ /’, not ‘http:’).

4.4 Fonts

Font Preferences

Font: Size:
Lists: Geneva B (10 B
Plain Text: Monaco B (10 B
Printed Text! Courier ) (10 e
Print Captions: Courier = ] UL ]
Styled Base:! Palatino B (12
Styled Fixed: Monaco L RE 4]

Smallest Size Allowed in Styled Text: 12 |5

@ Use Styled Fents in Formatted Messages

Figure 28 The Font preference panel

Lists Choose the font face and size to use when displaying lists of items,
such as servers and mailboxes in the server window, message captions
in a mailbox window, and address books in the address book manager
window.

Plain Text Choose the font face and size to use when displaying message text in a
message window or a draft window. You should try to choose a font
with a fixed character width (mono-spacing) so that text formatting
and alignment is preserved.

Printed Text Choose the font face and size to use when printing plain text messages.
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Printed Captions

Choose the font to use for the header and footer on printed pages.

Styled Base

Choose the default font face and size to use for displaying styled text in
text/enriched and text/html styled text messages or drafts.

Styled Fixed

Choose the font face and size to use for displaying fixed-width text in
text/enriched or text/html styled text messages.

Smallest Size
Allowed for

Choose the smallest font size you want to view styled text at.

Styled Text

Use Styled Fonts  To always use different fonts in messages with styled text turn this on.
in Formatted To only use the Plain Text font in formatted messages, turn this off.
Messages
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4.5 Mailbox

Mailbox Preferences
,! Basic | .-iﬁa—nced ' Di_sar{nected I

Open Mailbox at: Processing Order:
First Message @ Oldest to Newest
Last Message 2 Mewest to Oldest
First New Message

@0

: Don't Preview Mew Message

| Expunge on Close

] Wam on Expunge

}E Warm when Marking All Messages as Seen

[1‘1 Open Mext with Mew Messages
[21 Ask before Opening Mext

[1‘1 Move Read Messages in INBOX
Move to: POP3:seen @

E Wam when Moving

Figure 29 The Mailbox preference panel

4.5.1 Basic Tab

Open Mailbox at  These three radio buttons determine whether mailbox windows are
opened with either the “First’, ‘Last’, or ‘First New’ message displayed.
The ‘First’ and ‘Last’ options will display the oldest and newest set of
messages, respectively, when a mailbox window is opened. The ‘First
New’ option will cause the oldest unread message to be highlighted
when a mailbox window is opened.

Don’t Preview To prevent a new message being previewed when first opening a
New Message mailbox, turn this on.
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Processing Order

These two radio buttons determine the direction in which Mulberry
will automatically move message selections as you are reading through
a mailbox. If you prefer to process messages in the order of oldest to
newest, turn the 'Oldest to Newest' radio button on. If you prefer to
process messages in the order of newest to oldest turn the 'Newest to
Oldest' radio button on.

Expunge on Close

To automatically expunge a mailbox after closing its window, turn this
on. Expunging permanently removes from the mailbox any messages
marked as deleted.

Warn on Expunge

To display a warning before expunging a mailbox, turn this on.
Expunging permanently removes from the mailbox any messages
marked as deleted.

Warn when
Marking All
Messages as Seen

To display a warning before marking all messages as seen, turn this on.

Open Next with To automatically move to the next mailbox with new messages in it

New Messages when you have read all messages in the current mailbox, turn this on.

Ask before To show a warning before moving on to the next mailbox with new

Opening Next messages, turn this on.

Move Read This option allows you to automatically move messages in your

Messages in INBOX that you've read to another mailbox. Upon closing the INBOX

INBOX window, all “seen” messages are moved to the mailbox specified in the
‘Move to’ field (described next), and deleted messages are expunged
from the INBOX.

Move to When the INBOX is closed any messages that have been seen will be

automatically moved to this mailbox and the INBOX expunged. The
mailbox name should be the full path name for the mailbox. You can
click on the pop-up menu next to the field to select a mailbox from
those currently known to Mulberry.

Warn when
Moving

To display a warning if any messages are about to be automatically
moved out of the INBOX, turn this on.
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4.5.2 Advanced Tab

Basic

[ Advanced |

Disconnected

MNew Messages:
@ are Linseen
=

are Recent

=i
are Recent and Unseen

Cabinets:

: Use 'Copy Messages To" Cabinet
" | Use ‘Copy Drafts To' Cabinet

Maximum History: 30

Message Display Cache:
Remote Mailboxes:

Lacal Mailboxes:

Initial Download: 30 Initial Download: 30
£ Unlimited Total ) Unlimited Total

: Limit tao: 200 : Limit to: 100
I@ Auto Increment @ Auto Increment

: Increment: 20 : Increment: 50
Sort Warning: 200 Sort Warming: 1000

Figure 30 The Advanced tab in the Mailbox preference panel

New Messages

These three radio buttons determine what type of message is
considered to be a new message. Selecting ‘are Unseen’ or ‘are Recent
causes messages without the seen flag set and messages with the
recent flag set, respectively, to be considered as new. The “are Recent
and Unseen’ option causes messages without the seen flag AND with
the recent flag to be considered new.

J

For a complete description of message flags, please see section 5.5.4.3.

Use ‘Copy To use the list of mailboxes in the ‘Copy Messages To’ cabinet in the
Messages To’ ‘Copy To’ main menu and popup menu, turn this on.

Cabinet

Use ‘Copy Drafts  To use the list of mailboxes in the ‘Copy Drafts To” cabinet in the

To’ Cabinet

‘Append To” main menu and popup menu, turn this on.

Maximum History

Enter the number of recently chosen mailboxes to be shown in the
‘Copy To’ or “Append To” main menu or popup menu when the menus
are set to display their respective cabinet contents.
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The next set of options determine the behavior of Mulberry’s message display caching.
Novice users will probably want to use the default settings. There are two sets of options,
one of which applies to mailboxes being accessed over a network connection to a server,
and the other of which applies to local mailboxes, including ones residing on a server that
are being accessed in disconnected mode.

Initial Download

Enter a number into this field. Mulberry will download a
corresponding number of message captions automatically when you
first open a mailbox window. Setting this number too high when using
a slow network connection could result in poor performance.

Unlimited Total

To allow Mulberry to download an unlimited number of message
captions for a mailbox, select this option. If this option is not selected,
message caption information will be discarded as other captions need
to be downloaded. Selecting this option when working with very large
mailboxes could result in a low memory situation.

Limit To

To allow Mulberry to discard information on messages not currently
displayed in a mailbox window, click here. When the number of
message captions downloaded exceeds the specified number, Mulberry
will discard previously downloaded message captions. Enter the
number of message captions to remember in the box to the right.

Auto Increment

If this option is selected, Mulberry will automatically download a
number of new message captions equivalent to the number of
messages displayed in the mailbox window.

Increment If this option is selected, Mulberry will automatically download a
number of new message captions equal to the number entered.

Sort Warning Specifies the maximum number of messages in a mailbox that
Mulberry will download to get information for sorting without
displaying a warning alert.
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4.5.3 Disconnected Tab

Basic ' Advanced | Disn:nrlnec:tad]

[ Opticns | Local

E Prompt on Startup if Required

E Automatic Modem Dial/Hangup
E Wam if Mailboxes do not Match

Use 05 Specific Default Locations

E Connect after Wake if Metwork Connections Found

Figure 31 The Disconnected tab in the Mailbox preference panel

Within the Disconnected tab, the Options tab allows you to specify various settings that
affect disconnected mode operations.

Prompt on Startup
if Required

When Mulberry is started, it will attempt to start up in the same state it
was in when it was last quit — either connected or disconnected mode.
In the case where Mulberry was previously in connected mode and no
network connection is available on startup, you can select this option to
have Mulberry prompt you to determine whether you want to
establish a connection or startup in disconnected mode instead. If you
don’t have this option turned on, Mulberry will always try to establish
its previous state on startup, and you will receive an error message if a
network connection is required but not available.

Automatic Modem
Dial/Hangup

Select this option to have Mulberry automatically dial and hang up
your modem as necessary when moving between connected and
disconnected mode.
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Warn if Mailboxes In some rare cases, if an online IMAP mailbox has completely changed

Do Not Match

since the last time it was synchronized with a disconnected mailbox,
Mulberry may not be able to perform some of the pending
synchronization options. Turning this option on will produce an alert if
this happens.

You will generally want to keep this option on.

Use OS Specific
Default Locations

To use the default location for documents as specified by the current
operating system, select this option. The default location is usually the
user documents folder. If this option is off, the default location is the
Mulberry application folder.

This setting can potentially affect any local mailboxes, disconnected
mailboxes, POP3 mailboxes, and local address books that are set to be
stored in the default location.

Connect after
Wake if Network
Connections
Found

To have Mulberry automatically recover network connections when
the computer wakes from sleep, provided an active network
connection is found, turn this on. When this is off, Mulberry will always
display a prompt after the computer wakes from sleep.

The items in the Local tab are identical to those in the Local tab for a POP3 mailbox account
(see section 4.1.2.2), though the settings in this tab specify the location for the storage of
disconnected mailboxes.
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4.6 Message

Message Preferences

{ General | Options .

Creator for Saved Messages R*ch | " Choose...

.1

Print Captions: {7 Set._.

Wam when Opening a Message bigger than:
’: Mo Limit E}I Size: 20 Kbytes

Allow Choice of who to Reply to when:

“: Option Key is Down
E} Opticn Key is not Down

’: Allow Choice of Forward Options
E} Forward using Options:

E Quote Driginal
" lInclude Headers in Quote

E_q Always Forward as Attachment
[21 Use Embedded Message

Figure 32 The Message preference panel

4.6.1 General Tab

MAc OS X ONLY MAc OS X ONLY

Creator for Saved Enter the creator code for messages saved to disk. For example:

Messages “ttxt” for TeachText/SimpleText

‘MSWD’ for Microsoft Word

If you don’t know the proper creator code for the application you want
to use, you can click the Choose button and select the application you
want to handle saved messages. Mulberry will fill in the appropriate
creator code for you.
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WINDOWS &
UNIX ONLY

Extension for
Saved Messages

WINDOWS & UNIX ONLY

Enter the three character filename extension for messages saved to
disk. For example:

.txt for a plain text file

.doc for a Microsoft Word document

Print Captions

Click the “Set...” button to define the header and footer that will appear
when you print a message. A dialog box (shown in Figure 34) will
appear. You can create different headers for regular messages and
draft messages.

Warn when
Opening a
Message bigger
than

When this option is selected, a warning alert will be displayed before
opening a message exceeding the specified size. If ‘No Limit’ is selected,
no size warning occurs.

Allow Choice of
who to Reply to
when

This setting allows Mulberry to automatically display a dialog with a
choice of reply addresses when replying to a message. To have this
dialog always come up, select ‘Option Key is not Down’ (Mac OS X) or
‘Alt Key is not Down’ (Windows) option. To have the dialog appear
only when you hold down the Option (Mac OS X), Alt (Windows) or
Control (Unix) key while selecting the Reply option, choose ‘Option
Key is Down’ (Mac OS), ‘Alt Key is Down’ (Windows), ‘Control Key is
Down’ (Unix).

All Choice of
Forward Options

When this option is selected, a dialog presenting options for
forwarding a message will appear when the Forward command is
used.

Forward using
Options

When this is selected, the forward options specified via the controls
below it are used to determine how messages are forwarded, avoiding
the dialog.

Quote Original

When this is selected the text from the original message is quoted in
the forwarded message.

Include Headers
in Quote

When this is selected, the headers of the original message are also
included in the forwarded message.

Always Forward
as Attachment

When this is selected, Mulberry will always attach the original message
to the forwarded message, even if it only contains text which is also
quoted.

Use Embedded When this is selected, Mulberry will attach the original message as a

Message message /rfc822 part in the forwarded message. When this is not
selected, the parts of the original message are attached to the
forwarded message ‘in-line’.
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4.6.2 Options Tab

General | Dptions !

=how Message Header in Window

@ Show Styled Text Alternatives

Put Message Header in File when Saving

E Delete Message after Copy

E Allow Deleted Messages to be Opened
E Close Message when Deleted

: Reuse Dpen Message Window

@ Quote Selection Only

@ Quote whole Message if no Selection
E Dpen First Digest Message

E Expand Header for Multiple Addressees
: Expand Parts for Attachments

sender Read Receipt Requests
' Always Send Read Receipt
Never Send Read Receipt

()

Prompt to Send Read Receipt

Figure 33 The Options tab in the Message preference panel

Show Message To have the message header displayed at the top of each message

Header in when opened, turn this on.

Window

Show Styled Text To display the styled text message part in a multipart/alternative

Alternatives message, turn this on. To always display the plain text part of a
multipart/alternative, turn this off.

Put Message To save the message header along with the message text when a

Header in File
when Saving

message is saved, turn this on.

Delete Message

To delete messages after copying from one mailbox to another, turn

after Copy this on.

Allow Deleted To allow messages that are marked as deleted to be opened, turn this
Messages to be on. When off, messages being deleted will have their message
Opened windows closed.
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Close Message

To close message windows when the message they are displaying is

when Deleted deleted, turn this on.
Reuse Open To reuse the oldest open message window when opening a message
Message Window  from a mailbox window, select this option. Holding down the Option

(Mac OS X), Alt (Windows) or Control (Unix) key when opening a
message from the mailbox window will produce the opposite
behavior.

Quote Selection
Only

If this option is checked and you reply to a message, only the text
currently selected in the original message will be automatically quoted
in the reply draft window.

Quote whole
Message if no

If this option is checked and you reply to a message, the complete text
of the original message will automatically be quoted in the reply draft

Selection window when no text is selected in the original message.

Open First Digest To automatically open the first digest message when a

Message multipart/digest message is opened, turn this on.

Expand Header for When this option is selected, if you open a message which contains

Multiple more than one address in an address field, Mulberry will automatically

Addresses expand that address field to show multiple lines when it is visible.

Expand parts for =~ When this option is selected, Mulberry will automatically expand the

Attachments Parts section of a message window (see Section 5.8.2.1) if the contains
any attachments.

Sender Read These options determine how Mulberry will process read receipt

Receipt Requests  requests that have been sent to you.

* Always Send Read Receipt - an automatic read receipt will
always be sent whenever you read a message that contains a read
receipt request.

* Never Send Read Receipt - read receipts will never be
automatically sent even if they are requested.

* Prompt to Send Read Receipt - when a read receipt request is
detected on a message you have just started to read, Mulberry will
prompt you as to whether you want to send a read receipt back to
the sender of the message, or not.
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4.6.3 Editing Captions

You can create custom captions to appear on message printouts. Captions are created
using the ‘Set Caption’ dialog.

Set Caption
My Mame | Smart Mame | From Mame To Mame CC Mame Subject Page Mumber
My Email amart Email | From Email To Email CC Email Date Short
My Full amart Full From Full To Full CC Full Date Long
My First amart First | From First To First CC First Date Mow
Header Ej Message ,:, Drraft E Draw Box E Print Summary Headers

Message: %smart-full on %sent-short
Subject: %subject

Footer Ej Message ,:, Drraft E Draw Box
Page Xpage Printed for: ¥me-name on  %now

{ Revert ) { Cancel ) @
= J \ = J

Figure 34 The Set Caption window

You can edit different headers and footers for regular messages and draft messages by
selecting either the “‘Message’ or ‘Draft’ radio buttons. The buttons at the top of the
window allow you to insert various fields from the message you are printing into the
printed header or footer. A description of each field button follows:

My Name Your real name. If you have not specified your real name in the
appropriate preference panel, your email address will be used instead.

My Email Your email address.
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My Full

Your real name and email address.

My First Your first name. If you have not specified your real name in the
appropriate preference panel, your email address will be used instead.

Smart Name The real name of the correspondent. If a real name is not specified, the
email address of the correspondent will be used instead.

Smart Email The email address of the correspondent.

Smart Full The real name and email address of the correspondent.

Smart First

The first name of the correspondent. If a real name is not specified, the
email address of the correspondent will be used instead.

From Name

The real name specified in the ‘From’ address of the current message. If
a real name is not present, the email address will be used instead.

From Email

The email address specified in the ‘From” address of the current
message.

From Full The real name and email address specified in the ‘From’ address of the
current message.

From First The first name specified in the ‘From’ address of the current message.
If a real name is not present, the email address will be used instead.

To Name The real name specified in the ‘To” address of the current message. If a
real name is not present, the email address will be used instead.

To Email The email address specified in the “To” address of the current message.

To Full The real name and email address specified in the “To” address of the
current message.

To First The first name specified in the “To’ address of the current message. If a
real name is not present, the email address will be used instead.

CC Name The real name specified in the ‘CC” address of the current message. If a
real name is not present, the email address will be used instead.

CC Email The email address specified in the ‘CC” address of the current message.

CC Full The real name and email address specified in the ‘CC" address of the
current message.

CC First The first name specified in the ‘CC” address of the current message. If a
real name is not present, the email address will be used instead.

Subject The subject of the current message.

Date Short A short version of the date and time the current message was sent.

Date Long A long version of the date and time the current message was sent.
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Date Now A short version of the current date and time.

Page Number The current page number.

To draw a box around either the header or footer, select the appropriate Draw Box
checkbox. The Revert button will change all captions back to the state they were in when
the Set Caption window was first opened.

When used for setting print headers and footers, turn on the Print Summary Headers
checkbox to ensure a set of headers are always displayed at the top of the first printed

page.
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4.7 Outgoing

Outgoing Preferences

General | Options [ Styled |

Default Domain for
Dutgoing Mail:

Tab Width: 4 @ Use Spaces for Tabs
Wrap Length: 76

F i

Reply Prefix: | Caption: [ sat.
Forward Prefix: Caption: [ Ser.. )
Forward Subject: * { fwid)
Print Captions: (" Ser._.

E Separate Bocc Message with Caption: © Set,,
save Draft

T

Always Save to Disk
Always Save to Mailbox:

imap:INBOX. drafts .
@ Allow Choice of where to Save

L1x

Figure 35 The Outgoing preference panel

4.7.1 General Tab

Default Domain  If you enter an email address without the ‘@’ character which is not a

for Outgoing nickname or a group name, this text will be filled in as the rest of the

Email email address. If you are not sure what to enter here, you should leave
it blank.

Tab Width The character width to use for tab characters, or the number of spaces

to insert when typing a tab in a draft window when the “Use Space for
Tab’ checkbox (described below) is on.

Use Spaces for To use a run of spaces rather than a real Tab character when typing a
Tabs tab in a draft window, turn this on. The number of spaces used is
determined by the “Tab Width’ setting, described above.
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Wrap Length

The number of characters per line to which the text of a draft message
is wrapped when it is sent. This should normally be left at 76 characters
per line.

Reply Prefix

The string used to indicate a quotation of a message being replied to.
This string followed by a space is inserted at the start of each line of the
quotation.

Reply Caption

To configure the text displayed before and after each message being
replied to, click the ‘Set...” button. A dialog box (shown in Figure 34)
will appear.

Forward Prefix

The string used to indicate a quotation of a message being forwarded.
This string followed by a space is inserted at the start of each line of the
quotation.

Forward Caption

To configure the text displayed before and after each message being
forwarded, click the ‘Set...” button. A dialog box (shown in Figure 34)
will appear.

Forward Subject

The string used to configure the subject used when forwarding a
message. An ‘¥ character is used to represent the original subject. Thus
a value of “* (fwd)’ (the default) will append * (fwd)’ to the original
subject. A value of ‘Fwd: * will prepend ‘Fwd: * to the original subject.

Print Captions

Click the ‘Set...” button to define the header and footer that will appear
when you print a message. A dialog box (shown in Figure 34) will
appear. You can create different headers for regular messages and
draft messages.

Separate Bcc
Message with
Caption

When this option is selected, Mulberry will send two copies of
messages which contain Bcc recipients. One copy is sent to the To and
Cc recipients only, the other to the Bcc recipients only. The Bec copy
has some text automatically added to the top of the first text part in the
message. This is used to provide a warning to the Bec recipients to
ensure they don’t accidentally reply to other recipients and thus expose
the fact that they were a Bcc recipient.

Bcce Caption

Click the ‘Set...” button to define the text that is automatically inserted
into the Bee copy of a message. This option is only available when the
‘Separate Bcc Message with Caption’ option (described above) is
selected.

Always Save to
Disk

When this option is selected, the File menu Save command will allow
you to save draft messages to disk only. Drafts can still be appended to

a mailbox using the Append To or Append Now command in the
Draft menu.

Always Save to
Mailbox

When this option is selected, the File menu Save command will allow
you to save draft messages to the specified mailbox only. You can
choose the mailbox via the popup to the right of the text field.
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Allow Choice of
where to Save

When this option is selected, the File menu Save command will
prompt you whether to save draft messages to disk or to a mailbox.

4.7.2 Options Tab

. General | Options | Styled |

@ Insert Signature Automatically

E Add Blank Line before Signature

E Add °-- " before Signature

@ Remaowve Signatures from Reply Quotation
@ Wam if no Subject when Sending

@ Warn when Reply Subject is Changed

: Display From Address in ldentity Popup

| Always Show Cc Field

| Always Show Bcc Field

E Only Show Attachments in Parts List

@ Append as Draft

: Copy INBOX Messages being Replied to

@ Add URL delimiters when Pasting Text

: Wrap Text while Composing

E Delete Drafts in Mailboxes after Sending
@ Don't Delete Important Drafts after Sending
@ Always Use Unicode Character Set for non-ASCI Text

Figure 36 The Options tab in the Outgoing preference panel

Insert Signature

To have the signature specified in the current identity automatically

Automatically added to the end of a new draft message, turn this on.

Add Blank Line To ensure that there is at least one blank line between the signature
Before Signature  and any text that precedes it, turn this on.

Add '--' before To add a recognizable signature indicator before the signature text,
Signature turn this on.

Remove To have recognizable signatures removed from text being quoted in a

Signatures from
Reply Quotation

reply, turn this on.
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Warn if no Subject To have a warning displayed when sending a message with an empty

when Sending

subject line, turn this on.

Warn when Reply To have a warning when a reply is sent with a different subject than
Subject is the original, turn this on..

Changed

Display From To include the From address for the selected identity in the Identity
Address in popup, turn this on.

Identity Popup

Always Show Cc
Field

When this option is selected, all new Draft windows will always contain
a Cc: address field. When this option is off, the Cc address field will
initial be hidden in the Draft window, but it can be added by clicking
the Add Cc toolbar button in the window.

Always Show Bcc  When this option is selected, all new Draft windows will always contain

Field a Bec: address field. When this option is off, the Bec address field will
initial be hidden in the Draft window, but it can be added by clicking
the Add Bcc toolbar button in the window.

Only Show To display only attachments in the parts list, turn this on. When turned

Attachments in off, all parts of the draft will be displayed, including the text part being

Parts List edited.

Append as Draft ~ To copy draft messages into a mailbox so that they will be opened as
draft messages, turn this on. Holding down the Option (Mac OS X), Alt
(Windows) or Control (Unix) key while selecting the equivalent
command will produce the behavior.

Copy INBOX To automatically set the ‘Also copy original message’ checkbox when

Messages being replying to a message in the INBOX, turn this on.

Replied To

Add URL To automatically have <...> delimiters inserted around a URL when

Delimiters when  pasted into a Draft window, turn this on.

Pasting Text

Wrap Text while
Composing

To have text in a draft window wrapped to the “Wrap Length’,
described above, while composing a message, select this option. If this
option is not selected, text will be wrapped to the width of the compose
window, and re-wrapped to the specified “Wrap Length” when the
message is sent.

Delete Drafts in
Mailboxes after
Sending

If a draft message is opened from a mailbox, turn this on to have the
original draft message deleted after the draft has been sent, saved or
copied.

Don’t Delete
Important Drafts
after Sending

If the ‘Delete Original Draft’ option is on, turn this option on to prevent
draft messages marked as ‘Important’ from being deleted. This allows
the use of ‘template’ draft messages by marking such messages as
‘Important’ to avoid them being deleted like ordinary draft messages.
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Always use To always send messages with non-ASCII text using a Unicode
Unicode Character character set, turn this on. When turned off, Mulberry will attempt to
Set for non-ASCII use an ISO-8859-x character set whenever possible, and Unicode in
Text other cases.

4.7.3 Styled Tab

General | Options | Styled

Compose Text as: Plain -

L3
3

Generate Alternatives:

Generate: Generate:
Compose Enriched: E Flain : HTMIL
Compose HTML: E Flain : Enriched

E Send Plain Text Flowed

Figure 37 The Styled tab in the Outgoing preference panel

Compose Textas  To set the default styled text format to use when composing draft
messages, choose one from the pop-up menu.

Composing To automatically generate a text/ plain part alternative when

Enriched composing a text/enriched message, turn ‘Plain’ on. To automatically
generate a text/html part alternative when composing a text/enriched
message, turn ‘"HTML’ on.
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Composing HTML To automatically generate a text/plain part alternative when
composing a text/html message, turn ‘Plain’ on. To automatically
generate a text/enriched part alternative when composing a text/html
message, turn ‘Enriched’ on.

Send Plain Text When this option is on, outgoing text/plain messages are sent using
Flowed the “flowed” format. If the recipient of such a message is using a email
client that supports flowed text, the message will automatically wrap to
the size of their viewing window. Users of email clients that do not
support flowed text will see the message text wrapped to the “Wrap
Length’ specified in the General tab of the Outgoing panel (see
section 4.7.1).
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4.8 Security

Note: The options in this preference panel are only available when you have the Mulberry
PGP, GPG or S/MIME plugins installed and activated

Security Preferences

Preferred Plugin: PGP - using PGP Plugin

'
—

[21 Use MIME Multipart Security with PGP
[21 Always Encrypt to Self
[21 Cache Passphrase while Running

[21 Verify Signed Messages when Opened
[21 Decrypt Messages when Opened

[21 Warmn wihen Responding without Encryption
: Motify Errors with an Alert Box

signature Verined OF MNotification:

"] Use Alert
" Play Sound:

[21 speak:

Verfied digital signature

| Manage Certificates... |

Figure 38 The Security preference panel

Use MIME When this option is on, Mulberry generates outgoing messages that

Multipart Security are signed or encrypted with PGP as proper MIME multipart/signed or
multipart/encrypted messages. If this is off, messages are sent as
regular text/ plain parts with signing and/or encryption information in
the message body.

Always Encrypt to  When this option is on, any encrypted messages generated will also be

Self encrypted to the signing key specified in the currently selected identity.
As an example, if you save copies of all outgoing messages, this option
ensures that you can decrypt messages sent to other people.
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Cache Passphrase  To cache in memory the passphrase(s) for any signing key(s) you use
while Running during the current Mulberry session, turn this on. PGP passphrases are
never written to disk.

Verify Signed To automatically verify the signature on a signed message when it is
Messages when opened, turn this on. This feature will only work for messages in a
Opened proper MIME multipart/signed format.

Decrypt Messages To automatically decrypt an encrypted message when it is opened,
when Opened turn this on. This feature will only work for messages in a proper
MIME multipart/encrypted format.

Warn when To display a warning when sending a an unencrypted reply to a
Responding message that was encrypted, turn this on.

without

Encryption

Notify Errors with To display a warning when a verify or decrypt operations produces an
an Alert Box error, turn this on.

Manage Click this button to display a dialog allowing S/MIME and SSL
Certificates certificates to be viewed, added or removed.
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4.9 Identity

Identity Preferences

[dantitias
Default

Add... !Ehange...x f Duplitateh " Delete

E Use Tied Identities with Mew Drafts
: Choose Identity from Original Message
: Mailboxes Inherit Tied |dentities

Outgoing Addresses to Count as Mine
daboo@cyrusoft.com

Figure 39 The Identity preference panel

Identities Displays a list of the current set of identities. You can use drag and
drop to re-order identities in the list. The first identity is always
considered the “default’ identity.

Add To add a new identity to the list, click here.

Change... To edit the currently selected identities, click here.

Duplicate To duplicate the currently selected identities, click here.

Delete To delete the currently selected identities, click here.
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Use Tied Identities To automatically select a tied identity when creating a new draft, turn

with New Drafts  this on. The tied identity is determined by the currently selected
mailbox, front most mailbox or message window. Holding down the
Option (Mac OS X), Alt (Windows) or Control (Unix) key when
creating a new draft will produce the opposite behavior.

Choose Identity To automatically select the identity for a reply or forward message
from Original based on the addresses in the message being replied to or forwarded,
Message turn this on.

Mailboxes Inherit To have tied identities inherited from ‘parent’ mailboxes in a mailbox
Tied Identities hierarchy, turn this on.

Outgoing Enter addresses into this field, one on each line. The addresses

Addresses to displayed here are used to determine whether or not you are the

Count as Mine sender of a message when a ‘Smart Address’ is displayed in a mailbox
window.

4.9.1 Editing Identities

Identity Edit
Identity Mame: |
Inherit from: Default ldentity ﬂ
SMTP Account! SMTP F+] [ inherit

[ From | Reply-To | Sender | Options ' Qutgoing ' Security

] Active

( Cancel ) { OK }

Figure 40 The ‘Identity Edit’ dialog box
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The items in the Identity Edit dialog are:
e ‘Identity Name’ — A text string describing the current identity.

e ‘SMTP Account’ — The SMTP server to use for sending messages with this identity. The
popup menu includes all ‘SMTP Send Email” accounts as defined in the ‘Accounts’ panel.

* ‘From’, ‘Reply-To’, ‘Sender’, ‘Options’, ‘Outgoing’ and ‘Security’ tabs — These tabs are
used to specify more options for the current identity, and are described below

4.9.1.1 From Tab

Active To use a custom ‘From’ address when the current identity is selected,
turn this on. If this checkbox is not selected, the inherited ‘From’
address is used instead.

Single Address To enter a single address with separate fields for full name and email
address, click here.

Multiple To enter multiple addresses in a single field, turn this on. If this option

Addresses is selected, a single text box will be displayed in lieu of the ‘Name” and

‘Email’ boxes described next.

Name The name to be used as part of the custom ‘From’ address should be
entered here (e.g. ‘Joe User’).

Email The email address to be used as part of the custom ‘From’ address
should be entered here (e.g. ‘joeuser@mulberrymail.com’).

4.9.1.2 Reply-To Tab

The ‘Reply-To’ tab is identical to the ‘From’ tab. Address(es) entered into this tab will be
used as the Reply-To address when the current identity is selected.

Note: If you choose to use the “Multiple Addresses’ option in
either the ‘From” or ‘Reply-To’ fields, the addresses you enter
should be fully specified email addresses, e.g. "Mulberry Sales"
<sales@mulberrymail.com>.

4.9.1.3 Sender Tab

The ‘Sender’ tab is identical to the ‘From’ tab, except the ‘Multiple Addresses’ option is not
available. The address entered into this tab will be used as the Sender address when the
current identity is selected.
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4.9.1.4 Options Tab

From

Reply-To " Sender | Options | Outgoing [ Security

@ Active

: Copy Tao: [I]

E‘I Mo Copy To
__) Choose Copy To | Also Copy Original Message

E Active E Active

¥-Header Lines Signatura

Figure 41 The Options tab of the Identity Edit dialog

Copy To Enter the mailbox in which copies of messages sent with this identity
are to be saved. Use this to keep a record of messages that you send.
The “Active’ box must be checked for sent messages to be copied.

No Copy To When this item is selected, the ‘Copy To:” popup menu in the Draft

window will be set to ‘None’ by default when the current identity is
used.

Choose Copy To

When this item is selected, the ‘Copy To:” popup menu in the Draft
window will be set to “Choose Later’ by default when the current
identity is used.

Also Copy
Original Message

Select this option to copy the original message into the specified ‘Copy
To” mailbox along with your reply. This option is only applicable when
you are composing a reply or forwarding a message.

X-Header Lines

To create your own custom header field lines for this identity, click this
button. A text box will open where you can type the additional header
lines. The ‘Revert’ button in the text box will cause the text box to
return to the state it was in when originally opened. If ‘Active’ is not
checked, the inherited ‘X-Header Lines’ will be used instead.

Signature

To create your own custom signature to use when sending messages
with this identity, click this button. A text box will open where you can
type your custom signature. The ‘Revert’ button in the text box will
cause the text box to return to the state it was in when originally
opened. If “Active’ is off, the inherited ‘Signature” will be used instead.
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4.9.1.5 Outgoing Tab

From | Reply-To | Sender | Options | Dutgoing | Security
[¥o| Cc | Boc | DSN
Eﬂ.ctiue

IE:’I single Address
") Multiple Addresses

Mame:

Emnail:

Figure 42 The Outgoing tab of the Identity Edit dialog

The first three tabs allow you to specify one or more email addresses to automatically add
to the To, CC, or BCC line of an outgoing message when the current identity is selected.

Addresses specified in these tabs are added to the appropriate header line when you select
the identity from the popup menu in the Draft window, and removed when you switch to

another identity.

The DSN tab allows you to request Delivery Status Notification information for all
messages sent using the current identity. Click the ‘Active’ box to activate this feature.

Request DSN Check this box to request delivery status notification information for
all outgoing messages that use this identity.

Success Check this box to request a notification when the message is delivered

Notification successfully.

Failure Check this box to request a notification when the messages is NOT

Notification delivered successfully.

Delay Check this box to request a notification when there is a delay in

Notification delivering a message.

Return Whole Check this box to request that the entire original message be included

Message with any of the notifications that are selected.

Return Headers
Only

Check this box to request that only the headers of the original message
be included with any of the notifications that are selected.
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Note: Keep in mind that DSN notifications are not guaranteed. These requests
depend on the ability of the various SMTP servers that handle your message to
honor DSN requests. In some cases, you may not receive notifications even if you
have these options turned on.

4.9.1.6 Security Tab

From | Reply-To | Sender | Options [ Qutgoing | Eacuﬁty.r]

E Active

" | Sign Messages
" | Encrypt Messages

Sign with Key: Default Key ﬂ

Eey:

Figure 43 The Security tab of the Identity Edit dialog

This tab will only be available when the Mulberry PGP Plugin is installed.

Sign Messages To automatically sign messages generated when this identity is active,
turn this on.

Encrypt Messages To automatically encrypt messages generated when this identity is
active, turn this on.
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Sign with Key

This popup menu allows you to choose the PGP key you will use for
signing and encryption options when this identity is active. Available
options are:

Default Key — uses the default key as specified within the PGP
application

From Address Key — uses a key with an email address matching the
‘From’ address specified within this identity.

Reply-To Address Key — uses a key with an email address matching
the ‘Reply-To” address specified within this identity.

Sender Address Key — uses a key with an email address matching
the ‘Sender’ address specified within this identity.

Other Key — uses a different key. When this option is selected, you
can type a string in the ‘Key’ box. When you sign a message,
Mulberry will attempt to find a PGP key with a name or email
address that contains the specified string.
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4.10 Addresses

Address Preferences

Allow Choice of Addresses when:
: Option Key is Down
@ Option Key is Mot Down

! Expansion | Capture " Local |

: Use Expansion instead of Nick-names

E Expand when Nick-name Fails

E Expand using Full Mame
E Expand using Mick Mame
E Expand using Email Address

: skip LDAP if Address Book Results are Found

Figure 44 The Addresses preference panel

Allow Choice of  This setting allows Mulberry to automatically display a dialog with a

Addresses choice of addresses when you click the Draft button in the Address
Book or Address Search window. The items in the dialog will
correspond to the items selected in the window when you click the
Draft button. To have this dialog always come up, select the ‘Option
Key is not Down’ (Mac OS X) or “Alt Key is not Down’ (Windows)
option. To have the dialog appear only when you hold down the
Option (Mac OS X) or Alt (Windows) key while selecting the Draft
option, choose ‘Option Key is Down’ (Mac OS X) or “Alt Key is Down’
(Windows).
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4.10.1 Expansion Tab

Use Expansion
instead of Nick-
names

To expand partial addresses via an address book search instead of
using nickname lookup, turn this on. This will cause Mulberry to
search all address books marked for searching for matches in the fields
specified below using the partial address as a search string.

Expand when
Nick-name Fails

To perform address expansion only after nickname resolution fails,
select this option.

Expand using Full To search for the partial address in the Full Name field of all address
Name book entries when doing expansion, turn this on.

Expand using To search for the partial address in the Nick-Name field all address
Nick-Name book entries when doing expansion, turn this on.

Expand using To search for the partial address in the Email Address field of all

Email Address address book entries when doing expansion, turn this on.

Skip LDAP if To prevent LDAP searches occurring when addresses have been found
Address Book by searching only address books, turn this on.

Results are Found

4.10.2 Capture Tab

Capture to: imsp:vince

Expansion | Capture | Local

Display Edit Dialog on Capture

E Allow Choice when Capturing Multiple

92

Capture when Reading a Message
Capture when Responding to a Message

In a Message

E Capture From Addresses

Capture Cc Addresses
Capture Reply-To Addresses
Capture To Addresses

Figure 45 The Captions tab in the Address preference panel
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Capture To:

Select the address book to be used for storing captured addresses.

Allow Choice
when Capturing
Multiple

To be prompted for which address to capture when multiple addresses
in a message are detected, turn this option on.

Capture when
Reading a
Message

To automatically capture addresses from any message that you read,
turn this option on.

Capture when
Responding to a
Message

To automatically capture addresses from any message that you
respond to (reply or forward), turn this option on.

Capture From
Addresses

To capture the addresses in the message's From field, turn this on.

Capture Cc
Addresses

To capture the addresses in the message's Cc field, turn this on.

Capture Reply-to
Addresses

To capture the addresses in the message's Reply-to field, turn this on.

Capture To
Addresses

To capture the addresses in the message's To field, turn this on.

4.10.3 Local Tab

The items in the Local tab are identical to those in the Local tab for a POP3 mailbox account
(see section 4.1.2.2), though the settings in this tab specify the location for the storage of

local address books.
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4.11 Calendar

Calendar Preferences
atart Week on: | Sunday i

4w
p—

Work Days are:

Sun | Mon | Tue | Wed | Thu | Fri | Sat

Preset Hour Ranges for Day/Week Displays

Start on End at
Morning:  6:00AM - 12:00PM .
Afternoon: 12:00PM . C6:00PM .
Evening:  6:00PM . 12:00AM | .
Awake Period:  6:00 AM | - 12:00 AM -
Work Period: CB:00AM .  6:00PM .

: Display Times in Event Labels
E Handle text/calendar Attachments Internally
E Automatically Send Email Invitations and R5WVFs

Figure 46 The Calendar preference panel

Start Week on Select which day of the week is to be considered as the first day in a
week. When displaying items in Week view, the selected day is appears
in the first column.

Work Days are Select which days are ‘work’ days. Non-work days are given a slightly
different background when displayed in calendar views.

Preset Hour Select ranges of hours to be defined for use in restricting the “vertical’
Ranges for time range displayed in day/week views.

Day/Week

Displays

Display Time in To display the start time in events, turn this on.

Event Labels
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Handle To have calendar attachments handled directly by Mulberry when they
text/calendar are viewed, turn this on.

Attachments

Internally

Automatically To have calendar RSVPs automatically sent, turn this on.
Send Email

Invitations and

RSVPs
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4.12 Attachment

Attachment Preferences

{ Sending | Receiving

Ovemride MIME with: AppleDouble |

ar
)

’: Always override MIME
Ej Only overide when needed

: Check for mailte URL Handling on Startup
@ Wam when mailto URL Attaches Files
@ Check for webcal URL Handling on Startup

E Wam if Attachments are not Present in a Draft

E Check Subject as well as Text

Words in a Draft that Imply Attachments

attachment
attached

Figure 47 The Attachment preference panel.

4.12.1 Sending Tab

Override MIME The default encoding to use for files sent from this computer.

with

Mac OS X ONLY

This should normally be set to ‘AppleDouble’ so that files can be read
by users on other computer systems.

Always override  To always use the encoding method specified above regardless of the

MIME file’s type, turn this on.
Mac OS X ONLY
This allows you to always send binary files to other Macintosh users
and ensure that the full file information is sent as well.
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Only override
when needed

Mac OS X ONLY

To only use the encoding method specified above with binary files or
files which may have a resource fork, turn this on.

WINDOWS ONLY

To use MIME mappings determined by the Windows Registry for files
that do not need special processing, turn this on.

UNIX ONLY

To use MIME mappings determined by the mime.types file for files
that do not need special processing, turn this on.

Check for mailto
URL Handling on
Startup

To have Mulberry check whether it is the default mailto URL handler
on the machine it is running on, and prompt you to make it the default
handler if it is not, turn this option on.

Warn when mailto

To display a warning when a mailto URL causes files to be attached to a

URL Attaches draft, turn this on.

Files

Check for “{Ebcal To have Mulberry check whether it is the default webcal URL handler
URL Handling on  on the machine it is running on, and prompt you to make it the default
Startup handler if it is not, turn this option on.

Warn if To display a warning when sending a message without attachments,

Attachments are
not Present in

but with text that implies an attachment should be present, turn this
on.

Drafts

Check Subjectas  To have the subject checked for attachment words as well as the

well as Text message body, turn this on.

Words in a Draft  Enter the list of words (one on each line) which are used to determine
that Imply whether an attachment should be included in a draft.

Attachments
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4.12.2 Receiving Tab

Sending | Receiving ]

Double-click Attachment to:

|

) View it
: Sawve it to Disk

ve to Disk:
IE:‘I Ask for Location
: Use Default Location:

Open after Save:

I'E:‘I Always B
) Ask .=
H‘ NEvEer Sat Mappings

E Include Text Attachments

Figure 48 The Receiving tab in the Attachments preference panel

View it When this option is selected, double-clicking on an attachment in an
incoming message window, will result in the attachment being
temporarily saved to disk and then automatically opened with the
application suitable for displaying it.

Save it to Disk When this option is selected, double-clicking on an attachment in an

incoming message window will result in the attachment being saved to
disk at the location specified by the options described below.

Ask For Location

To be given the choice of name and location when downloading an
attachment, turn this on.

Use Default To use a default name and save an attachment in a default folder when
Location downloading turn this on and enter the folder location in the text field.
Choose To choose the location of the default download folder, click here.
Open After Save:  To have attachments automatically saved to disk after downloading,
Always turn this on.
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Open After Save:  To be given the choice of opening attachments saved to disk after

Ask downloading, turn this on.

Open After Save:  To prevent attachments saved to disk after downloading from being

Never opened, turn this on.

Include Text To have text attachments opened after downloading using the ‘Open

Attachments After Save’ option, turn this on. To prevent text attachments from
being opened after downloading irrespective of the ‘Open After Save’
option, turn this off.

Set Mappings To edit the default MIME type to file type mappings, click here. This

brings up a dialog box (shown in Figure 49) from which you can
specify a relationship between a MIME type /subtype and a Mac OS file
creator and file type (Mac OS X) or a file extension (Windows). These
mappings can then be used to correctly convert between Email
attachments and files on the local computer.
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4.12.3 Mappings

The mappings set in the explicit mappings dialog are used to override the default MIME to
file type mappings specified in Internet settings (Mac OS X), the Windows Registry
(Windows), or the mailcap files (Unix). These mappings are only used for incoming
attachments.

MIME to Mac O5 Mapping

MIME Type to Mac OS5 File Type Mappings:

MIME type/subtypa Mac OS5 Application Tvpe
application/octet-stream xﬁ‘ EBEdit Lite 6.1 for 05 X TEXT
application/text -E" BEBEdit Lite 6.1 for 05 X TEXT
image/jpeg ﬂ:lﬁraphiccnrwerter JPEG

MNew... | x[hange...x * Delete

.__; Cancel l_.- f OK }

Figure 49 The attachments type mapping dialog

To add a new mapping to the list click the Add... button. This allows you to set the MIME
type and subtype and the corresponding file extension for the mapping. You can also

choose which option to use for opening a file when a matching MIME part is downloaded
to disk.

To edit an entry, select that entry in the table and click the Change... button.
To delete an entry, select that entry in the table and click the Delete button.
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4.13 Spelling

Spelling Preferences

! Options | Suggestions .

|21 Case Sensitive

1 Ignore Capitalised Words (e.g. Mulberry)
lgnore All-Caps Words (e.g. IMAFP)

lgnore Words with Mumbers (e.g. System32)

lgnore Words with Mixed Case (e.g. SpellCheck)

ENENENN

lgnore Domain Mames (e.q. XxyZ.com)
|21 Report Doubled Words (e.g. the the)

E Auto Correct

E Automatically Position Dialog

: Always Check Spelling before Sending
E Check Spelling whilst Typing

E Use Colour for Errors: |:|

LA

Main Dictionary: American English -

Figure 50 The Spelling preference panel.

4.13.1 Options Tab

Case Sensitive To test words case-sensitively, turn this on.

Ignore Capitalised To ignore words that are capitalized, turn this on.
Words

Ignore All-Caps  To ignore words that contain only capitalized letters, turn this on.
Words

Ignore Words To ignore words that are a mixture of letters and numbers, turn this
with Numbers on.
Ignore Words To ignore words that contain both lowercase and uppercase characters

with Mixed Case  within it, turn this on.
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Ignore Domain To ignore words which look like internet addresses, turn this on.
Names

Report Doubled  To generate a warning when a word appears twice, turn this on.
Words

Auto Correct To automatically correct certain well known misspellings, turn this on.
Automatically To automatically position the spelling dialog above the text area being
Position Dialog checked, turn this on.

Always Check To have spelling checked before sending, turn this on.

Spelling before

Sending

Check Spelling To have spelling checked as words are typed, turn this on.
whilst Typing

Use Colour for To use a different background colour for misspelled words, turn this
Errors on and choose a suitable colour.

Main Dictionary ~ Choose the dictionary to be used to check words.

4.13.2 Suggestions Tab

Opticns | Suggesu’nns]

E Phonetic Suggestions
E Typographical Suggestions
E suggest Split Words

Suggestions:

IE‘I Fast but less Accurate
F: Moderately Fast and Accurate

") Slow but Accurate

Figure 51 The Suggestions tab in the Spelling preference panel
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Phonetic To have suggestions that sound similar to the misspelled word
Suggestions returned, turn this on.

Typographic To have suggestions that correspond to typing errors of the misspelled
Suggestions word returned, turn this on.

Suggest Split To have suggestions that can be more than one word, turn this on.
Words

Suggestions To determine whether the suggestions are returned quickly or more

accurately, choose the appropriate option.
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4.14 Speech (Mac OS X Only)

This panel will only be available if the Mac OS X Text-To-Speech software is installed on
your computer.

Speech Preferences

Automatic Speech:
: Speak Mew Messages in INBOX
: Speak Messages as they Amive

Message Speak:

= =

Incoming Outgoing

Maximum characters to speak: 4096

Empty Item: This field is blank

Figure 52 The Speech preference panel.

Speak New To automatically have new messages in your INBOX spoken after you
Messages in open the INBOX window, turn this on.
INBOX

Speak Messages as To have new messages spoken when they arrive, turn this on. You can
they Arrive use this to have parts of new email message read to you as the
message arrives (e.g. the name of the sender and the subject).

Speak New Email To have the new email alert speak text instead of beep, turn this on.
Alert
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Speak Enter the text to be spoken when new email arrives if the previous
option is on. Use a single “#” to have the number of new messages
spoken for each mailbox which has new email. Use a single “*’ to have
the name of the mailbox spoken for each mailbox that has new email.
Use “##’ to have the total number of new messages in all mailboxes
with new email spoken. Use “** to have the names of all mailboxes
with new email spoken one after the other in turn.

Incoming To edit which parts of an incoming message are spoken, click here. This
brings up a dialog box (shown in Figure 53) from which message items
and suitable text can be specified for speaking.

Outgoing To edit which parts of a draft message are spoken, click here. This
brings up a dialog box (shown in Figure 53) from which message items
and suitable text can be specified for speaking.

Maximum The maximum number of characters in the body of a message that will
characters to speak be spoken. Use this to limit the amount of text spoken.

Empty Item The text to be spoken when a field in the message being read is empty
should be entered here.

4.14.1 Speech Configuration

Configure Message Speech

Message Speech:

Iltem to Speak Text to Speak bafore Iteam
From {1st address) From
subject Sulbject

© New...

[ Cancel | {_ Ok _}

Figure 53 The dialog used to configure which parts of a message are spoken
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To add a new mapping to the list click the New button to create a new blank entry. This
will bring up the dialog box shown in that allows you to choose which message field is read
and to specify the text to be spoken before that item is spoken. To edit an entry, double-
click that entry in the table. To delete an entry, use the delete key.

Edit Message Speech

ltem: From {1st Address) f

aw
"4

Text: Frc:-rr‘l

._._' Cancel '___. { Ok }

Figure 54 The dialog used to edit items in the speech configuration dialog

You can select which message item to speak from the pop-up menu shown in Figure 55.
The ‘Text’ field can be set to text that will be spoken before the message item is read. The
‘None’ item can be used to speak some text at any point during the message speak process.

= From {15t Address)
From {All Addresses)

To {1st Address)
To (All Addresses)

CC {15t Address)
CC (Al Addresses)

Date
Subject
MNumber of Parts

Body (without Header)
Body (with Header)

None

Figure 55 The pop-up menu of message items that can be spoken
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5. USING MULBERRY

To help you read, compose, and manage your email and calendar data, Mulberry uses
several different windows. The best way to become familiar with Mulberry is to learn
about the information contained in each major window. Each subsection in this chapter
describes one of Mulberry’s main windows, dialogs and menus that might be encountered
in the window, and important concepts to know when using the window.

5.1 Windowing Modes

5.1.1 3-Pane or Separate Windows

Mulberry supports two different window modes for organizing the information it has to
display. A email client typically has three main categories of information to display for
incoming email: a list of mailboxes where email messages are stored; the contents of a
mailbox showing the list of messages in that mailbox; the content of a message. In the 3-
pane window mode, a single window is used to contain all three categories, whereas in the
separate windows mode, each category appears in its own window. There is a similar set of
three categories required for displaying address information.

Mulberry defaults to using the 3-pane mode for new installations. It can be switched
between 3-pane mode and separate windows mode at any time whilst it is running.

To switch into 3-pane mode from separate | Select Use 3-pane Window from the
windows mode Layout sub-menu in the Window menu

To switch into separate windows mode Select Use Separate Windows from the
from 3-pane mode Layout sub-menu in the Window menu

5.1.2 Window Action Options

Various windows and panes in Mulberry show lists of data. Some of that data represents
objects that can be 'opened' or displayed in other windows or panes (e.g. mailboxes or
messages). Mulberry allows you to configure exactly what user 'action’ can be used to
trigger the open/display operation in each of the various lists it displays.

The possible actions available are:
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Action Description

Selection Change The action is triggered when a single item in
the list is selected, either via a mouse click or
via the keyboard.

Single Click The action is triggered when the mouse is
clicked on a single item.

Double-Click The action is triggered when the mouse is
double-clicked on a single item.

Type a Key The action is triggered when the specified

key is typed on the keyboard, and it
operates on whatever is selected in the list
when the key is typed.

Table 1 Possible triggers for window actions.

For each list, there may be two possible sets of action that can be used. One controls the
'preview' behavior, the other the 'open' behavior. 'Preview' behavior is used to display the
chosen list item in the pane in the same window as the list that is being used for previewing
that type of data. For example, the message preview pane in the 3-pane window is used to
display message previews from the mailbox pane (which shows the list of messages). The
preview action will determine when the message preview pane is changed in response to
an action in the mailbox pane. 'Open' behavior is used for opening the chosen list item into
its own window. For example, a message window can be opened to display the content of
a message in its own window. The open action will determine when the message window
is opened in response to an action in the mailbox pane.
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Sarver Pane
To Preview a Mailbox
" Selection Change
" Single Click
%Dﬂuble Click
Type Key
space

To Dpen a Mailbox Window

Selection Change
single Click

_ ! Double Click
Type Key

—

return

' Choose ‘

’ Choose )

Window Options

{ Email | Contacts

Calendar |

Mailbox Pane
To Preview a Message

@ Selection Change
Single Click

Double Click
__ Type Key

II Il

To Open a Message Window

Selection Change
single Click
Dﬂuble Click
¥ Type Key
return

{—

’ Choose

Options
W Use Tabbed Display
@ Restore Tabs on Start

Message Preview
Preview Options
@ Show Address Bar

" Show Summary Headers
@ Show Parts Toolbar

When Previewing a Message

f*) Mark it Seen
" Mark it Seen after:

3 seconds
" Don't Mark it Seen

ok )

Eancel

Figure 56 The Window Options dialog.

The window action options can be configured separately for the 3-pane window and for
separate windows, and for email related lists and contact related lists. The Window

Options dialog shown in Figure 56 can be used to set these options.

5.1.3 Toolbars

Every major window in Mulberry contains a toolbar at the top of the window. The toolbar
contains buttons that cause certain actions to be executed depending on the button, the
window it is in, and whatever might be selected in that window.

&

Create

A

Draft
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Reply Forward Mowve to Delete Expunge |

& B | @ QD

Match  Select | Check  Search | Details

Figure 57 A typical toolbar in a window.
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Figure 57 shows a typical toolbar. On the far-left of the toolbar is a button that can be
clicked to 'collapse' the toolbar to a thin area that does not show any buttons. When the
toolbar is collapsed, another button on the left can be clicked to expand it.

Toolbars in all windows can be completely hidden by selecting the Hide Toolbar
command in the Toolbars sub-menu of the Window menu. Toolbars can be shown again
by selecting Show Toolbar from that same menu.

Toolbar buttons can contain an icon (large or small) and text. You can control whether
icons or text are shown or whether small or large icons are used using the Toolbars sub-
menu of the Window menu.

5.1.3.1 Changing Buttons on the Toolbar

The set of buttons in any toolbar can be customized by adding or removing buttons and
empty space or vertical dividers, or by moving existing items to re-order them. A context
menu is used to manage the toolbar.

Toolbars can contain three types of ‘spacer’ element:

e ‘Separator’ — this is a thin vertical line used as a divider between different groups of
buttons.

* ‘Space’ — this is a blank space of fixed width used to increase the gap between buttons.

* ‘Expandable Space’ — this is used to add space which fills the available space left in the
toolbar. Inserting an expandable space between two sets of buttons results in the
second set appearing right-justified in the toolbar. Only one expandable space can be
present in a toolbar.

To add a new item, bring up the context menu on the toolbar, choose the Add Toolbar
menu item and select the appropriate button, divider or space from the sub-menu.

To remove an item, bring up the context menu on that item and choose the Remove item
from the menu.

To move an item, bring up the context menu on that item and choose the Move item from
the menu. After releasing the mouse, the button will highlight and you can move the
mouse left or right to drag the toolbar item to a new location. Once the item is in the new
location, click the mouse button once to drop it in place.

The Reset to Default Buttons item in the context menu can be used to reset the toolbar
to the default set of buttons built-in to Mulberry.
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5.2 3-Pane Window

Ne e Mulberry (Connected)
— = 3
(e9) |
A By ‘@Euvtﬂr’b@%,ww
Draft Create Reply Forward Move to Delete  Expunge Match Select Check  Search Deetails
{Emai} | Contacts | Calendar | I% INBOX | read-mail | sant-mail} |
Name | Gy @i &5 imap:INBOX.sent-mail x
INBOX 509 501 From =
v [ subscribed B
. ; ¥ =
&5 INBOX. read-mail . 0 [8] |Fmrn. To | Date Sent | Thread |
1 @ B vince@cyrusoft.com 2501 4:02 PM JP test
» ECompzny N ﬁ . e e e s
. . TZT T UL T TT g =8
> u..fnends 30 Hapy sromer 6/B/98 8:01 PM Re: Mulberry is Great!
=3 from the bass 4 »Haoy cusmmer 5/5/03 4:09 FI'\-1 Re: Mulberry is Great!
& jane 5  PVince Everrett [ f How are you?
&5 read-mail 1 0 6 [EF  Pfriend®domainuk 3 8 8:01 P Mulberry is Great
&5 sent-mail g 0 7 @ B friend®domain.uk 29/5/03 11:50 PM  Re: Mulberry is Great!
& work 3] @ P vince everett 29/5/03 11:51 PM Test Message
9 P Mailing List 29/5/03 11:52 PM  List Message
Total: 9 | Unseen: O | Deleted: 1 |Found: @
From: Vince Everett <vince@cyrusoft.com= To: Happy Customer <happy®domain.uks>, ... ©cis [y
Subject: Re: Mulberry is Great! Date: 6/8/98 8:01 PM
P Parts: 1 | " Formatted ) :] | |AAIAv| | " All Quotes | ;]
On Mon, Feb 28, 1995 3:17 pm "Happy Customer ppy@domal I
wrote:
I think Mulberry is great - don't you
Yes - but I wrote it so what do vou expect?
Status: kdle r

Figure 58 The 3-pane window showing email information.

The 3-pane window displays either email or contact information in each of its resizable
panes. The window contains the following areas:

¢ The Tool Bar

Contains a set of buttons to control actions in the various panes. The buttons will
operate on the 'active’ pane in the window. The 'active' pane has a rectangular border

around it. To activate a pane, simply click anywhere in that pane.

* The List Pane

Contains a set of tab buttons at the top to switch between viewing Email , Contacts
or Calendar in the entire 3-pane window. When set to Email, the list pane shows the

list of email accounts and lists of mailboxes within those accounts. When set to
Contacts, the list pane shows the list of address accounts and lists of address books
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within those accounts. When set to Calendar, the list pane shows the list of calendar
accounts and lists of calendars within those accounts.

* The Items Pane

When set to Email, the items pane shows the content of one or more mailboxes. When
more than one mailbox is being displayed, each has an associated tab button at the top
of the pane, and you can switch between viewing each mailbox by clicking on the
corresponding tab. For more details about managing mailbox tabs in this pane, see the
Reference Guide. When set to Contacts, the items pane shows the contents of a selected
address book. When set to Calendar, the items pane shows the view of subscribed
calendars.

* The Preview Pane

When set to Email, the preview pane shows a selected message and associated
addressing and attachment information. When set to Contacts, the preview pane
shows information about a selected address or group, which can be changed. When set
to Calendar, the preview pane shows details about the currently selected event or task.

To resize the panes, click on the area between them (the cursor will change to a horizontal
or vertical bar when over that area) and drag the mouse.

You can show or hide any pane in the 3-pane window by selecting the Show/Hide
List/Items/Preview menu commands in the Window menu.

You can zoom a specific pane to fill the entire 3-pane window area by clicking on the zoom
button in the top-right corner of the relevant pane.

5.2.1 Layout Geometry

The 3-pane window has eight different layouts for the three panes that it contains. You can
select different layouts for Email or Contacts, if desired. The layout geometries are
enumerated in Table 2. To change layout geometry, select the appropriate item from the

Layout sub-menu in the Window menu.

List Vertical List Horizontal
ITEMS LIST
LIST
PREYEW ITEMS | PREWEW
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Items Vertical Items Horizontal

LIST ITEMS
ITEMS
FREWEW LIST FREY EW
Preview Vertical Preview Horizontal
LIST LIST ITEMS
PREYEW
ITEMS PREWEW
All Vertical All Horizontal
LIST
LIST |ITEMS |PREVIEW ITEMS
PREYEW

Table 2 3-pane Window Layout Geometries

5.2.2 Email Toolbar

When set to view email details, the 3-pane window toolbar contains the following items:

74

Draft

Create a new draft window to allow you to compose a new message.

Login or logout of the email server selected in the server pane. This is

Yy only meaningful for IMAP servers.

Legin

Eq_lﬁ Creates a new mailbox in the server pane.
Craate
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5]

Allows you to toggle the display of cabinet items in the server pane.

Cabinat
s Creates a reply to messages selected in the mailbox pane, or the
3 message in the preview pane, depending on which is focused.
Reply
5 Forwards the messages selected in the mailbox pane, or the message
L in the preview pane depending on which is focused.
Forward

Copies or moves the messages selected in the mailbox pane, or the
message in the preview pane depending on which is focused.

Deletes the messages selected in the mailbox pane, or the message in
the preview pane depending on which is focused.

Delete
Expunges (permanently removes) deleted messages in the mailbox
lf?._il shown in the mailbox pane.
Expurnge
@ Turns on or off the mailbox view Match behavior.
Match
Selects messages with the flag criteria (chosen from the popup menu)
in the mailbox pane.
select
TR Checks the selected mailboxes in the server pane for new email, or
VR checks for new email in the mailbox shown in the mailbox pane
Check depending on which is focused.
3 Searches for messages in the selected mailboxes in the server pane, or
— the mailbox shown in the mailbox pane depending on which is
Sparch focused.
= Displays information about the mailboxes selected in the server pane,
Y, or the mailbox shown in the mailbox pane depending on which is
Details focused.

114

Table 3  3-pane Window Email Toolbar
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5.2.3 Contacts Toolbar

When set to view contacts details, the 3-pane window toolbar contains the following items:

Create a new draft window to allow you to compose a new message.

2
3
B .,
o= | | &

Creates a new address book.

Waw

Opens the address book selected in the address book manager pane.

Deletes the address books selected in the address book manager

Creates a new address in the current address book shown in the
address book pane.

1s
Open
E_‘_f. pane.
Delete
b
N

Single
| Creates a new group in the current address book shown in the

&_p address book pane.

Group

Q Deletes the addresses or groups selected in the address book pane.
bl
Delete

Tr— Allows searching for addresses in address books.
Learch

. Shows details about the address books selected in the address book

WL/ manager pane, or the address book shown in the address book pane.
Details

Table 4 The 3-pane Window Contacts Toolbar
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5.2.4 Calendar Toolbar

When set to view calendar details, the 3-pane window toolbar contains the following items:

; Creates a new draft window. When an event or task is selected, the
M selected item is added to the draft as an attachment.
Draft
P Changes calendar accounts between online and offline states.
Login
— Creates a new calendar or calendar container in a calendar account.
Create
ILa} Creates a new event.
Event
Q} Creates a new to do item (task).
To Do
Changes the calendar view to display a single day.
|
Diay
Changes the calendar view to show the work days.
Waork
Changes the calendar view to show an entire week.
Weelk
_____ Changes the calendar view to show an entire month.
Maonth
Changes the calendar view to show an entire year.
Year
Changes the calendar view to display a listing of events within a
specified time range.
SUITHTAY
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Shows or hides the tasks view.

=

Tasks

iﬂ Changes the current event view so that the current day is displayed.
Today

| ﬂ Switches the current event view so that a chosen date is displayed.
oto

o When a calendar or calendar account is selected, this will display a
W1/ dialog providing details about the selected item.
Details

Table 5 The 3-pane Window Calendar Toolbar

5.2.5 Server Pane

The server pane is used to display email accounts and mailboxes. A full description of the
pane can be found in Section 5.4 where the Server Window is described.

5.2.6 Mailbox Pane

The mailbox pane is used to display the content of a mailbox - the list of messages in that
mailbox. The mailbox name is listed at the top of the pane. If the mailbox state cannot be
changed, the mailbox name will have the text (Read-Only) appended to it. Operations
such as deleting will not be possible in that state.
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5.2.6.1 Mailbox Tabs

(F&F INBOX  read-mail | sent-mail | work | friends | o
g imap:INBOX.sent-mail X
From == ]

PN ™ From / To | Thread |=

1 @ P vince@oyrusoft.com JP test

z E:E i Everrett fest

3 o B Happy Customar Re: Mulberry is Great!

4 @ B Happw Custormar Re: Mulberry is Great!

] [_5"' B Vince Everrett How are wou?

6 G Pfriend®domain.uk Mulberry is Great

v @ P friend®domain.uk Re: Mulberry is Great!

a8 @ B vince everett Test Message

9 B P Mailing List List Messar
Total: 9 Uns=en: O Deleted: 1 Found: O

Figure 59 The Mailbox Pane with five tabs.

The 3-pane window supports an optional 'tabbed' mailbox pane, as shown in Figure 59 -
which shows a mailbox pane with five tabs. This allows multiple mailboxes to be open
within the mailbox pane, with a tab associated with each at the top of the pane. Clicking on
a tab will display the associated mailbox content. Mulberry preserves the 'view state' (scroll
position, selected messages, message being previewed) for each mailbox tab when
switching back and forth between tabs. This allows 'browsing' of multiple mailboxes in an
efficient manner. The tab for a mailbox that contains new messages will have a & icon

before the mailbox name.

The tabbed behavior is controlled via the Window Options dialog, accessed via the
Options command in the Window menu. Two options are available:

Window Options item Description

Use Tabbed Display When this is on, the tabbed display behavior
is turned on. When it is off, tabs are disabled
so that only a single mailbox can be open
and displayed in the mailbox pane.

Restore Tabs On Start When this is on, any tabs that were
displayed at the time Mulberry was last quit
will be re-opened when Mulberry next starts

up.
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Right-clicking on a tab brings up a context menu, as shown in Figure 60, that allows you to
change the position of the tab, as well as set certain properties on the tab.

Mailbox Tab menu item

Move Left
Move Right
Move to Start
Mowve to End

Close
Close All
Close Others

Rename...

Lock
Lock All
Dynamic

Save Current Set
Restore Last Set

Figure 60 The Mailbox Pane tabs' context menu.

Description

Move Left

Move the tab clicked on one position to the

left in the tab list.

Move Right Move the tab clicked on one position to the
right in the tab list.

Move to Start Move the tab clicked on to the start (far-left)

of the tab list.

Move to End

Move the tab clicked on to the end (far-
right) of the tab-list.

Close Close the tab (and thus the mailbox) of the
tab clicked on. This may be disabled if the
tab is locked.

Close All Close all unlocked tabs (and thus all

Mulberry Reference Guide v4

mailboxes) in the mailbox pane. Tabs that
are locked will not be closed.
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Close Others Close all unlocked tabs (and thus all
mailboxes) in the mailbox pane other than
the one being clicked on. Tabs that are
locked will not be closed.

Rename... Change the name of the tab clicked on. This
allows an alternative to the mailbox name to
be used in the tab, which helps avoid the
problem of duplicate names (e.g. two
INBOX mailboxes from different accounts).

Lock Locks the tab clicked on. See below for more
details on locked tabs.
Dynamic Changes the 'dynamic state' of the tab

clicked on. See below for more details on
dynamic tabs.

A 'Locked' tab is one that cannot be accidentally closed. The context menu close
commands, the File menu Close command and the tab Close button (far-right of the tab

area) are disabled for locked tabs. Locking is useful for mailboxes you always want to be
tabbed.

The 'Dynamic' tab is a tab that will be reused when a new mailbox is opened. Only one tab
in the entire list can be dynamic, but it is also possible to have no dynamic tabs. This
behavior is useful when you have a fixed set of mailboxes you always want visible (locked)
but then want to 'browse' other mailboxes without adding more and more tabs for each.
The dynamic tab will be reused for each of the additional mailboxes being browsed.

5.2.7 Message Preview Pane

The message preview pane, as shown in Figure 61 is used to display a chosen message
from the mailbox currently on display in the mailbox pane.

From: Vince Everett <vince@cyrusoft.com>  To: Happy Customer <happy®@domain.uk>, ... [y
Subject: Re: Mulberry is Great! Date: 678798 8:01 PM
= Parts: 1 = Formatted ﬂ A“lA~ All Quotes _t]

------ 1045 217 mne "Honnw Cictamar®  chanmuidnes

[

Tes - but I wrote 1t so what do yvou expect?

Figure 61 The message preview pane.
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The message preview pane has three main sections:

* The Address Bar which is used to provide summary information about the message
(the From, To and CC addresses, the Subject and Date).

* The Parts Toolbar which is used to provide information about the parts in the message.
* The Message Text Display which shows the message content
The Parts Toolbar and Message Text Display are described in more detail in Section 5.8.

The components of the message preview can be controlled via the Window Options
dialog, accessed via the Options command in the Window menu.

Window Options item Description

Show Address Bar When this is on, the address bar summary
information is displayed in the preview
pane.

Show Summary Headers When this is on, summary message header

information is displayed at the top of the
Message Text Display in the preview pane.

Show Parts Toolbar When this is on, the parts toolbar will be
displayed in the preview pane.

5.2.7.1 Changing Seen State

When an unseen message is opened into its own window, it is always marked as seen.
When a message is previewed in a preview pane, you can control whether the seen state is
changed immediately, after a short delay (assuming the message is still previewed after
that delay) or not at all. This is controlled via the Window Options dialog, accessed via the

Options command in the Window menu.

Window Options item Description

Mark it Seen When this is on, the message will always be
marked seen as soon as it is previewed.

Mark it Seen After: When this is on, the message will only be

marked seen after the specified delay,
assuming it is still being displayed at that
time.

Don't Mark it Seen When this is on, the message will not have
the seen flag turned on when it is
previewed.
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5.2.8 Address Book Manager Pane

The address book manager pane is used to display address book accounts and their
associated address books. A full description of the pane can be found in Section 5.10 where
the Address Book Manager Window is described.

5.2.9 Address Book Pane

The address book pane is used to display the content of an address book - both the single
address entries and the group entries. A full description of the pane can be found in
Section 5.12 where the Address Book Window is described.

5.2.10 Address/Group Preview

The address/ group preview pane is used to display an address or group. The address or
group can be edited directly in the preview pane. A full description of the pane can be
found in Section 5.12 where the Address Book Window is described.

5.2.11 Calendar Store Manager Pane

The calendar store pane is used to display calendar accounts and their associated calendars.
A full description of the pane can be found in Section 5.13 where the Calendar Store
Window is described.

5.2.12 Calendar View Pane

The calendar pane is used to display the content of one or more calendars. A full
description of the pane can be found in Section 5.14 where the Calendar Pane is described.

5.2.13 Event/task Preview Pane

The event/task preview pane is used to display a details about an event or task. A full
description of the pane can be found in Section 5.14 where the Calendar Pane is described.

122 Mulberry Reference Guide v4



5.3 Status

Mac OS X
UNIX

The status line at the bottom of the 3-pane window provides status
information about the Network operations currently in progress. It will also
give an indication of the progress of operations that may occasionally take a
long time to complete (for example sending large attachments or opening
large mailboxes).

In separate windows mode, the status information appears in its own
window. Clicking the close box will hide the window. To see the window

again select the Status item from the Window menu (see page 311). The
location of the status window and its hidden/shown state are saved in the
current preferences file when Mulberry is closed, and then restored from
that preferences file when it is used to launch Mulberry again.

WINDOWS

The status line at the bottom of the main window provides status
information about the Network operations currently in progress. It will also
give an indication of the progress of operations that may occasionally take a
long time to complete (for example sending large attachments or opening
large mailboxes).
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5.4 Mailbox Server Pane/Window

{Email | Contacts  Calendar . R

Mame I '1’5-3-"‘1! EIE

&3 INBOX 509 501
v [ subscribed
e INBOX. read-mail 1 0
> F:ltnr'-'npan}'
P &g friends 4 0

@ from the boss

G jane

g read-mail

g sent-mail 5
o work

Figure 62 The server pane.

The server pane, an example of which is shown in Figure 62, displays several different
entities, the most important being all of the email servers as defined in the ‘Accounts’
preferences, as well as the mailboxes available on each email server.

Depending on how you’ve configured Mulberry, the server pane/window can display a
simple list with your INBOX and a few mailboxes of interest, or a complex list of multiple
email servers, subscribed mailboxes, cabinets, and display hierarchies.

The server pane is divided into two main sections:

* The items in the Column Header section indicate what type of mailbox information is
displayed in the corresponding column in the Mailbox List section.

* The Mailbox List section displays lists of mailboxes, cabinets, email servers, and other
items.

5.4.1 Server Window Toolbar Buttons

The server window has a toolbar associated with it, whereas the server pane in the 3-pane
window uses the toolbar in the 3-pane window.

The server window toolbar contains the following items:
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Create a new draft window to allow you to compose a new message.
For more information on the compose window, see page 224.

Draft

T Login or logout of the email server selected in the server pane.

il Logging in to an IMAP email server automatically generates a list of
T mailboxes available on the selected server, which includes your

INBOX, any subscribed folders, and any display hierarchies you've
previously specified. POP email servers and local mailbox accounts
are always ‘logged in’. Logging out of a server causes Mulberry to
terminate all connections to that server. Note that Mulberry
maintains a constant connection to an IMAP server when logged in.

If you only have one email server account set up, the Login button
will act on that server, and will always be available. If you have
multiple email server accounts set up, you must select one of those
accounts in the “Mailbox List’ section of the server window to make
this button active.

When you are already logged in to the selected email server, the
Login button will change to a Logout button. Logging out of a
server causes Mulberry to terminate all connections to that server.

Creates a new mailbox in a selected email account or within a selected
display hierarchy. When you click this button, you will be presented
with a ‘Create Mailbox” dialog that allows you to enter a name for the

Create
new mailbox and specify where it will be created. This button is not
available unless a email server, display hierarchy or mailbox (that is
allowed to contain other mailboxes) is selected. Creating mailboxes is
covered in more depth on page 137.
—— Allows you to toggle the display of cabinet items in the server pane.
v More information on cabinets is available on page 138.
Cabinet
3 Checks the selected mailboxes in the server pane for new email.
I:‘-j l;‘.-"l
Chack
e Searches for messages in the selected mailboxes in the server pane.
— When you click this button, you are presented with a new search
Search window. The search window is covered on page 167.
i Displays information about the mailboxes selected in the server pane.
Details

Table 6 The Server Window Toolbar
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5.4.2 Column Headers

The column headers indicate what mailbox information is displayed in each column in the
mailbox list below it. The column indicates with text or an icon what the information is:

Name

The name of the displayed item.

= State

Icons representing the state of the corresponding mailbox. These
icons include:

s Indicates that the mailbox is open and a corresponding
mailbox window is on screen.

'L!J' Indicates that the mailbox is closed, but is marked for
automatic email checking.

s~  Indicates that the mailbox is closed, but it has new messages.

No icon means the mailbox is closed and has no new messages.

&y Total

The total number of messages in the mailbox the last time it was
checked. If the mailbox has never been checked or opened, a dash
will appear.

%] Recent

The number of new messages that have arrived in the mailbox the
last time it was opened. If the mailbox has never been checked or
opened, a dash will appear.

7% Unseen

The number of unseen messages in the mailbox the last time it was
checked, or, if the mailbox is open, the current number of unseen
messages in the mailbox window. This last value may be different
from the total number of unseen messages in the mailbox if the
mailbox window is only displaying a subset of all the messages in
the mailbox. If the mailbox has never been checked or opened, a
dash will appear.

'Lu" Favorite

A “diamond’ button that can be clicked to turn on or off automatic
checking of the corresponding mailbox. If the mailbox is marked for
automatic checking the button will have a check mark:

@ Indicates a mailbox not marked for automatic checking.

4%  Indicates a mailbox marked for automatic checking.

Mailboxes marked as favorites are automatically added to the
‘Check Favorites’ cabinet. For more information on cabinets, see
page 138.
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Size The size of the mailbox. This information is available for locally-
stored mailboxes, such as mailboxes in a POP or Local Mailbox
account, or IMAP mailboxes cached for disconnected mode
operations.

For IMAP mailboxes in connected mode, the size has to be manually
calculated. For mailboxes that have not had their size calculated the

button appears. Clicking this button will cause Mulberry to
calculate the mailbox size and then display it in place of the button.

B Hierarchy This button is only available when a cabinet or display hierarchy is
Display Toggle selected. Items within cabinets and display hierarchies can be
== Button viewed as either a flat or hierarchical list. Clicking this button

toggles between these two views.

Column headers can be re-arranged, added, or deleted.

Mac 0S X  Hold down the control key and click the mouse button (ctrl-click) on a
column header to change the column type, insert a new column, or delete

the column.
WINDOWS Click the right mouse button on a column header to change the column
UNIX type, insert a new column, or delete the column.

When you do this, the menu shown in Figure 63 will appear.

State

v Total
Recent
Unseen
Favourite
S5ize

Insert Column after
Insert Column before
Delete Column

Figure 63 The pop-up menu for changing column headers in the server window

Note: The ‘Name’ column, which displays the names of the various items in
the server pane/window, is always present and cannot be changed or
deleted. However, you can insert columns before or after it. Additionally, the
hierarchy display toggle button cannot be changed or removed.
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5.4.3 Mailbox List

The main purpose of the mailbox list section of the server window is to display the various
mailboxes available to you. However, depending on the number and type of email servers
you have access to, your list of interesting mailboxes may be quite large. In order to help
you categorize and organize your mailboxes, several types of entities other than mailboxes
can be displayed in the server window. The following icons represent these different
entities:

Servers
v/ An IMAP server account.

e An IMAP server account that is available for use in disconnected mode. This icon
is only shown when in disconnected mode.

A POP server account.

& &

A Local Mailbox account.

Mailboxes

A remote mailbox that can be opened.

A remote mailbox that cannot be opened or that failed to open in the past.
A remote mailbox that contains no new messages.

A remote mailbox marked as interesting.

B0 XKE

A mailbox with messages stored on the local disk. This can either be a mailbox
within a POP or Local Mailbox account, or an IMAP mailbox that has been
synchronized for use in disconnected mode.

(@

A mailbox whose contents are only available while in connected mode.

Note: Mulberry depends on responses from the IMAP server to
decide which of the remote mailbox icons to display for a particular
mailbox. Some IMAP servers do not communicate mailbox states, in
which case the first remote mailbox icon will be used for all
mailboxes.

Cabinet

A cabinet, which stores aliases of mailboxes (see page 138).

[

An alias to a mailbox, found within a cabinet
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Mailbox ‘containers’

- A folder, which may contain more mailboxes or other folders. Note that unlike a
mailbox, a folder does NOT hold email messages. It is simply used as a
placeholder within a hierarchical list of mailboxes.

= A display hierarchy, which may contain mailboxes or folders (see page 133).

The subscribed mailbox list.

At the highest level, the mailbox list shows all of the email servers you have defined in the
Accounts preferences panel, listed alphabetically, as well as any cabinets that you have
made visible. Within each email account, the INBOX is shown at the top, followed by the
list of subscribed mailboxes and any display hierarchies that have been defined, listed
alphabetically.

Figure 62 shows a simple server pane, with the default column headers and only one email
server defined. There are no subscribed mailboxes, and one display hierarchy is defined.
Notice that since only one email server account is defined in the Accounts preferences
panel, the name of the account is shown in the title bar of the server window rather than in
the mailbox list area. Because only one display hierarchy is defined in this example, the
contents of the hierarchy are displayed directly in the mailbox list area.

A more complex server window is shown in Figure 64. The window shows multiple email
accounts and their contents. Since multiple email accounts are defined, the title of the
server window is simply ‘Servers’, and the contents of each server account are displayed
under a collapsible header. The list of ‘Subscribed’” mailboxes in the third email account (the
second IMAP account) is shown as a flat list, while the contents of the expanded display
hierarchy ‘INBOX.* in the first IMAP account is shown as a hierarchical list.
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e 06 Servers (Connected)

7} e @ W Q

(b

Draft ut  Create Cabinet Check  Search Details
|Name | @Jl L | i
¥ @ imap i

e INBOX sog so1 ¥
— _ ™
b4 Subscribed
e INBOX. read-mail 1 0
v  [Hineox
> E Company
| e friends 4 0
@ from the boss
& jane
g read-mail 1
e sent-mail 5
g work
v & rorz
& INBOX 0 0
v [@)Local
ﬁ Home - ™

ﬁ Test - - A
ﬁ Work - - |
4

Figure 64 The server window with multiple email accounts, multiple display
hierarchies and some subscribed mailboxes

Double-clicking on a server name will open a new window, similar to the server window,
but displaying only the contents of that email server account. Clicking or double-clicking a
mailbox in the list will open a mailbox window containing message captions for that
mailbox (see page 158).

Note that several items in the server window, including email servers, cabinets, and all
hierarchies can be expanded and collapsed using disclosure buttons. This allows you to
organize a complex server window to show only the mailboxes of immediate interest.
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5.4.4 Working with the Server Pane/Window

5.4.4.1 Logging In To Servers

When you open an IMAP mailbox in connected mode, Mulberry must first log in to the
appropriate IMAP server if it has not already done so. When you check for new email in a
POP3 INBOX mailbox, Mulberry must login to the POP3 server. When a login is necessary,
the dialog shown in Figure 65 appears, allowing you to enter your user ID and password
for that server. If you wish, you can set your preferences to automatically login to all
IMAP email servers when you start Mulberry (see page 38).

Note: Your user ID may be specified in the preferences, in which case you
will not be able to change it (as shown in Figure 65). Similarly, if you have
also set your preferences to save the password for the current account, the

Login dialog may not appear at all. In addition, some authentication
mechanisms do not require the Login dialog.

Set User ID & Password

Login to IMAP Server:
P_'] imap (imap.cyrusoft.com)

User ID: vince-1 -aps lock i
dowm

Password:

Method: CRAM-MDS5
Connection: Secure: S5L

(" Cancel ) {_ Ok .}

Figure 65 The dialog used to log in to a server

The login dialog will also appear when a login is necessary for other types of servers, such
as an IMSP or ACAP preferences server. The icon in the login dialog is used to indicate
what type of account is being logged in to. The server type icons are:

E j For an IMAP email server.

E?-;J For a POP email server.
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—

For an SMTP send email server.

For an IMSP or ACAP remote preferences server.

For an IMSP or ACAP remote address book server.

For an LDAP remote address lookup server.

"B E

For a ManageSIEVE sieve script server.

C

For a WebDAV or CalDAV calendar server

]

5.4.4.2 Modifying the List of Mailboxes

By default, Mulberry will always show your INBOX as the first item under each email
server account. The INBOX is usually where your incoming email is stored. In the case of
IMAP email accounts, any subscribed mailboxes will be automatically displayed after you
login, in the ‘Subscribed” hierarchy, immediately below the INBOX. Other mailboxes and
hierarchies are displayed only if you explicitly ask for them. This can be done in two ways:

* Open a mailbox directly. This is described in more detail on page 131.

e Add a new display hierarchy. This is described in more detail on page 133.

5.4.4.3 Opening Mailboxes

The simplest way to open a mailbox is to click/double-click on the icon of the desired
mailbox in the mailbox list. Alternatively, a mailbox can be opened by selecting the Open

Mailbox... option from the File menu (see page 296). When you do this, the dialog shown
in Figure 66 is displayed.

In the Open Mailbox dialog, you can enter the full pathname of the mailbox to open in the
‘Name’ text box. If you have configured multiple email server accounts, you can select the
account on which the mailbox exists in the ‘Account” popup menu. Clicking the Browse...
button will produce a ‘Browse Mailbox” window with contents similar to the server
window, allowing you to select a mailbox to open. The Open Mailbox... command is most
useful for directly opening mailboxes that aren’t listed in the server window.
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Open Mailbox

Account: imap B

Mame: |

( Browse... | ( Cancel )

Figure 66 The Open Mailbox dialog

Note: The server window must be the active window for the
Open Mailbox command to be active.

5.4.4.4 Display Hierarchies

Display hierarchies are a means of displaying a list of mailboxes within a particular
hierarchy. These are most useful in conjunction with IMAP servers, where mailboxes are
stored in hierarchies, but can also be used to view mailboxes in POP or Local Mailbox
accounts that you have organized hierarchically on disk.

The concept of display hierarchies are somewhat complicated by the fact that different
types of IMAP servers store mailboxes in different ways.

Some IMAP servers store mailboxes within a standard UNIX directory structure on the
server machine. For example, mailboxes can be stored in a user’s home directory (usually
denoted as ‘~/’), or in a subdirectory of the home directory, such as ‘~/mail/’. Since IMAP
servers allow mailboxes to be shared among many users, interesting mailboxes may also
exist in directories outside of a user’s home directory, such as ‘~bob/mail / public/’ or
‘~public/’.

In contrast, other types of server maintain a completely separate email store, which is often
not directly accessible to users except through IMAP. Users can create personal mailboxes
in the INBOX hierarchy, such as INBOX.work” or INBOX.friends.bob’. Other users’
shared mailboxes may be available in a separate hierarchy such as ‘user.bob.public’.

In order for Mulberry to display the mailboxes available in a particular location on an
IMAP server, a display hierarchy must be created. In simple terms, a display hierarchy is
simply a pointer to a particular location in a email store. For example, a display hierarchy
of ‘~/* on the first type of server described above, will list all of the available mailboxes in
a user’s home directory. An ‘INBOX.* display hierarchy on the second type of server will
list all of a user’s personal mailboxes.

5.4.4.41 Configuring all Display Hierarchies

You can configure all display hierarchies in one go by using the Choose Mailbox Locations
dialog, which is accessed by selecting the Display Hierarchy>Reset All... command from
the Mailbox menu. This dialog, shown in Figure 67, allows you to see which hierarchies are
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advertised by the server (if there are any) and what other hierarchies you have specified
by hand.

Choose Mailbox Locations

Mulberry needs to know where to look for mailboxes on your IMAP server. The
sErver suggestions below, are mailbox locations suggested by vour server. You can
use any of these by clicking the button to the left of each entry. You can enter
other mailbox locations in the text area below the server suggestions, one on each
lime. You can alse add mailbox locations later, if you want.

Server Suggestions:

On | Mailbox Location | Type
9 INBOX. Personal
< user. Shared
3 «<«<Entire Hierarchyz== Public

5'E|E‘ET—'[FersnnaI:| [ Shared :I [ Public } [ All :I [ None :I

E Automatically Add Server Suggestions in Future

Places to Search for Mailboxes on the Server

Company.
demo.

(_Cancel ) 0K )

Figure 67 The Choose mailbox Location dialog box
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Server
Suggestions

Contains the list of display hierarchies advertised by the server via
the optional IMAP NAMESPACE extension. If the account being
changed is not an IMAP account, or is an IMAP account in
disconnected mode, or is an IMAP account on a server that does not
support NAMESPACE, then this list, and the buttons immediately
below it, will not appear.

The list shows the name of each hierarchy on the left, and the type of
hierarchy on the right. Types are:

* Personal - a list of mailboxes that belong to you alone.

* Shared - a list of mailboxes that belong to other users,
which have been shared with you.

* DPublic - a list of mailboxes that are publicly accessible and
available to you.

To have Mulberry display or remove from display each hierarchy,
simply click the diamond to the left of each name.

Personal

Clicking this button will select all the Personal display hierarchies
advertised by the server for display by Mulberry.

Shared

Clicking this button will select all the Shared display hierarchies
advertised by the server for display by Mulberry.

Public

Clicking this button will select all the Public display hierarchies
advertised by the server for display by Mulberry.

All

Clicking this button will select all display hierarchies advertised by the
server for display by Mulberry.

None

Clicking this button will deselect all display hierarchies advertised by
the server from the display in Mulberry.

Automatically
Add Server
Suggestions in
Future

When this option is selected, Mulberry will automatically insert all
display hierarchies advertised by the server into the display, each
time it logs in to that account after startup. To prevent display
hierarchies from automatically appearing, turn this option off, and
deselect the display hierarchies you want to remove from display in
the list above.

Places to Search
for Mailboxes on
the Server

Enter a list of display hierarchies, one on each line, that you want
displayed by Mulberry. You do not need to add display hierarchies
already selected in the Server Suggestions list, if available.

5.4.4.4.2 Adding a Single Display Hierarchy

To simplify the process of creating display hierarchies, Mulberry provides the Display
Hierarchy dialog, which is accessed by selecting Display Hierarchy>New Display
Hierarchy... from the Mailbox menu. This dialog, shown in Figure 68, allows you to build
a new display hierarchy using a natural language query.
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Display Hierarchy

Search in account  imap ﬂ
for mailboxes  in sub-hierarchy ﬂ

" Display Full Hierarchy
E‘} Display Top Level of Hierarchy Only

( Cancel ) {_ DK _,'r

Figure 68 The Display Hierarchy dialog box

Several options are available to assist you in finding available mailboxes:

Search in account

If you have more than one email server account defined, choose the
account you want to search using this popup menu.

For mailboxes

This popup menu specifies the pattern you wish to use to find
available mailboxes. Each of these options works in conjunction with
a string that you type in the text box below the popup menu.
Available options are:

‘whose name starts with’ - find mailboxes with names that begin with
the specified text string.

‘whose name ends with’ — find mailboxes with names that end with
the specified text string.

‘whose name contains’ — find mailboxes with names that contain the
specified text string.

‘whose name is’ — find mailboxes with names that match the specified
text string exactly.

‘in sub-hierarchy’ — find mailboxes in the hierarchy specified by the
text string

‘in entire hierarchy’ — find all mailboxes available on the specified
email server. The text box will not accept any input if you choose this
option.
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Display Full To have the full hierarchy matching the search pattern initially
Hierarchy displayed, choose this option. Selecting this option causes the names
of all mailboxes in the specified hierarchy to be fetched from the
server when logging in.

Note: This is only available when you are finding
mailboxes using the ‘in sub-hierarchy’ or ‘in entire
hierarchy’ options.

Display Top Level | To have only the top level of the hierarchy matching the search

of Hierarchy Only | pattern initially displayed, choose this option. Selecting this option
causes Mulberry to fetch only the names of the mailboxes at the top
level of the specified hierarchy when logging in.

Note: This is only available when you are finding
mailboxes using the ‘in sub-hierarchy’ or ‘in entire
hierarchy’ options.

Once you have created a display hierarchy, it will be shown under the appropriate email
server account in the server window until you delete it. To delete a display hierarchy, click
once on the hierarchy and select Display Hierarchy>Remove Display Hierarchy... from
the Mailbox menu. To edit a display hierarchy, select Display Hierarchy>Edit Display
Hierarchy... from the Mailbox menu. A dialog box will appear asking you to specify a
new path for the display hierarchy. To refresh the contents of a display hierarchy, select
Display Hierarchy>Refresh from the Mailbox menu.

Note: If there is only one display hierarchy defined for a
particular server, only the contents of that display hierarchy will
be visible. To edit or remove a single hierarchy, you need to use
the Server Details window for the server (see page Error!
Bookmark not defined.).

Note that some display hierarchies may appear automatically under certain IMAP email
accounts. IMAP servers that support the NAMESPACE extension (see page 23) have the
ability to advertise a list of interesting display hierarchies to a email client. Mulberry will
automatically list these display hierarchies if the ‘Automatic Hierarchy List” option (see
page 38) is turned on for a particular IMAP email account.

5.4.4.5 Creating, Renaming, and Deleting Mailboxes

Once you have customized the mailbox list in the server window, you may want to create
your own mailboxes under one or more mail server accounts. You can create a new

mailbox by choosing Create... from the Mailbox menu or by clicking the Create button
in the window tool bar. When you do this, the dialog shown in Figure 69 is displayed.

There are two types of mailboxes that you can create. One is a mailbox that contains
messages, the other is a mailbox that is used as the 'root' for a hierarchy of other mailboxes
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appearing below it. The later is similar to a 'directory’ in a file system, whereas the former
is similar to a file. You can select which type of mailbox to create by clicking the Create a
Mailbox to Contain Messages or Create a Mailbox to Contain Mailboxes button.

You can choose to enter the full pathname for the new mailbox (e.g. INBOX.newbox” or
‘~/mail/newbox’) by clicking the Full Pathname button. You can also choose to create
the mailbox in an existing hierarchy by clicking the Create in Hierarchy button. In this
case just enter the name of the mailbox (e.g. ‘newbox’). You can choose to have the server
automatically subscribe to the new mailbox by selecting the Subscribe when Created
checkbox. When you create a new mailbox, Mulberry will automatically insert it in the
correct location in the server’s mailbox list and also open an empty mailbox window for
the new mailbox.

Create Mailbox
'E} Create a Mailbox to Contain Messages
__ Create a Mailbox to Contain Mailboxes

Mame:

“J Full Pathname
) Create in Hierarchy:
INBOX.

in Account: imap

| Subscribe when Created

[ Cancel | {_ Ok _}

Figure 69 The dialog used to create a new mailbox on the server

The default selections in the Create Mailbox dialog will vary depending on the item you
had selected before executing the Create Mailbox command. For example, if you click on a
display hierarchy in the server window and then create a new mailbox, the dialog assumes
you meant to create the new mailbox in that hierarchy. If you click on a server name in the
server window and then create a new mailbox, you will only be able to specify the new
mailbox name using a full pathname.

5.4.4.6 Cabinets

Cabinets provide a powerful mechanism for grouping sets of mailboxes together. In
simple terms, a cabinet is a collection of aliases to different mailboxes. The server window
displays cabinets at the top of the mailbox list section, before any email servers or
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mailboxes. Cabinets can not be displayed in individual server windows, only the main
server window. You can control which cabinets are displayed using the Cabinet popup
menu in the server window tool bar. To display a cabinet, click on the Cabinet popup
menu and select a cabinet name. Cabinets that are currently displayed have a check mark
in front of their name. To hide a cabinet, click on the popup menu and select the
appropriate cabinet name again. Figure 70 shows the server window with three cabinets
displayed:

eSO Servers (Connected)

A o @ W QD
Draft | Create '[.alt:nine':r Check  Search Details
|Hame | @Jl = |E
v [& check Favourite .

&5 imap:INBOX 0 0 ;
s imap:INBOX. read-mail 1 0
s imap:INBOX.sant-rmail 5
s POP3:INBOX 509 509
s POP3:INBOX 509 509
23 CMUINBOX
@ dummy:INBOX
v Mark Seen on Close
imap:lists.* "
hJ Mew Messages
s POP3:INBOX 509 509
¥ (Jimap
&3 INBOX 0 0
v Subscribed
e INBOX. read-mail 1 0
v INBOX.
» B Company v
P

Figure 70 The server window with cabinets displayed

Mulberry comes with several pre-defined cabinets. You can also create as many of your
own cabinets as you like. The pre-defined cabinets that come with Mulberry are:
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Check Favorites

This cabinet contains a list of mailboxes marked for automatic
checking. This cabinet is used by the first alert style by default
(see page 50).

Open After Login This cabinet contains a list of mailboxes that Mulberry should
open automatically after starting up.
Copy Messages To This cabinet contains a list of mailboxes that will appear in the

Copy To popup in the Message window or the Copy to
Mailbox sub-menu under the Message menu. Note that the
contents of this cabinet are only used if the ‘Use Copy Messages
To Cabinet’ option is checked in the Mailbox preference panel
(see page 65).

Copy Drafts To

This cabinet contains a list of mailboxes that will appear in the
Copy To popup in the Draft window or the Append to Mailbox
sub-menu under the Draft menu. Note that the contents of this
cabinet are only used if the “Use Copy Drafts To Cabinet’ option
is checked in the Mailbox preference panel (see page 65).

Mark Seen on Close

Mailboxes listed in this cabinet will automatically have all
messages marked as seen when their mailbox windows are
closed.

Auto Synchronize

This cabinet contains a list of IMAP mailboxes that will be
synchronized automatically when switching between connected
and disconnected modes. For more information on disconnected
mode operations, see page 151.

New Messages

This cabinet contains a list of all mailboxes that have been marked
for automatic checking, AND have been found to have new
messages since they were last opened. This is a fast and
convenient way to display a list of only those mailboxes that have
new messages to be read. This cabinet is an example of an
‘automatic’ cabinet that is maintained by Mulberry. The contents
of this cabinet can not be changed directly.

Subscribed

This cabinet contains a list of all mailboxes marked as subscribed
in all IMAP email accounts.

Cabinets can contain mailboxes from multiple email servers. When multiple email server
accounts are defined, Mulberry will prepend the server name and a colon (:) to the mailbox
names within a cabinet. The contents of cabinets are always sorted, first by server name
and then either alphabetically or hierarchically.

To add a mailbox alias to a cabinet, first make sure the cabinet is visible at the top of the
server window. Then, simply find the mailbox(es) that you wish to add to the cabinet and
drag the icon for the mailbox(es) onto the appropriate cabinet icon. Mulberry will add an
alias to the appropriate mailbox to the selected cabinet.
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To remove a mailbox alias from a cabinet, highlight the mailbox alias you wish to remove
and press the delete key on your keyboard or choose Cabinets>Remove Item from the
Mailbox menu. Removing a mailbox alias just removes that item, it does not delete the
mailbox that it refers to.

Note: You cannot change the contents of the ‘New Messages’
cabinet. The contents of this cabinet are managed automatically
by Mulberry.

To create your own cabinet, select New... from the Cabinet popup menu or select
Cabinets>New Cabinet... from the Mailbox menu. Mulberry will prompt you for a
name for the new cabinet. User-defined cabinets are listed after the pre-defined cabinets in
the order that they are created. You can create as many cabinets as you like.

In addition to individual mailbox aliases, cabinets can also contain ‘wildcard’ items. These
items allow you to quickly add the contents of an entire mailbox hierarchy to a cabinet.
For example, you might want all of the folders in your INBOX hierarchy to appear in the
‘Copy Messages To’ cabinet. One way to set this up would be to select all of the folders in
your INBOX hierarchy and drag them to the ‘Copy Messages To’ cabinet. Unfortunately, if
you were to then create a new mailbox in your INBOX hierarchy, you would have to
remember to also add that new folder to the ‘Copy Messages To” cabinet. An elegant
solution for this problem is to place a single wildcard entry for the ‘INBOX.* hierarchy into
the ‘Copy Messages To’ cabinet. “Wildcard’ entries are dynamic — every time they are
needed, the full list of matching mailboxes is determined and substituted for the “wildcard’
entry. Thus any changes to the mailbox hierarchy will always be picked up by the
‘wildcard’ entry.

To add a ‘wildcard’ entry to a cabinet, click once on the appropriate cabinet and select
Cabinets>New Wildcard Item... from the Mailbox menu. You will be presented with a
dialog box like the one in Figure 71.

Cabinet Entry List

Match mailboxes in account All s 1

anywhere in hierarchy T‘

| Cancel | f DK }

Figure 71 Cabinet wildcard item dialog box

The options in this dialog box are very similar to those in the Display Hierarchy dialog,
described on page 133.
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You can modify a wildcard item within a cabinet by clicking once on the wildcard item and
selecting Cabinets>Edit Wildcard Item... from the Mailbox menu, or by double-clicking
on the wildcard item. A dialog box will appear, allowing you to specify a new path for the
wildcard item.

Note that the mailbox aliases within a cabinet function in a manner very similar to the
actual mailboxes they represent. Double-clicking on a mailbox alias will open a separate
mailbox window for the associated mailbox. If you attempt to remove a cabinet item using
the Delete... command from the Mailbox menu, you will be asked whether you want to
delete the mailbox alias or the actual mailbox associated with the alias.

5.4.4.7 Closing the Server Pane/Window

Clicking the close box on the 3-pane window or the server window will automatically log
you out from any IMAP servers. A dialog box will also appear asking if you would like to
quit Mulberry, or just hide the server window. Mulberry will not operate without the 3-
pane window (in 3-pane window mode) or the server window (in separate windows
mode), so the window will only be hidden if you choose to close the window.

Note: Logging out of an IMAP server will close all mailbox and
message windows that belong to that server.

To see the server window again, select the appropriate item from the Window menu (see
page 311), which contains a list of all available windows.

Note: Since the server window is hidden, its name appears in
brackets in the Window menu.

The location and size of server windows are saved in any existing current preferences file
when Mulberry is closed, and then restored from that preferences file if it is used to launch
Mulberry again.

5.4.5 Getting Information on Email Servers and Mailboxes

Mulberry allows you to view detailed information on the various email servers that you
have configured in your Accounts preferences, as well as details about individual
mailboxes. This information will be of most interest to experienced users and system
administrators.

To get information on a server, click once in a server pane on the server name or a mailbox
in the server account you want to examine, and click the Details toolbar button, or select
Details... from the Edit menu.

To get information on a mailbox, click once on the mailbox and click the Details button in
the server pane tool bar or select Details... from the Edit menu. You will be presented
with the Mailbox Details dialog box, which is shown in Figure 72.
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The Details dialog can have up to five different panels displaying different information
about the server or mailbox. The five possible panels are:

*  Options
* Details
* Server
* Access*
* Quota*
Mailbox: INBOX
& opt Options
g Details E Check for New Mail with style: | Default | :]
@ Sarver E Open after Login
: Use for Copying Messages
E Access [ Use for Drafts or Sent Messages
() Quota ] Mark Seen on Close

E synchronise on Disconnect

Identity
W Tie to Identity

Identity: Default B ]

Figure 72 The Mailbox Details dialog showing the ‘Options' panel

* Note: The ‘Access’ and ‘Quota’ panels are only available when
you are communicating with an IMAP email server that
supports the ACL or QUOTA extensions, respectively.
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5.4.5.1 Details: Mailbox Options

Options

E Check for New Mail with style: Default ﬂ
E Open after Login
: Use for Copying Messages

: Use for Drafts or Sent Messages
" | Mark Seen on Close
E synchronise on Disconnect

Identity
E Tie to ldentity

Identity: Default

A
e

Figure 73 The Mailbox Details ‘Options’ panel

This panel allows you to set several different options for a given mailbox. The available
options are:

144

‘Check for New Email with style’:  If turned on, the mailbox will be checked for new
messages at the interval specified by the alert style selected in the popup (see page 50).

‘Open After Login’:  This option tells Mulberry to automatically open this mailbox
after the program is launched and you have successfully logged into the IMAP server
containing the mailbox.

“Use for Copying Messages”: This option lets you add the selected mailbox to the list of
mailboxes used in the ‘Copy To’ menu in the Message window.

‘Use for Drafts’: This option lets you add the selected mailbox to the list of mailboxes
used in the “Copy To’ menu in the Drafts window.

‘Mark Seen on Close”: This option tells Mulberry to automatically mark all messages in
the selected mailbox as seen when you close the mailbox window.

‘Synchronize on Disconnect’: This option tells Mulberry to automatically add the
selected mailbox to the list of mailboxes that will be synchronized when disconnecting.

‘Tie to Identity’: If turned on, the identity chosen in the popup menu will be ‘tied” to the
selected mailbox. When creating new drafts, or replying to messages in the selected
mailbox, Mulberry may automatically select the ‘tied” identity in the new draft window.
For more information on tied identities see page 229.
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5.4.5.2 Details: Mailbox Details

Details %
Name: INBOX P,
server:  imap.cynusoft.com

Hierarchy:

Hierarchy

Separator:
Messages:

Total: O Eecent: 0 Unseen: 0 Deleted:

synchronised State: Full: Partial: Missing:
Size: “  Calculate O

Status: Subscribed

UID Validity: 863984863

synchronised:

Figure 74 The Mailbox Details ‘Details’ panel

The items in this panel are:

‘Name’

‘Server’

‘Hierarchy’

The full pathname of the mailbox.

The Internet address of the server on which this mailbox is located.

The hierarchy that the folder belongs to, if any.

‘Hierarchy Separator’ The character that signifies a new level of hierarchy in the

mailbox name.

‘Messages’

‘Total’

‘Recent’

‘Unseen’

‘Deleted’

The total number of messages in the mailbox.

The number of new messages in the mailbox the last time it was
checked. This is the number of messages that have arrived since the last
time the mailbox was open.

The number of unseen messages in the mailbox the last time it was
checked, or, if the mailbox is open, the current number of unseen
messages in the mailbox window. This last value may be different from
the total number of unseen messages in the mailbox if the mailbox
window is only displaying a subset of all the messages in the mailbox.

The number of messages marked as deleted in the mailbox, if open. If
the mailbox is closed this value will be empty.
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- ‘Full The number of messages in an IMAP mailbox that are completed cached
locally for use in disconnected mode.

— ’Partial’ The number of messages in an IMAP mailbox that are partially cached
locally for use in disconnected mode.

— ‘Missing’ The number of messages in an IMAP mailbox that are not cached locally
for use in disconnected mode.

e ‘Size’ Shows the size of the mailbox in bytes.

e ‘Calculate’ Clicking this button causes the mailbox size to be re-calculated.

e ‘Status’ Shows various status information about the mailbox:
- ‘Open’ Indicates that the mailbox is open and has a window on-screen.
— ‘Subscribed’ Indicates that the mailbox is subscribed to.

— ‘No Hierarchy’ Indicates that the mailbox does not have a sub-hierarchy.
— ‘Cannot Open’ Indicates that the mailbox cannot be opened.
- ‘Interesting’ Indicates that the server has marked the mailbox as ‘interesting’.

e ‘UID Validity’ A number that is unique to this mailbox and provided by the server.
This value is only available for IMAP4 and later version servers.

* ‘Synchronized’” Shows the date and time that the IMAP mailbox was last synchronized
with a disconnected mailbox on this machine.

5.4.5.3 Details: Server

Mulberry allows you to view detailed information on the various email servers that you
have configured in your Accounts preferences. This information will be of most interest to
experienced users and system administrators.

To get information on a server, click once on the server name or a mailbox in the server
account you want to examine, in the server window and click the Details button in the
server window tool bar, or select Details... from the Edit menu. The dialog shown in
Figure 75 will appear. Click on the Servers button to display the server information. The
Server panel in the dialog shows the name of the server, the type of the server recognized
by Mulberry, the ‘Greeting’ text, and the ‘Capability” text.

* The name is just the Internet address of the server.

* The type indicates which email protocol Mulberry is using to communicate with the
server. This will depend on what versions the server supports, and will be one of
‘POP3’, IMAP2bis’, 'IMAP4’ and 'IMAP4revl’.

* The greeting is the first line of text sent back by the server when first contacted by
Mulberry. It sometimes gives details about the manufacturer and version of the server
software.

* The capability text is the information returned by the server when Mulberry requests
information about what commands and extensions the server supports. This usually
indicates the version of the IMAP protocol the server is using (e.g. ‘POP3’, ‘IMAP2bis’,
‘IMAP4rev]’ etc.) and any extensions that the server supports (e.g. ‘ACL’ or ‘QUOTA’).
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This information is useful when trying to track down problems with the server, or
making sure you are connected to the right server.

The connection indicates whether an SSL secure connection is in place or not. If one is,
the View Certificate button can be used to view the SSL certificate that the server

provided.

Server -
Mame: imap.cyrusoft.com i 'J

Type: IMAP4rev]

Greeting: * QK darius.cyrusoft.com Cyrus IMAP4 v2.1.15 server
ready

Capability: IMAP4 IMAP4rev] ACL QUOTA LITERAL+ MAILEBOX- |4
REFERRALS NAMESFACE LIDPLUS ID ¥
NO_ATOMIC_RENAME UNSELECT CHILDREN m
MULTIAPPEMD 50RT THREAD=ORDEREDSUBJECT
THREAD=REFERENCES IDLE AUTH=PLAIN AUTH=LOGIN|
AUTH=DIGEST-MD5 AUTH=CRAM-MD5 -

Connection: Secure - TLS/55L encryption I::_ View Certihicate :j

Figure 75 The server panel in the mailbox details dialog box
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5.4.5.4 Details: Mailbox Access

Access Control List

Mailbox! imap:INBOX 13| Key
— T — E Lookup
User ID i (L SO (4 Read
Current User: Y Y R R Y Y ARV Y
7% Seen
vince W W ¥ Y Y Y YV .
daboo Y YIYYEL Y 4
By Add
Pl
g Post
q_‘,:u Create
&5 Delete
,_k_-lh_-r Admin

f_ Add User... “ ’f Remowve User “ 5'[!-'|Ef

Figure 76 The Mailbox Details ‘Access’ panel

The “Access’ panel displays information about the access control list for the mailbox or
mailboxes being examined in this dialog. The access control list for the mailbox chosen in
the “Mailbox’ popup is displayed in the dialog. To see the access list for other mailboxes
being examined, choose them via the popup menu.

The access control list is the list of users who have ‘rights’ to the mailbox. For mailboxes,
there are a total of nine ‘rights’ that can be applied to each user. These are:

‘Lookup’ - if set, the user is able to see the mailbox if they attempt to list it.

‘Read’ - if set, the user is able to read messages in the mailbox.

‘Seen’ - if set, each user can mark a message as seen without affecting other users.
‘Write’ - if set, the user can change any message flag except the delete flag.

‘Add’ - if set, the user can add messages to the mailbox by copying them in.

TSN @ pOe

‘Post’ - if set, the user is able to send email directly to the mailbox. This capability is
only available if supported on the server.

e L7 ‘Create’ - if set, the user can create sub-hierarchies of mailboxes below the
mailbox.
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o o ‘Delete - if set, the user can delete and expunge messages from the mailbox.

e &) ‘Admin’ -if set, the user is able to change the access control list for the mailbox.

The rights that you have to the mailbox are shown in the “Current User:” row at the top of
the access control list table. All users’ rights are then shown in the table below this. Each
row consists of a user id, followed by nine icons or buttons representing the state of the
right for that user:

« 9 Abutton indicating that this right is turned off for the user, but it can be changed
by clicking it.

- ¥ Abutton indicating that this right is turned on for the user, but it can be changed
by clicking it.

« * Anindication that this right is turned off for the user, but it cannot be changed
because you do not have the rights to do so.

« ' Anindication that this right is turned on for the user, but it cannot be changed
because you do not have the rights to do so.

When you have the right to change ‘rights’ for the mailbox, you can do so by clicking one
of the ‘diamond’ buttons in the list. To change the ‘rights” for more than one user at a time,
select all their user ids and click a diamond button with the option key held down.

To delete one or more users from the access control list, select their user ids in the list and
click the “Delete’ button. To create add rights for a new user, click the ‘New User...” button.
This will display the dialog shown in Figure 77. This allows you to enter any number of
user ids, one on each line, and choose a set of ‘rights’, by clicking the buttons below the list,
to apply to all the users that you enter.

New User ACL
Usar ID=:

Vince
Justin

set: |6 |Q|F|/|ID &S| |8 &
Styla: E]
(" Cancel ) {_ 0K _}

Figure 77 The dialog used to add new users to an access control list
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You can create a set of ‘rights” as a style to quickly apply frequently used ‘rights’. To create
a new style:

* Select a user id with the set of ‘rights’ to use.
* Click the ‘Style’ pop-up menu and choose ‘New Style...".
* Enter your chosen name for the new style in the resulting dialog.

The new style will be added to the end of the “Style” pop-up menu list. To apply a style,
select one or more user ids in the access control list and then select the required style from
the ‘Style” pop-up menu.

When there is more than one mailbox being examined, you can apply the rights for the
current mailbox selected in the ‘Mailbox” popup to all the others by clicking on the ‘Apply
to All Selected Mailboxes’. This provides a convenient and quick way to copy rights from
one mailbox to others.

5.4.5.5 Details: Mailbox Quota

Quota
Mama Currant Maximum |96 Usad
v USer vince
STORAGE 53 10240 0%

Figure 78 The Mailbox Details ‘Quota’ panel

The ‘Quota’ panel displays information about the available quota for the mailbox. This is a
hierarchical list of ‘quota roots” and quota values. In the example in Figure 78, “user.vince’ is
a ‘quota root’, and ‘STORAGE’ a quota value. For each quota value, the current and
maximum values are shown together with the percentage used. The units of the values are
determined by the type of quantity being described. Thus for ‘'STORAGE’ the units will
probably be Mb of disk use, for ' MESSAGES’ the units will be number of messages.
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5.4.6 Disconnected Mode Operations

Messages in remote IMAP mailboxes can be cached locally for use when the computer
running Mulberry is not connected to a network. These messages can be read and
otherwise manipulated in the normal manner, and any changes made to messages while in
disconnected mode will be reflected in their online counterparts the next time a network
connection is made. This is known as disconnected mode operation.

In order to use an IMAP mailbox in disconnected mode, you must first synchronize that
mailbox with a local cache. There is some preparation necessary before IMAP mailboxes
can be synchronized for disconnected use:

* The IMAP account that contains the mailboxes to be used in disconnected mode must
have the ‘Allow Disconnected Operations’ preference option enabled (see page 38).

* The IMAP mailboxes to be synchronized must be identified. For mailboxes that will be
synchronized on a regular basis, the easiest way to do this is to add the desired
mailboxes to the “Auto Synchronize’ cabinet (see page 138). A mailbox can also be
chosen for synchronization using the Options tab of the Mailbox Details dialog (see
page 144).

5.4.6.1 Disconnecting

To switch Mulberry into disconnected mode, select the Disconnect... item from the File
menu. The Disconnect Options dialog, shown in Figure 79, will appear.
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Disconnect Dialog

When Disconnecting:

f* Synchronise All Messages
_ Synchronise New Messages
_ No Message Synchronisation

v Synchronise Mailbox Lists
__ Send Queued Messages First
@ Synchronise Remote Address Books

Message Synchronisation:

) Entire Message
f*) Entire Message below: 10| KB
_ First Displayable Part Only

¥ Hide Mailbox Information |_Cancel ) { oK j

Add Cabinet: [4] (Add... ) ( Clear )

imap:INBOX
iIMap:user. support

Total:2 Done:0 Messages:0
Figure 79 The Disconnect Options dialog

The Disconnect Options dialog provides the following options:

Synchronize All  Selecting this option causes all messages in each mailbox to be

Messages synchronized. Any messages already synchronized will have their flag
state updated and messages removed from the IMAP server will be
removed from the disconnected cache. New messages on the IMAP
server not already in the disconnected cache will be downloaded.

Synchronize New  Selecting this option causes only new messages in each mailbox to be

Messages synchronized. Only messages on the IMAP server that are not already
in the disconnected cache will be downloaded. Other messages in the
disconnected cache will not be touched.

No Message When this option is selected, no message synchronization takes place.
Synchronization
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Synchronize This option causes a list of all defined mailboxes to be cached for use in

Mailbox Lists disconnected mode. When a mailbox list is cached for disconnected
use, all display hierarchies will be navigable as they are while in
connected mode.

Send Queued This option causes pending messages in the outgoing queue to be sent
Messages First before going into disconnected mode.

Synchronize This option causes remote IMSP or ACAP address books to be cached
Remote Address for disconnected use. Address books to be synchronized must be
Books specified in the ‘General’ panel of the Address Book Details dialog (see

page 240) and their address account must be marked for disconnected
operations (see page 46).

Entire Message When this option is selected, the entire contents of each message
(header and all parts) will be downloaded and available in disconnected
mode.

Entire Message When this option is selected, only those parts of a message with a total

Below nn byte count below the specified number will downloaded. This means

that some messages in the disconnected cache may only be ‘partial’.
Such messages can be ‘fully’ downloaded at a later date to bring all
parts into the disconnected cache as required.

First Displayable ~ When this option is selected, only the first text part that would be
Part Only shown in the message window is downloaded. As with the previous
option, this results in a partial message in the disconnected cache.

The bottom portion of the dialog displays the mailboxes to be synchronized. By default,
the contents of the ‘Auto Synchronize’ cabinet are listed (see page 138). The contents of
other cabinets can be quickly added using the Add Cabinet popup menu. To add one or
more individual mailboxes, click the Add... button. To remove mailboxes, select them and
hit the delete key. To clear the entire list of mailboxes, click the Clear button.

When all disconnected options are set as desired, click the OK button to begin the
synchronization process. The bottom line of the dialog gives status information on the
progress of synchronization, including the total number of mailboxes to be synchronized,
the number completed, and the total number of messages synchronized.

After synchronization has completed, Mulberry will terminate all active connections to
IMAP, IMSP, and ACAP servers. Once this is complete, the Disconnected Options dialog
will disappear and Mulberry will be in disconnected mode. In this state, it is safe to remove
any network connection.

5.4.6.2 Connecting

To return to connected mode, select Connect... from the File menu. A dialog, shown in
Figure 80, similar to the Disconnect Options dialog will appear.
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Connect Dialog

When Connecting:

'Ei" Stay Connected
_ Update then Disconnect

v Synchronise Offline Changes

@ Send Queued Messages
v Synchronise Remote Address Books

10

( Cancel | { Ok }

Figure 80 The Connect Options dialog

Many of the options in this dialog are similar to those in the Disconnect Options dialog.
However, several new options appear, including:

Stay Connected Selecting this option causes Mulberry to stay in connected mode after
performing any specified synchronization.

Update then When this option is selected, Mulberry will perform any specified

Disconnect synchronization options and then return to disconnected mode.

Synchronize When this option is selected, any changes made to messages in

Offline Changes

disconnected mailboxes will be synchronized with the equivalent
messages in online IMAP mailboxes.

Update POP3 When this option is selected, Mulberry will check any POP3 accounts

Accounts listed in the server window for new messages while in connected
mode. This option is only available when the “Update then Disconnect’
option is selected.

Send Queued This option causes pending messages in the outgoing queue to be sent.

Messages When using the ‘Update then Disconnect” option, Mulberry will wait
until all messages in the outgoing queue have been sent before
automatically disconnecting.
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Synchronize When this option is selected, any changes made to addresses in
Remote Address disconnected address books will be synchronized with the equivalent
Books address in online address books.

When using the “‘Update then Disconnect’ mode, the mailbox list used in the Disconnect
dialog will be available to allow you to specify which mailboxes should be synchronized
before the disconnect.

5.4.6.3 Manual Synchronization

When Mulberry is in connected mode, individual mailboxes can be synchronized without
switching into disconnected mode. To do this, either select a mailbox in the server window
or open a mailbox and view its captions in a mailbox window, and then select
Synchronize... from the Mailbox menu. The Synchronize dialog, shown in Figure 81, will

appear.

Synchronise

Mailbox:

_ All Messages
_ New Messages
f*) Selected Messages

Messages:

) Entire Message
(® Entire Message below: 10 KB
_ First Displayable Part Only

( Cancel ) { OK \/'r

Figure 81 The Synchronize dialog

All of the options in this dialog are similar to the options found in the Disconnect Options
dialog, except for the ‘Selected Messages’ option. This option allows you to synchronize
only a selected list of messages in a particular mailbox. For this option to be available, you
must first double-click on a mailbox to open it, select one or more messages, and then
select the Synchronize... menu option.
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5.4.7 Reference

156

OPERATIONS ON ITEMS IN THE SERVER WINDOW

To open one or more selected
mailboxes

Press return or enter on the
keyboard.

Click/ double-click any one of
the selected mailboxes.

To open a mailbox that does
not appear in the server list

Choose Open Mailbox... from
the File menu.

To see information about the
selected mailbox

Choose Details... from the Edit
menu or press Command-I|
(Mac OS X), Ctrl-1 (Windows)
or Meta-I (Unix).

To create a new mailbox on
the server

Choose Create... from the

MailboXx menu or click the
create button in the toolbar.

To rename one or more
selected mailboxes

Choose Rename... from the
Mailbox menu.

To delete one or more selected

mailboxes

Choose Delete... from the
Mailbox menu.

To subscribe to one or more
selected unsubscribed
mailboxes

Choose Subscribe from the
Mailbox menu or press
Command-= (Mac OS X),

Alt-= (Windows) or Meta-=
(Unix).

To unsubscribe from one or
more selected subscribed
mailboxes

Choose Unsubscribe from the
Mailbox menu or press
Command-- (Mac OS X),

Alt-- (Windows) or Meta--
(Unix).

To check for new messages in
one or more selected
mailboxes

Choose Check Email from the
Mailbox menu or press
Command-L (Mac OS X),

Ctrl-L (Windows) or Meta-L
(Unix).
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To check the set of mailboxes
marked for automatic
checking

Choose Check Favorites from
the Mailbox menu or press
Shift-Command- L (Mac OS
X), Shift-Ctrl-L (Windows) or
Shift-Meta-L (Unix).
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5.5 Mailbox Pane/Window

g imap:INBOX. work x
From -

ﬁ";l ™ From / Ta Thread =
1 IE] B friend@domain.uk Mulberry is Great!
2 E] b Ha Custamar Re: Mulberry is Great!
] @ B Vince Everrett How are you?
4 E] B Vince Everrett Here's the new Mulberry!!l
5 IE] E B friend®cyrusoft.com Mulberry is Great!

Total: 5 Uns=en: Deleted: O Found: O

Figure 82 A mailbox window showing all available messages in the mailbox

Figure 82 shows a typical mailbox pane. Mailbox panes show a list of messages in the
corresponding mailbox (when displayed in its own window, the window title is the name
of the mailbox). The pane is divided into three main sections:

* The Column Headers section indicates which information from a message is displayed
in the corresponding column and which category is used to sort the messages.

* The Message List section shows all the requested categories of information about each
message sorted according to your preference.

* The Mailbox Information section at the bottom of the window lists important
information about the content of the mailbox.

If a mailbox has read-only permission you will not be able to delete or expunge any
messages, or copy any messages into the mailbox. You may be able to set some of the
flags (see page 166) for messages in the mailbox, but this depends on your permission to
do so as determined by the server. If you do not have enough permission to change a flag,
an error message from the server will be displayed when you try to do so.

A choice of options set in the “Mailbox’ preferences (see page 61) allows mailbox panes to
be opened either at the start or end of the message list or with the oldest new message in
the list selected and displayed.

5.5.1 Mailbox Window Toolbar Buttons

The mailbox window has a toolbar associated with it, whereas the mailbox pane in the 3-
pane window uses the toolbar in the 3-pane window.
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The mailbox window toolbar contains the following items:

7

Create a new draft window to allow you to compose a new message.

Draft
& Creates a reply to messages selected in the mailbox pane, or the
K message in the preview pane, depending on which is focussed.
Reply
% Forwards the messages selected in the mailbox pane, or the message
L in the preview pane depending on which is focussed.
Foreard
- Copies or moves the messages selected in the mailbox pane, or the
= | message in the preview pane depending on which is focussed.
Move to
(s Deletes the messages selected in the mailbox pane, or the message in
| the preview pane depending on which is focussed.
Delete

e This button has three states depending on what is selected.

e If no messages are currently selected in the mailbox window
then the button is not active.

e If one or more selected messages are not deleted then the
button is off and clicking on it will delete the undeleted
messages in the selection.

e If all the selected messages are deleted, then the button title
changes to Undelete and it is in the on state. Clicking the
button now will undelete the selected messages.

Note If you delete a single message, Mulberry will
automatically select the next message after the one deleted (if
one exists).

oy

Expunges (permanently removes) deleted messages in the mailbox
shown in the mailbox pane.

Expunga
@ Turns on or off the mailbox view Match behavior.
Match
Selects messages with the flag criteria (chosen from the popup menu)
in the mailbox pane.
halect

Mulberry Reference Guide v4 159



Checks the selected mailboxes in the server pane for new email, or
y checks for new email in the mailbox shown in the mailbox pane
Check depending on which is focussed.

Searches for messages in the selected mailboxes in the server pane, or

— the mailbox shown in the mailbox pane depending on which is

Sparch focussed.

= Displays information about the mailboxes selected in the server pane,
Y, or the mailbox shown in the mailbox pane depending on which is
Details focussed.

The upper right corner of the toolbar displays an icon that indicates the
connected / disconnected status of the mailbox. Possible icons are:

L-—‘] An online (IMAP) mailbox

L;-J A POP3 or Local mailbox

E\lj An online (IMAP) mailbox that has been synchronized and is being used in
. disconnected mode.

5.5.2 Quick Search

The quick search area provides a way to quickly search for messages matching a single
criterion. The criterion can be chosen via the popup, shown in Figure 83.

* From
To
Recipient
Caorrespondent
subject
Body

Saved Search

Figure 83 The quick search popup.

A search occurs when text is typed in the edit field and the return key or tab key is hit, or
there is a pause in typing for more than about 1 second. When the search occurs, the
content of the mailbox is restricted to showing only those messages that match the search
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criterion. To edit the quick search mode, click the &ibutton on the far right off the edit
field, or delete all text in the edit field, or turn off the Match toolbar button.

5.5.3 Column Headers

The column headers indicate what message information is displayed in each column in the
message list below it.

Mac OS X To change a category, or to insert a new category, or to delete an existing
category click the mouse button with the control key down (ctrl-click) on the
category title.

WINDOWS To change a category, or to insert a new category, or to delete an existing
UNIX category click the right mouse button on the category title.

A menu will appear giving you the choice of what category to show in the corresponding
column, as shown in Figure 84. You can also insert a new column before or after the one
clicked, or delete the column that was clicked.
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To
From
Reply To
Sender
Cc
Subject
Thread
Date Sent
Date Received
Size
Flags
Number

v Smart Address
Artachments
Parts
Matching
Disconnected

Insert Column after
Insert Column before
Delete Column

Figure 84 A mailbox window with the column title changer menu displayed.

5.5.3.1 Resizing Column Headers

Columns in the mailbox window can be resized by clicking and dragging the cursor whilst

it is over a column boundary (the cursor will change shape to < when it is close to a
column boundary).

5.5.3.2 Smart Address

One special category is the ‘Smart Address’ category. When this category is selected, the
column title is ‘From: / To:" (see the third column in Figure 82). When this category is
chosen, Mulberry discriminates between messages that were sent by you to someone else,
messages sent directly to you by someone else, and sent indirectly to you (possibly via a
mailing list). This is useful if you have a mixture of messages received and messages sent in
the same mailbox. In this case Mulberry will display in the message list either the ‘From:’
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address, if the message was sent by someone other than you, or the “To:” address, if the
message was sent by you.

To indicate which is which, it displays different icons in front of the addresses in that
column:

e 4 for messages sent directly to you (where you are the primary recipient) by
someone else (your address does not appear in the ‘From’ address field of the message,
but does appear at least once in the “To” address field)

* < for messages sent directly to you (where you are a secondary recipient) by
someone else (your address does not appear in the ‘From’ address field of the message,
but does appear at least once in the ‘CC" address field, but not in the “To” address field)

* + for messages sent indirectly to you by someone else (your address does not

appear in the ‘From’ address field of the message, and it does not appear in the “To’ or
‘CC’ address field)

* B for messages sent by you (your address appears at least once in the ‘From’
address field)

Note By default Mulberry always uses the email address that it
has set for you to discriminate between messages sent or received
by you. But you can specify additional address to count as yours
by adding them to the ‘Outgoing Addresses to Count as Mine’ list
in the ‘Identity” preferences (see page 4.9).

5.5.3.3 Sorting Messages

You can sort the message list in a mailbox window by any message category. If a category
appears in a column title, you can click that column title to sort by that category. If the
category in a column is the one being used to sort the messages the title display will change
(for example in Figure 82 the messages are being sorted by ‘Number’ (the “#” column).

If you want to sort the mailbox by a category that is not displayed then choose the

category from the Sort sub-menu in the Mailbox menu (see page 301). The order of
sorting (ascending or descending) can be changed by clicking the sort direction button on
the far right of the category titles. The button appears differently for each sorting method:

* |z forascending sorts
* [§ for descending sorts

You can also click on the column title for the category being sorted on to toggle the order
of sort between ascending and descending.

When sorting a mailbox, keep in mind that only messages that currently have information
cached will be included in the sort (for a detailed description of caching, see page 167), if
Mulberry has to do the sort itself. If you attempt to sort the messages in a mailbox by
clicking on a column header, and all of the messages in that mailbox have not yet been
cached or the server dos not support server-side sorting, you will be presented with the
following dialog:
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Some information needed to sort all the
messages is unavailable. Do you want to
download the missing message information and
then do a full sort, or just sort the currently
available messages?

( cancel ) ( Current ) ( Full Sort \}

Figure 85 The Search Warning dialog box

To sort only the messages for which Mulberry currently has information cached, click the
Current button. To download information on all messages that have not been cached and
then perform the sort, click the Full Sort button. Note that this action may not be desirable
if the mailbox has a large number of messages or you're limited by available memory or a
slow connection (e.g. a modem). To cancel the sort action, click the Cancel button.

5.5.3.4 Displaying Message Threads

A special sorting category is “Thread’. When this is selected for a column, Mulberry displays
in the column the subject of the message. When sorting by Thread, Mulberry looks at the
information in each message's In-Reply-To and References header, and links together
messages that are in the same thread. The message subjects display in the mailbox
window, are then indented by an amount that reflects the position of the message within
the thread.

5.5.4 Message List

The message list shows one message per row with the data in each column corresponding
to the category of message information selected for that column. Messages in this list can
be manipulated in a number of different ways.

5.5.4.1 Selecting Messages

All operations on messages only occur for those messages that are selected at the time.
There are a number of different ways to select a message:

* A message can be selected by clicking anywhere in its row.

* More than one message can be selected either by shift-clicking to extend a selection, or
command-clicking (Mac OS X) or control-clicking (Windows & Unix) to make a
noncontiguous selection.
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5.5.4.2 Manipulating Messages

You can manipulate selected messages in a number of different ways:

* Pressing return or enter on the keyboard will also open any selected messages. If the
message is marked as a draft it will be opened into a draft window (see page 224),
otherwise it will open into a message window (see page 183).

* Pressing delete on the keyboard will toggle the delete flag of any selected messages.

* Messages may be copied by dragging them out of the mailbox window into another
mailbox window or onto a mailbox shown in the server window. An option in the
‘Message’ preferences panel (see page 69) allows copied messages to be automatically
marked as deleted after a successful copy. This option can be toggled by holding down
the option key during the drag.

Mac OS X * Messages may also be saved by dragging them to the Desktop or a

ONLY Finder window. They can also be dragged to a window of any open
application that can receive drag and dropped text (SimpleText for
example). In this case the first text part of the selected message is sent to
the receiving application.

e Some commands can act on all messages in a selection together, or on each individual
message. For example, Figure 86 shows the dialog that appears when saving more than
one selected message. You are given the choice of saving all messages in the selection to
a single file (click the Single button), or saving each message to their own separate file
(click the Multiple button). A similar dialog appears when replying or forwarding with
more than one message in the selection.

Do you want to save the selected messages in
a single file or as multiple files, one for each
message’

( Cancel ) | Single ) f Multiple }

Figure 86 The dialog giving the choice of whether to operate on all messages
in a selection together or individually
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5.5.4.3 Message Flags

The IMAP server assigns various flags to each message that is stored in a mailbox, to help
you keep track of the state of each message. If you have the ‘Flags’ category column on
display in the table, Mulberry will display different icons to represent these states. These
icons are:

* [E for messages that have arrived since the mailbox was last checked (recent)

for messages that have never been opened (unseen)

for messages that have been opened at least once (seen)

for messages that have been replied to (answered)

for messages that are drafts (draft)

DL O

for messages that have been marked as deleted (deleted)

For messages in more than one state (e.g. answered and deleted) the icon order in the list
above will take precedence (i.e. for messages answered and deleted, the deleted icon will
be shown).

5.5.4.4 Attachments in messages

You can see if any messages in the mailbox have attachments by viewing either the
‘Attachments’ column category or the ‘Parts” column category. The ‘Attachments’ column
will display an icon if the message contains more than one part. The ‘Parts’ column will
display the total number of parts in the message. The icons used in the ‘Attachments’
column are:

e (none) for messages that contain only plain text

for messages that contain styled text (HTML)

. for messages that contain only plain text and attachments

for messages that contain a calendar attachment

for messages that contain styled text (HTML) and attachments

for messages that contain styled text (HTML) and a calendar attachment
for messages that contain only plain text and are cryptographically signed

for messages that contain styled text (HTML) and are cryptographically signed

FFEN TS ED S

for messages that contain only plain text and attachments and are
cryptographlcally signed

[ ]
f.;;

< for messages that contain only plain text and a calendar attachment and are
cryptographically signed

. ..%! for messages that contain styled text (HTML) and attachments and are
cryptographically signed
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o U7 for messages that contain styled text (HTML) and a calendar attachment and are
cryptographically signed

ISl

. for messages that are cryptographically encrypted

5.5.4.5 Color and Text Style of Displayed Messages

The color and text style of messages displayed in the window is also determined by the
state of the message. The color and text style can be set in the ‘Display’ preferences (see
page 50).

5.5.4.6 Limiting the Number of Displayed Messages (Caching)

You can limit the maximum number of messages on display in every mailbox window by
changing the ‘Message Display Cache’ settings in the ‘Mailbox” preference panel (see page
61). This may be required if you have large mailboxes that would either use up too much
of the available memory when all messages are visible, or take a long time to download
over a slow connection (e.g. when using a modem).

The individual caching options are described on page 63. As you become more familiar
with these settings, you will be able to customize them to suit your available RAM and
connection speed. The following chart will give you starting point for different situations:

Connection Speed
Slow Fast
Available Memory Low Initial Download: 20, Initial Download: 100,
Limit To 100, Auto Limit To: 100, Auto
Increment Increment
High Initial Download: 20, | Initial Download: 100,
Unlimited Total, Auto Unlimited Total,
Increment Increment by: 100

5.5.5 Searching

Mulberry provides robust message searching capabilities. Using the search window, you
can find email messages meeting multiple criteria. You can search for messages in one or
several different mailboxes. You can even save searches and reuse them later. The Message
Search window, shown below, is the interface to this powerful functionality:

Mulberry Reference Guide v4 167



® 60 Message Search

Saved Search: E]

Find Messages whose
3 ' From Address |4 | Contains 4] imulberry|
EI" or | :]: Size I :] " Is Greater Than I :] 1024 | KB ==
[*+17and [5) DateSent |5 | Before By 11/ s / 2005
f: More ChﬂiEES:,'I I: Fewer Chﬂi[ES:,'l (: Reset :,l (—Sen-rch-a
¥ Hide Mailbox Information
Add Cabinet:(8) (" Add... ) ( Clear ) ( Options... )
POP3INBEOX
Total: 1 Found: 0 Messages: 0 S

Figure 87 The Message Search window

The top section of the window allows you to set one or more email message attributes to
search. By default, the Search window is configured to search on one attribute. To add
more attributes, click the More Choices button. To decrease the number of attributed to
search on, click the Fewer Choices button. To re-order the attributes in the list, click on
the up or down arrow at the left edge of the attribute to move that one up or down in the
list. The message attributes that can be searched are:

168 Mulberry Reference Guide v4



From Address
To Address
CC Address
BCC Address
Recipient
Correspondent
sender

Date Sent
Date Received
subject

Body

Header Field
Entire Message
Size

Recent Flag
seen Flag
Answered Flag
Important Flag
Deleted Flag
Draft Flag

Labell
Label2
Label3
Labeld
Label5
Labelt
Labels
Label8

Grouped
Saved Search

All

Figure 88 The Search Attributes popup menu

From Address

The ‘From’ address of the message.

To Address

The “To” address of the message.
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CC Address The ‘Cc” address of the message.

BCC Address The ‘Bec” address of the message.

Recipient The ‘“To’, “‘Cc’ or ‘Bec” addresses of the message.
Correspondent The ‘From’, ‘“To’, “Cc’ or ‘Bec” addresses of the message.
Sender The ‘Sender’ of the message.

Date Sent The date the message was sent.

Date Received

The date the message was received.

Subject The subject text of the message.
Body The body text of the message.
Header Field The header text of the message.

Entire Message

The entire message, including all headers and the message body.

Size

The size of the message.

Recent Flag

The recent flag of the message.

Seen Flag

The seen flag of the message.

Answered Flag

The answered flag of the message.

Important Flag The important flag of the message.

Deleted Flag The deleted flag of the message.

Draft Flag The draft flag of the message.

Labels The named label set on a message.

Grouped This options creates a ‘group’ that allows multiple criteria to be
grouped together so that their result is considered as a whole.

Search Set This option allows you to select a previously saved set of search criteria

in order to combine it with one or more other criteria.

All Messages

This option causes all messages to be returned. This is primarily useful
when used by rules (see Section 5.7.1.2 for more on Rules).

Once you have selected a message attribute to search, you must set certain criteria to
search on. The available criteria vary with the different attributes. When you select a text
field, such as the “To’, “From’, “‘Cc’, or ‘Bcc” addresses, or the message Subject or Body, you
can choose from the following criteria:
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* Contains
Does not Contain
s Me
Is not Me

Figure 89 Text Search Criteria

Contains The selected field contains the following text.

Does not Contain  The selected field does not contain the following text.

Is Me The selected address field contains my email address. This option will
only be available if an address field is selected.

Is not Me The selected address field does not contain my email address. This
option will only be available if an address field is selected.

When searching a date field, the following criteria are available:

= Before
ion
After
is
is not
is Within
is not Within

Figure 90 Date Search Criteria

Before The selected date field is before the following date.
On The selected date field is equal to the following date.
After The selected date field is after the following date.
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Is Allows a choice of relative dates selected via a second popup:
* Is Today - The date is equal to today’s date

* Since Yesterday - The date is equal to either today’s or yesterday’s
date.

* This Week - The date falls within the current week.

* Within 7 Days - The date falls within the past 7 days.
* This Month - The date falls within the current month.
* This Year - The date falls within the current year.

Is Not Allows a choice of relative dates selected via a popup:
* Is Today - The date is not today’s date
* Since Yesterday - The date is neither today’s nor yesterday’s date.
* This Week - The date falls outside the current week.
* Within 7 Days - The date falls outside the past 7 days.
* This Month - The date falls outside the current month.
* This Year - The date falls within the current year.

Is Within Allows a choice of dates within a specified timeframe (number of days,
weeks, months or years)

Is Not Within Allows a choice of dates outside of a specified timeframe (number of
days, weeks, months or years)

If at any time you need to clear the criteria you've set, click the Reset button. When you
have selected the message attributes you wish to search and the appropriate criteria, click
the Search button to begin the search. Mulberry will search the selected mailboxes for
messages that match your search criteria. If any messages are found, the current mailbox
window is brought to the front and you are presented with a list of only messages
matching your search parameters.
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®an Message Search

Saved Search: -

1
1

edu

{ Cancel )

¥ Hide Mailbox Information
Add Cabinet: 2

+7 | PFOP3:INBOX
| imapINBOX
* | imapINBOX. read-mail
g | imapINBOX. sent-mail

Total: 4 Found: 1 Messages: § eeeeeeeeeeeeeeee

Figure 91 The Message Search window with mailbox information displayed

As the search progresses, the Search window presents information on the total number of
folders being searched (‘Total’), the number of mailboxes that contain messages found
during the search (‘Found’), and the total number of messages in all mailboxes that match
the current search (‘Messages’). While the search is in progress, a progress bar will be
visible to indicate the time remaining.

If you would like to save a set of search parameters for later use, you can use the Search
Set popup menu in the upper right corner of the Search window. Choose the Save As...
option to specify a name for the current set of search parameters. The information will be
saved, and a search set with the appropriate name will be added to the Search Set menu.
To recall the search parameters you've saved, simply choose the appropriate set name
from the Search Set menu.

By default, Mulberry searches the current mailbox for messages that match your search
criteria. You can also specify multiple mailboxes to be searched. To get a list of mailboxes to
be searched, click the disclosure button next to the ‘Show Mailbox Information’ text. A list
of the mailboxes to be search will be revealed. You can add mailboxes to the list by clicking
the Add... button and selecting a mailbox. To clear the list of mailboxes to be searched,
click the Clear button. You can also quickly all of the mailboxes within a cabinet to the
search list by using the Add Cabinet popup menu. The Options... button provides you
with a dialog from which you can set various options:
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Search Options

M Simultaneous Searching

Maximum Number: |

| Load Balance Multiple Accounts

@ Open First Matching Mailbox

[ Cancel | {_ OK _}

Figure 92 The Search Options dialog

You should check with your server administrator if you're unsure about any of these
settings.

Simultaneous Selecting this option causes Mulberry to search all of the mailboxes

Searching you’ve specified simultaneously instead of one at a time. Mulberry will
open an separate IMAP connection for each mailbox to be searched if
this option is selected.

Maximum Number This field allows you to specify a maximum number of IMAP
connections that Mulberry can make at once for performing searches.
This option is only available if ‘Simultaneous Searching’ is turned on.

Load Balance This option tells Mulberry to split the number of IMAP connections
Multiple Accounts used for searching across multiple IMAP servers, when appropriate.

Open First To automatically open the first mailbox with messages matching the
Matching Mailbox current search, select this option. The mailbox window will be opened
after the search is completed.

5.5.6 Matching

Mulberry’s matching feature provides a quick and easy way to select or display only
messages of interest within a mailbox window. This is controlled via the Match toolbar
button. Clicking this button displays the dialog shown in Figure 93 which allows match
options to be configured. When in match mode, the toolbar button appears ‘depressed’.
Clicking the toolbar button in that state, exits the match mode. The behavior for the Match
button is:

To enter Match mode and choose the match  Click the Match toolbar button
criteria from the dialog
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To enter Match mode using the last match ~ Click the Match toolbar button with option
criteria without displaying the dialog (Mac OS X), alt (Windows) or control (Unix)
key down.

To exit Match mode without displaying the = Click the Match toolbar button
dialog

To change match criteria using the dialog Click the Match toolbar button with option
whilst in Match mode (Mac OS X), alt (Windows) or control (Unix)
key down.

The Match dialog, shown in Figure 93, is used to setup match criteria and the mode for the
match display. A match pattern is constructed from one or more message characteristics
and a boolean operator. For example, you might wish to display only a list of new
messages from the last 7 days. To do this, you would select all Criteria met as your
boolean operator, select the New and Sent within 7 Days options, and click the Match
button. The list of messages in your mailbox window is then filtered to display only those
messages meeting the criteria you specified. To resume viewing all of the available
messages in the mailbox, click the Match toolbar button again.
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Match Options

View: Match using:
) All Messages without Match Hilights ) Selected Criteria
) All Messages with Match Hilights ") Last Search Results

) Matched Messages Only

Match if: Flag Criteria: Date Criteria:
f® any Criteria met " New " | Sent Today
_ all Criteria met !l Unseen __ ! Sent since Yesterday
./ no Criteria met _ Important _! Sent this Week
. not all Criteria met | Answered | Sent within 7 Days
" I Deleted
[ | Draft
ek Sent: Selected:
_| From me | by Me __| To Addresses
__ Within 1 week " to Me " From Addresses
" lto List " | Correspondents
__ Subjects
" | Dates
.___' Clear '___. .___' Cancel '___. f Match }

Figure 93 The Match Dialog

The following chart describes the View options in the Match dialog:

All Message Turns off the Match mode and displays all messages in the mailbox.
without Match

Highlights

All Message with  Turns off the Match mode and displays all messages in the mailbox.
Match Highlights Messages with the match criteria are highlighted with the background
color set I the Display preferences (see section 4.3.3).
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Matched Messages Turns on the Match mode so that only the messages with the match
Only criteria are shown.

The following chart describes the Match using options in the Match dialog:

Selected Criteria = Match using the criteria selected in the dialog.

Last Search This option tells Mulberry to use the results of the last search on this
Results mailbox as its matching criteria. For more information on searching,
see page 167.

The following chart describes the Match if options in the Match dialog:

any Criteriamet =~ Matches messages which meet one or more of the currently selected
criteria.

all Criteria met Only matches messages which meet all of the currently selected
criteria.

no Criteria met Matches messages which meet none of the currently selected criteria.

not all Criteria Only matches messages which do not meet all of the currently selected

met criteria.

The following chart describes each available matching criteria in depth:

New Matches any message that is new.

Unseen Matches any message that is unseen.

Important Matches any message that is important.

Answered Matches any message that has been answered.

Deleted Matches any message that is marked for deletion.

Draft Matches any message that is a draft.

Sent Today Matches any message that was sent today.

Sent since Matches any message that was sent either today or yesterday.
Yesterday

Sent This Week Matches any message that was sent this week.

Sent within 7 Days Matches any message that was sent within the last 7 days.

Sent by Me Matches any message that was sent by you.
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Sent to Me Matches any message that was sent to you.

Sent to List Matches any message that was sent to a list of people.

Selected To Matches any message with the same ‘To:” address as the currently
Addresses selected message(s) in the mailbox window.

Selected From

Matches any message with the same ‘From:” address as the currently

Addresses selected message(s) in the mailbox window.

Selected Matches any message with the same ‘“To:” or ‘From:” addresses

Correspondents (excluding your own) as the currently selected message(s) in the
mailbox window.

Selected Subjects Matches any message with the same subject as the currently selected
message(s) in the mailbox window.

Selected Dates Matches any message that was sent on the same date as the currently

selected message(s) in the mailbox window.

Search Sets

Selects a saved search set (see section 5.5.5) as a criterion for matching.

The ‘Selected ...” options above act on all of the currently selected messages within the
mailbox pane. You can select one or more messages manually from the mailbox pane that
have the characteristics you're looking for. Alternatively, the ‘Select’ toolbar button allows
you to quickly highlight groups of interesting messages within the mailbox window:
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Seen
Unseen
Important
Unimportant
Answered
Unanswered
Deleted
Undeleted
Draft

Mot Draft

Matching
Non-matching

Labell
Label2
Label3
Label4
Label5
Label6
Label7
Label8

Figure 94 The ‘Select’ toolbar button menu

The following table describes each of the available selection options in depth:

Seen Selects messages that have been seen.

Unseen Selects messages that have not been seen.
Important Selects messages that are important.
Unimportant Selects messages that are not important.
Answered Selects messages that have been answered.
Unanswered Selects messages that have not been answered.
Deleted Selects messages that are marked for deletion.
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Undeleted Selects messages that are not marked for deletion.

Draft Selects messages that are drafts.

Not Draft Selects messages that are not drafts.

Matching Selects messages that meet the current match criteria.
Non-Matching Selects messages that do not meet the current match criteria.
Labels Selects messages that have the corresponding label set.

5.5.7 Reference
OPERATIONS ON MESSAGES IN MAILBOX WINDOWS

To open one or more selected Press return or enter on the
messages keyboard.

Double-click one of the selected
messages.

Choose Open Message from
the File menu or press
Command-0 (Mac OS X),
Ctrl-0 (Windows) or Meta-0

(Unix).
To delete one or more selected Press delete or clear on the
messages keyboard.

Choose Delete from the
Message menu or press
Command -D (Mac OS X),

CtrI-D (Windows) or Meta-D
(Unix).

Click the Delete button in the
mailbox window.

To undelete one or more Press delete or clear on the
selected messages (which are  keyboard.
all deleted)

Choose Undelete from the
Message menu or press
Command -D (Mac OS X),

Ctrl-D (Windows) or Meta-D
(Unix).
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Click the Undelete button in the
mailbox window.

To undelete one or more
selected messages (some of
which are not deleted)

Delete the messages ‘twice’. The
first time will delete all those not
already deleted. The second time
will undelete all the deleted
messages.

To copy one or more selected
messages to another mailbox

Select the mailbox you want to
copy the messages to from the

Copy to Mailbox sub-menu in
the Message menu.

Drag and drop the messages
onto another open mailbox
window.

(This feature is only available if Drag
and Drop is supported)

Drag and drop the messages
onto a mailbox in the server
window.

(This feature is only available if Drag
and Drop is supported)

To print one or more selected
messages

Select Print from the File menu
or press Command -P (Mac OS
X), Ctrl-P (Windows) or
Meta-P (Unix).

(Only the first text part in the

message is printed, not the whole
message)

To save one or more selected
messages to disk

Select Save from the File menu
or press Command -S (Mac OS
X), Ctrl-S (Windows) or
Meta-S (Unix).

(Only the first text part in the

message is saved, not the whole
message)

To check for new messages

Select Check Email from the
Mailbox menu or press
Command -L (Mac OS X),

Ctrl-L (Windows) or Meta-L
(Unix).
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To create a text clipping (a
simple text file in the Finder)
of the message text in one or
more selected messages

Drag the messages to the
Desktop.

(Only the first text part in the
message is dropped on the destination,
not the whole message)

(This feature is only available if Drag
and Drop is supported)

To change the flags for one or
more selected messages

Select the flag to toggle from the
Flags sub-menu in the
Message menu.

To select messages with a
particular flag set or unset

Choose the flag to select by
from the Select by Flag sub-
menu in the Edit menu.

To reply to or forward the
selected messages

Select the required option from

the Message menu or click the
appropriate button in the
mailbox window.

To redirect or send the
selected messages

Select the required option from
the Message menu.

To create a message digest of
the selected messages

Choose Create Digest from
the Message menu.

To expunge (permanently
remove) deleted messages
from the mailbox

Choose Expunge from the
Mailbox menu or press
Command -E (Mac OS X),

Ctrl-E (Windows), Meta-E
(Unix).

Click the Expunge button in the
mailbox window.
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5.6 Outgoing Message Queue Window

Mulberry has the ability to collect outgoing messages in a local queue. The outgoing
message queue is a special type of local mailbox that is managed by Mulberry. There are
several advantages to this approach, including the ability to send outgoing messages in the
background, as well as compose messages while in disconnected mode and send them the
next time a network is available.

To enable the outgoing message queue for a particular SMTP account, you must first select
that account in the Accounts preference panel and turn on the appropriate items in the
Options tab (see page 43).

Once one or more SMTP accounts are enabled for local queuing, the Outgoing Message
Queues window will be accessible via the Show Outgoing Queues item in the File menu.
The window is shown in Figure 95.

SO0 Outgoing Message Queues: SMTP - Disabled

@ %7 Eﬂ r‘E' Accounts  SMTP .;] & @

Haold Pricrity  Delete Expungea Enakble

PN ™ [ From / To | Thread |

1 L| b friend@domain.uk  Mulberry is Great!
Faa 23 P i Drerrett hrerare o

Total: 2

Figure 95 The Outgoing Message Queues window

The Outgoing Message Queues window is very similar to a Mailbox window, although
different buttons are used in the header area and the icons in the ‘Flag’ column are
different. Messages can be opened, deleted, and expunged exactly as in a regular Mailbox
window.
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The outgoing queue window toolbar contains the following items:

®

Allows selected messages to be put on ‘hold’. Held messages are not
sent, even when Mulberry is in connected mode and the outgoing
queue is enabled.

Hold
Assigns a higher priority to selected messages. Priority messages are
' sent before other messages.
Pricrity
T Deletes the selected messages. Deleted messages will not be sent.
o
Delete
FT Expunges (permanently removes) deleted messages.
]|
Expungea
Account Allows switching between the queues for different SMTP servers.
N Enables the outgoing queue causing it to send any queued messages.
%) When the queue is enabled, this button will change to a Disable
Enable button. The outgoing queue is automatically disabled when

Mulberry is in disconnected mode. When switching from
disconnected back to connected mode, the outgoing queue is
normally re-enabled, and any messages queued while in disconnected
mode are sent.

The possible flag icons for messages in the outgoing queue are:

REHEE
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A message waiting to be sent.

A message being held in the queue.

A message in the process of being sent.

A message that was not sent successfully.

A messages that has been marked as deleted.
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5.7 Rules and Filtering

Mulberry has the ability to automatically perform user-defined actions or rules on
messages in chosen mailboxes, when a certain ‘event’ occurs for that mailbox. For example,
it is possible to setup a rule to look for new messages containing a particular From address,
and to change the flag to important, when a mailbox is first opened.

The current Rules behavior in Mulberry is implemented in two ways:

e ‘Local’ — with local rules, Mulberry can apply actions to incoming messages that it ‘sees’
in mailboxes. This implements a “client-side’ filtering capability, allowing Mulberry (the
client) to determine how to automatically process incoming messages in mailboxes.

» ‘SIEVE’ -SIEVE is a ‘server-side’ filtering technology that allows messages to be filtered
when they are delivered to mailboxes on the server, before the client application ever
‘sees’ them. Server-side filtering is more efficient than client-side filtering as the server
does all the work in the background, as opposed to having to wait for the client to do
filtering. In order to use SIEVE filtering, your email system must support it — check with
your email system manager.

Local and SIEVE rules are described in more detail in the following sections, together with
a description of the Rules Manager window which is used to create, edit, delete and
manage rules In Mulberry.

5.7.1 Local Rules

5.7.1.1 Introduction

Local rules are used to apply a set of actions to a set of incoming messages when a specific
event occurs on a mailbox. This can be thought of in the following way:

When event occurs on mailbox I Trigger 1
If a message matches search criteria Rule 1
then do actions
else if a message matches search criteria Rule 2
then do actions
When event occurs on mailbox I Trigger 2
If a message matches search criteria Rule 1
then do actions
else if a message matches search criteria Rule 3
then do actions
etc. etc

The items underlined above indicate properties that you can set in Mulberry.
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This behavior is configured in Mulberry by setting up a series of ‘triggers’ and ‘rules’, each
with a user supplied unique name. A trigger specifies a set of mailboxes and an event to
look for on those mailboxes. A rule specifies a set of search criteria and some actions to
apply to messages that match those search criteria. Multiple rules can be associated with a
single trigger, and a single rule can be used by multiple triggers, as illustrated above
(Trigger 1 contains Rules 1 and 2, Rule 1 is used in both Triggers 1 and 2).

The next sections describe rules and triggers in more detail.

5.7.1.2 Rules

Rules consist of two components: a set of search criteria used to determine which messages
should be processed, and a set of actions that will be applied to those message which match
the search criteria. Each rule can be associated with one or more Triggers (see

Section 5.7.1.2.3 for full details of Triggers) and this can be done by selecting the triggers
when the rule is created or by dragging it onto the trigger after it has been created (see
Section 5.7.1.3.4 for more details). If a rule is not associated with any triggers, it will never
be run, and its name appears in the Rules Manager window in italic text. Each rule has a
user supplied unique name.

5.7.1.2.1 Search Criteria

Rules can contain one or more search criteria. When a rule is executed against a set of
messages, a search is done to determine which messages in the set match the rule’s search
criteria. Only those messages which match the search criteria will be processed, others will
be ignored by the rule.

Rules search criteria are the same as those available for searching of messages, using the
Search window, and are fully described in Section 5.5.5.

5.7.1.2.2 Actions

Rules can contain one or more actions. When a rule is executed against a set of messages,
the actions are applied to (only) those messages that match the rule’s search criteria. The
actions are:
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Set Flag Sets the specified flag or label on the matching messages.
Unset Flag Removes the specified flag or label from the matching messages.
Copy Message to  Copies the matching messages to the specified mailbox.

Note This action does not set the deleted flag after the
copy operation, even if the ‘Delete Message after Copy’

option is on in the Message>Options preference panel (see
Section 4.6.2).

Move Message to

Copies the matching messages to the specified mailbox and then sets
the deleted flag on all of those messages.

Note The deleted flag is always set, even if the ‘Delete
Message after Copy’ option is off in the Message>Options
preference panel (see Section 4.6.2).

Reply to Message

Generates replies to the matching messages, one for each matched
message. A number of options for generating the reply are available,
and fully described in Section 5.7.3.3.1.

Forward Message

Generates forwarded messages for the matching messages, one for
each matched message. A number of options for generating the
forward are available, and fully described in Section 5.7.3.3.2.

Redirect Message

Generates bounces to the matching messages, one for each matched
message. A number of options for generating the redirect are available,
and fully described in Section5.7.3.3.3.

Expunge Message

Expunges (permanently removes) the matching messages from their
mailbox.

Note Only those messages in the matching set that have
their deleted flag turned on will be expunged. Thus an
Expunge action will likely be preceding by a ‘Set Flag
Deleted’ action or a ‘Move Message to” action.

Play Sound

Plays the specified sound when matching messages are found.

Display Alert
with

Display an alert box on screen with the specified text appearing in the
alert when matching messages are found.

MAc OS X &
WINDOWS ONLY
Speak

Mac OS X & WinDows ONLY

Speaks the specified text when matching messages are found.
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5.7.1.2.3 Stopping Rules from further processing Messages

When a trigger contains multiple rules, each rule is executed one after the other when the
trigger runs. Sometimes it is necessary to prevent later rules from processing messages
that were already processed by an earlier rule.

For example, you might have a rule to match messages from your boss with an action to
mark it as important, and another rule to match messages from co-workers in your email
domain and move those to another mailbox. If you don’t want messages from your boss
to be moved out along with the others from co-workers, you can turn on the ‘Stop if
Matched’ option for the ‘boss’ rule, when creating or editing the rule (see Section 5.7.3.3).
That will prevent messages that match that rule from being processed by others that
follow it.

5.7.1.3 Triggers

Triggers are different types of events that occur in Mulberry and that can be used to run a
set of rules. Each trigger specifies what type of event it is governed by, as well as the set of
mailboxes to which it applies. Rules are then added to the trigger and those rules will be
executed when the trigger runs.

By default the Triggers list in the Rules Manager window is hidden, but it can be made
visible via the Show Triggers button. Mulberry provides a set of default triggers that are
the common ones most users will need. Additional triggers can be created and configured
via the Triggers list in the Rules Manager window.

Each trigger has a user supplied unique name. Triggers can be explicitly enabled or
disabled. Disabled triggers appear in the Rules Manager window with their names
displayed in italic text.

5.7.1.3.1 Trigger Events

There are a number of different events in Mulberry that can cause a trigger to be run:

Never The trigger never runs. This can be used to disable a trigger without
deleting it.

New Messages The trigger runs when new messages are detected when opening a
Arrive mailbox, or when an open mailbox is checked. This trigger will only be
applied to messages that are unseen, not deleted and not drafts, in
addition to any other search criteria specified by its rules.

Opening a This trigger runs whenever a mailbox is opened.

Mailbox

Closing a This trigger runs whenever a mailbox is closed.

Mailbox

All The trigger runs when any of the three previous events occur.
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5.7.1.3.2 Trigger Mailbox Sets

Each trigger will only run when its event occurs on a mailbox that is specified in the trigger.
There are a number of different ways of specifying the list of mailboxes to which the
trigger applies. Using the Rule Triggers dialog (see Section 5.7.3.4), it is possible to create
multiple sets of each type. The different types are:

None

There are no mailboxes causing this trigger to run.

Mailbox

The name of a single mailbox can be specified. The trigger will run when
the trigger’s event occurs on that mailbox only.

Cabinet

The name of a single mailbox cabinet (see Section 5.4.4.6) can be
specified. The trigger will run when the trigger’s event occurs on any of
the mailboxes listed in the chosen cabinet at that time. This provides a
quick way to apply a trigger to an arbitrary group of mailboxes, by
simply creating a cabinet for those mailboxes, adding them to the
cabinet, and choosing that cabinet for the trigger. Adding or removing
mailboxes for use with the trigger is then a simple matter of adding or
removing them from the cabinet, as opposed to adding or removing
individual mailbox selections to the trigger.

Account

The name of a mailbox account can be specified. The trigger will run
when the trigger’s event occurs on any of the mailboxes belonging to
the chosen account.

All

The trigger will always run when the trigger’s event occurs on any
mailbox.

5.7.1.3.3 Default Triggers

When a new set of preferences is used (for example when first running Mulberry), a
default set of triggers is created. These cover the typical set that is used:

All Incoming
Email

This trigger is run when new messages arrive in any of the mailboxes in
the ‘Check Favorites’ cabinet. These are by default the set of mailboxes
chosen to be checked for new email. The rules are only applied to new
messages.

When Opening a
Mailbox

This trigger is run when opening any of the mailboxes in the ‘Check
Favorites” cabinet. These are by default the set of mailboxes chosen to
be checked for new email. The rules are applied to all the messages.
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5.7.1.3.4 Adding or removing rules

There are two ways to add rules to a trigger:

* When creating or editing the rule, click on the Triggered by popup button in the Rules
Edit dialog (see Section 5.7.3.3) and select the trigger you want to add the rule to or
remove the rule from. When the rule is added to a trigger, a checkmark will appear
against the trigger in the Triggered by popup menu.

*  When the Triggers table is visible in the Rules Manager window, each trigger has its set
of rules displayed beneath it in a hierarchical list that can be collapsed or expanded. To
see the rules associated with a trigger expand the list. To add a rule to a trigger, drag
and drop the rule from the Rules list onto the trigger in the Triggers list. To remove a
rule from a trigger, select the rule in the Triggers list and hit the Delete key.

5.7.1.4 Applying Rules by Hand

Normally rules are run by triggers in response to a particular event on a particular
mailbox. It is also possible to manually apply a rule to specific messages in any mailbox, or
to messages in all open mailboxes, without the need for a trigger. This can be done either
by using the Apply Rules sub-menu in the Mailbox menu, or by using the Apply button in
the Rules Manager window.

To use either method, the rule must first be set to appear in the Apply Rules sub-menu of
the Mailbox menu. This can be done by turning on the ‘Apply Rules Menu’ option in the
Triggered by popup when editing a rule (see Section 5.7.3.3). Rules which have that option
set will appear in the Apply Rules sub-menu.

5.7.1.4.1 Using the Apply Rules sub-menu

To manually apply a rule to a set of selected message in an open mailbox, first select
messages in the mailbox and then choose the rule from the Apply Rules sub-menu in the
Mailbox menu. Only those messages which match the search criteria in the rule, will be
processed — others will be ignored even though they are selected. If you want to have a
rule that is always applied to the entire selection, create one with a single search criterion
set to “All’ (see Section 5.7.3.3 for more details).

5.7.1.4.2 Using the Rules Manager Apply button

To manually apply all the rules in the Apply Rules sub-menu to all the messages in all
open mailboxes, go to the Rules Manager window and click the Apply button. Only those
messages which match the search criteria in each rule, will be processed — others will be
ignored.

5.7.1.5 Create a Rule using an Existing Message as a Template

It is possible to use an existing message in a mailbox to create a rule that matches criteria
for that message, so that similar messages can be filtered when they next appear. To do
that, first select one or more messages in a mailbox window, and then choose the Make
Rule command in the Mailbox menu. This will create a new rule in the Rules manager
window, and display a Rules Edit dialog (see Section 5.7.3.3) with the From address and
Subject text for each message automatically added as search criteria in the dialog. You can
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then remove the criteria you don’t want or add additional criteria, or refine the criteria
already present as required.

5.7.2 SIEVE Rules

5.7.2.1 Introduction

SIEVE rules are similar to local rules, except that they are put together into a ‘script” which
is then passed to a SIEVE server. The server then interprets the command in the script
whenever a message is delivered for the current user, and takes appropriate actions based

on the script contents.

In Mulberry, a SIEVE script is created from a set of rules. These rules are very similar to
those used for local filtering, but have slightly different search criteria and actions based on
what SIEVE can do. Rules can then be associated with one or more “scripts’, in a similar
manner that local rules are associated with triggers. A script can then be generated by
writing the script item to disk. From their, the script file can be uploaded to a SIEVE server
using the mechanism provided by that server.

The next sections describe SIEVE rules and scripts in more detail.

5.7.2.2 Rules

SIEVE rules are similar to local rules, and are created, edited and deleted in the same
manner as local rules. SIEVE rules have slightly different search criteria and actions
compared to local rules, and these will be described in the next sections.

5.7.2.2.1 Search Criteria

SIEVE search criteria contain the following items:

From Address Matches the From address in the message header

To Address Matches the To address in the message header

CC Address Matches the CC address in the message header

Bcc Address Matches the Bece address in the message header

Recipient Matches either the To, CC or Bec addresses in the message header

Correspondent Matches any address in From, To, CC or Bcc message headers that is
not one of your addresses or an alias.

Sender Matches the Sender address in the message header

Subject Matches the Subject text in the message header

Header Field Matches text in a chosen message header

Size Matches the size of the message

All Messages Always matches
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5.7.2.2.2 SIEVE Actions

SIEVE actions can be any combination of the following;:

Keep The message will always be delivered to the ‘default’ mailbox
(usually INBOX), in spite of any actions that come before or after this
one.

Discard The message will be removed and not be delivered to any mailbox.
There will be no error message to indicate the message was
removed.

Reject The message will be sent back to its sender and will not be delivered
to any mailbox. You can specify text to be used in the rejection notice
sent back to the sender of the original message.

Redirect The message will be bounced to an address that you specify and will
not be delivered to any mailbox.

File into The message will be delivered into the mailbox that you specify.
Mailboxes other than INBOX can only be used when SIEVE is
available with an IMAP server. The mailbox that you specify must be
a valid mailbox for the SIEVE server. If the mailbox does not exist,
the message will instead be delivered to the ‘default’ mailbox.

5.7.2.3 Scripts

A SIEVE script can contain multiple SIEVE rules, and has a unique user-defined name.
When a script is selected in the Rules Manager window, and the Write button clicked, a text
file will be generated with the textual form of the script as its content, and named after the
script name. This file can then be uploaded to the SIEVE server for use by that server.

5.7.3 Rules Manager Window

5.7.3.1 Basic Layout

The Rules manager Window is shown in Figure 96.
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Figure 96 The Rules Manager Window.

The Rules Manager window is divided into three main sections:

e The Tab buttons section allows either Local or SIEVE rules to be displayed in the list
area below. When one is selected, the toolbar and lists, will be changed to reflect the
type of rules selected for display.

e The toolbar section contains buttons that can be used to create, edit, delete and manage
rules. These buttons change depending on whether local or SIEVE rules are being
displayed.

e The lists section contains either one or two lists displaying rules, depending on whether
local or SIEVE rules are being displayed:

e Local: when local rules are selected, it is possible to have one or two lists displayed.
When a single list is displayed, it contains the list of local rules. When two lists are
displayed, the left-hand list is the set of local rules, and the right-hand list is the set of
triggers. It is possible to toggle the display between one or two lists using the Show
Triggers button in the toolbar.

e SIEVE: when SIEVE rules are selected, two lists are always displayed. The left-hand
list shows the set of SIEVE rules, and the right-hand list shows the list of SIEVE
scripts.
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When both lists are displayed, you can adjust the relative sizes of each by using the
split-pane control located between them. Items from the rules list on the left-hand side
can be drag and dropped onto items in the right-hand list, to add rules to a trigger or

script.

5.7.3.2 Toolbar

5.7.3.2.1

Local Rules

The following buttons are available in the Local rules toolbar:

Rule Creates a new rule. The rule edit dialog appears to allow a new item
to be configured and added to the rules list.

Trigger Creates a new trigger. The trigger edit dialog appears to allow a new
trigger to be configured and added to the triggers list.

Edit Edits the currently selected rule or trigger.

Delete Deletes the currently selected set of rules or triggers.

Apply Applies the currently selected rules to all messages in all open

mailboxes.

Show Triggers

Toggles the display of the triggers list.

5.7.3.2.2 SIEVE Rules

The following buttons are available in the SIEVE rules toolbar:

Rule Creates a new rule. The rule edit dialog appears to allow a new item
to be configured and added to the rules list.

Script Creates a new script. The a dialog appears to allow a name for the
new script to be configured and added to the script list.

Edit Edits the currently selected rule or script.

Delete Deletes the currently selected set of rules or scripts.

Write Writes the currently selected script to a server or to disk.

5.7.3.3 Editing a Rule

To edit a rule, either double-click on it in the rules list, or select it and click the Edit button
in the toolbar. The rules edit dialog shown in Figure 97 will then appear.
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Edit Rule

Mame: |MSDMN Triggered by@

If Messages Match:
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'Tl or s ] From Address |§ ] Contains I ¥ ] madnnote@microsoft.

[ More Choices | | Fewer Choices | | Reset |
|

Then do Actions:
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E Expunge Message | & ]

[+ Speak with 1'#] MSDN filter triggered

It' More Actions ',I It' Fewer Actions ',I (] Stop if Matched It' Reset ',I

(Cancel)

Figure 97 The Rules Edit dialog used for creating or editing rules.

The rules edit dialog contains three main sections:

Name and trigger/script application: this section allows the name of the rule to be set.
The Triggered by popup allows the rule to be associated with a trigger or script
depending on whether it is a local rule or a SIEVE rule.

Search criteria section: this section allows the criteria used to match messages to be
specified. It is possible to create as many criteria as required, using the More Choices
button. The last criteria can be removed using the Fewer Choices button. Criteria can
be moved up or down the list by clicking on the up or down arrow buttons to the left
of each item.

Action criteria section: this section allows the actions to be performed on matching
messages to be defined. It is possible to create as many actions as required, using the
More Actions button. The last action can be removed using the Fewer Actions
button. Actions can be moved up or down the list by clicking on the up or down arrow
buttons to the left of each item.

Mulberry Reference Guide v4 195



Reply, forward and redirect actions require extra configuration using the Options button
that appears with those action items. Clicking on that button, allows the configuration for
each of those types of action, and will be described next.

Reply Options

The reply options edit dialog is shown in Figure 98.
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Reply using:
E'j Reply-To
" Sender
From

All

(I

@ Quote original Message

Reply Text...

") Use Standard Identity

Eﬁ Use Identity: | Default

@ Create Draft instead of Sending

v Cancel ) (

Figure 98 The Reply Options action edit dialog.
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The dialog allows editing of the following reply options:

Reply using

Allows you to choose which address from the original message
should be used as the address to reply to. Choices are:

* Reply-to — the address in the Reply-To header of the original
message

* Sender — the address in the Sender header of the original
message

* From - the address in the From header of the original
message

¢ All - the addresses in the From and Cc headers of the
original message

Quote original Message

If turned on, the original message text will be automatically
quoted in the reply.

Reply Text

Click to set the text that is used in the reply.

Use Standard Identity

Turn this on to select the identity that is normally associated
with the mailbox or account that the original message is in. This
identity will be used for the reply message, and determines
what signature is used, and where any copies of the reply will
be saved etc

Use Identity

Turn this on and choose an identity via the popup next to it to
associate the chosen identity with the reply message. This will
override the normal identity that would be used when replying
to the message by hand.

Create Draft instead of
Sending

Turn this on to generate a draft window containing the reply,
without automatically sending it. You can then inspect the
reply, modify it if needed, and then send it manually. Turn this
off to have the reply automatically sent without giving you the
option to inspect or modify it.
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5.7.3.3.2 Forward Options

The forward options edit dialog is shown in Figure 99.

Forward Action Options

To: ||
Ci:

Beoe:

E Quote original Message
2 Attach original Message

Ifr Forward Text... 1'l

,:, Use Standard ldentity
f®) Use Identity: | Default B

E Create Draft instead of Sending

|':: Cancel :,l (—QK—)

Figure 99 The Forward Options action edit dialog.
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The dialog allows editing of the following forward options:

To Allows you to set the addresses to whom the forwarded
message will be sent.

Cc Allows you to set the addresses of recipients that should have
the forwarded message cc’d to them.

Bcc Allows you to set the addresses of recipients that should have

the forwarded message bec’d to them.

Quote original Message

If turned on, the original message text will be automatically
quoted in the reply.

Attach Original
Message

If turned on, the original message will be added as an
attachment to the forward message.

Forward Text

Click to set the text that is used in the forward.

Use Standard Identity

Turn this on to select the identity that is normally associated
with the mailbox or account that the original message is in. This
identity will be used for the forwarded message, and
determines what signature is used, and where any copies will
be saved etc

Use Identity

Turn this on and choose an identity via the popup next to it to
associate the chosen identity with the forwarded message. This
will override the normal identity that would be used when
forwarding the message by hand.

Create Draft instead of
Sending

Turn this on to generate a draft window containing the
forwarded message, without automatically sending it. You can
then inspect the message, modify it if needed, and then send it
manually. Turn this off to have the forwarded message
automatically sent without giving you the option to inspect or
modify it.
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5.7.3.3.3 Redirect Options

The forward options edit dialog is shown in .

Redirect Action Options

To: ||
Ci:

Beoe:

,:, Use Standard ldentity
f®) Use Identity: | Default B

E Create Draft instead of Sending

{: Cancel :,l (—BK—)

Figure 100 The Redirect Options action edit dialog.
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The dialog allows editing of the following forward options:

To Allows you to set the addresses to whom the bounced message
will be sent.

Cc Allows you to set the addresses of recipients that should have
the bounced message cc’d to them.

Bcc Allows you to set the addresses of recipients that should have

the bounced message bcc’d to them.

Use Standard ldentity

Turn this on to select the identity that is normally associated
with the mailbox or account that the original message is in. This
identity will be used for the bounced message, and determines
what signature is used, and where any copies will be saved etc

Use Ildentity

Turn this on and choose an identity via the popup next to it to
associate the chosen identity with the bounced message. This
will override the normal identity that would be used when
bouncing the message by hand.

Create Draft instead of
Sending

Turn this on to generate a draft window containing the
bounced message, without automatically sending it. You can
then inspect the message, modify it if needed, and then send it
manually. Turn this off to have the bounced message
automatically sent without giving you the option to inspect or
modify it.
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5.7.3.4 Editing a Trigger

To edit a rule, either double-click on it in the rules list, or select it and click the Edit button
in the toolbar. The rules edit dialog shown in Figure 101 will appear.

Edit Rule Trigger

Mame: |Incoming Mail E Enabled

Trigger when: Mew Messages Arrive (==

Apply to

+1 Cabinet {51 Check Favourites [B=

*1 Mailbox 1) POP3:NBOX (+)
( More Choices ) ( Fewer Choices ) ( Reset )

( cancel ) { Ok }

Figure 101 The Triggers edit dialog.

The triggers edit dialog contains the following items:

Name Allows you to set the name of the trigger that will be displayed in the
Rules Manager list. You must enter a unique name for this trigger.

Enabled Turn this on to enable the trigger. Turn this off to disable the trigger.
This gives you the option of temporarily turning off a trigger without
having to delete it.

Trigger when Select the event that should be occur to initiate this trigger. The events
that can be selected are described in Section 5.7.1.3.1.

Apply to Use this section to specify which set of mailboxes this trigger should
be applied to. You can create as many mailbox sets as you like. To add
a new set, click the More Choices button. To delete the last set click
the Fewer Choices button. To re-order sets, use the up and down
buttons to the left of each set item.

The options available for each set are described in Section 5.7.1.3.2.

202 Mulberry Reference Guide v4



5.7.4 Reference

OPERATIONS ON RULES IN THE RULES MANAGER

WINDOW
To display Local rules Click the Local tab button
To display SIEVE rules Click the SIEVE tab button

To show or hide the triggers
list for Local rules

Click the Show Triggers
button.

To create a new Local or
SIEVE rule

Click the New button

To create a new trigger

Click the Trigger button

To edit one or more selected
Local or SIEVE rules, or
triggers or SIEVE scripts

Click the Edit button

Press return on the keyboard

Double-click on the rule, trigger
or script

To delete one or more selected
rules, triggers or scripts

Click the Delete button

Press delete on the keyboard

To add a Local rule to a trigger

Drag and drop the rule onto the
trigger in the triggers’ list

Edit the rule and select the
trigger in the Triggered by
popup in the edit dialog

To remove a Local rule from a
trigger

Select the rule in the triggers’ list
and click the Delete button

Select the rule in the triggers’ list
and press delete on the
keyboard

Edit the rule and deselect the
trigger in the Triggered by
popup in the edit dialog

To add a SIEVE rule to a script

Drag and drop the rule onto the
script in the scripts’ list

Edit the rule and select the script
in the Triggered by popup in the
edit dialog

To remove a SIEVE rule from
a script
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Select the rule in the scripts’ list
and press delete on the
keyboard

Edit the rule and deselect the
script in the Triggered by popup
in the edit dialog

To apply selected Local rules  Click the Apply button
to all the messages in all open
mailboxes

To write selected SIEVE scripts  Click the Write button
to a server or to disk
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5.8 Message Pane/Window

From: Vince Everett <vince@cyrusoft.com= To: Happy Customer <happy®@domain.uks>, .. [
Subject: Re: Mulberry is Great! Date: /8798 8:01 PM

= Parts: 1 | Formatted I—#—] A“lA. " All Quotes I—H

= --0n Mon, Feb 28, 1995 3:17 pm "Happy Customer”™ <happy@domain.uks
> wWrote:

» I think Mulberry is great - don't you?

Yes - but I wrote 1t so what do you expect?

Figure 102 A typical message pane with its parts list collapsed
S O6 Mulberry is Great!
T = |
A b @ 3 dDb D
Draft Reply Reply Al Forward Move to Delete Print Prawv Mext Del-Mxt
Frome |1ufinn:e Everett <vince@cyrusoft.ooms
To: | friend@domain.uk
Ce: | somebody@domain.uk

Subject: Mulberry is Great!

Date sent: August &, 1998 2:01:43 PM Message 1 of 5

b Parts: 1 | “Formatted | 2 | [A=TA.] | Al Quotes )

|Ju51: to let vou know that I think Mulberry 1s great!

Figure 103 A typical message window with an expanded header area
and its parts list collapsed
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Figure 103 shows a typical message preview pane that can appear in the 3-pane window or
in a mailbox window. Figure 103 shows a typical message window that displays a message
in its own window, the window title is the text of the subject or the address of the sender if
the subject line is empty. You can set the default size and location for message windows by
sizing and positioning a message window to your tastes and then choosing Save Default

Window from the Window menu (see page 311).
Message windows are divided into three main sections:
* The Header section can appear expanded or collapsed:

e Expanded: shows the addresses, subject and date for the message, together with
navigation buttons and other buttons to operate on the message (as illustrated in
Figure 103).

e Collapsed: Shows only the navigation buttons and other buttons used to operate on
the message.. Address, subject and date information is displayed in summary form
in the message text display area (as illustrated in Figure 104).

* The Parts section can be expanded or collapsed. In its collapsed state (as shown in
Figure 103) it shows the total number of MIME parts to the corresponding message,
together with a button for displaying the message header, pop-up menus to change the
display format and choose a mailbox to copy the message to, and a button to perform a
copy to the selected mailbox. In its expanded state, it also shows a list of each MIME
part allowing you to manipulate the individual parts.

* The Text Display section is used to display any text parts in the message.

These sections are now described in more detail.

5.8.1 Toolbar Buttons

The message window has a toolbar associated with it, whereas the message preview pane
uses the toolbar in the window that contains it.

The message window toolbar contains the following items:

Create a new draft window to allow you to compose a new message.

N

=
-
[
=

Creates a reply to the message.

i

Reply

Create a reply to all correspondents in the message.

&

e

Rephy All

Forwards the message.

&

Forevard
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Eﬁj

Bounces the message.

Redirect

b Copies or moves the message.
= I

Move to

A Deletes the message.

L

Delete

Prints the message.

Print

5 Delete the message and display the next message in the mailbox in
ﬂ) the window.

Display the previous message in the mailbox in the window.

Del-MNxt
Prav
axt

M

Display the next message in the mailbox in the window.

5.8.2 Address Captions

5.8.2.1 Preview Pane

The address captions at the top of the preview pane, shown in Figure 102, display
summary details about the addressees, the subject and date the message was sent. The
address caption display can be added or removed by turning on or off the Show Address
Bar option in the Window Options dialog (see section 5.1.2).

As an alternative to the address captions, the summary header information can be
displayed at the top of the text area in the message preview. The display of summary
headers can be turned on or off using the Show Summary Headers option in the
Window Options dialog (see section 5.1.2).
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5.8.2.2 Window

e 06 Mulberry is Great!

- v r__=_- F—
174 o O | S O ©
Diraft Reply Reply All Forward Move to Delete Print MNext Del-Mxt

Message 1 of 5
= Parts: 1 = Formatted | f;] A-lA. All Quotes | f;]

From: Vince Everett <vince@cyrusoft.coms
To: friend@domain.uk

cc: somebody@domain. uk

Subject: Mulberry i1s Great!

Date-5Sent: August &, 1998 B:81:43 PM

Just to let yvou know that I think Mulberry 1s great!

Figure 104 The message window showing the header area in collapsed
state, with the summary headers displayed in the message body.

In its expanded state (see Figure 103), the message window header shows three address
fields for the ‘From?’, “To:” and ‘Cc:” address lists in the message. These fields display either
the first address in the corresponding list if it is collapsed, or a scrolling list of all the
addresses in the corresponding address list if expanded. Each address field can be expanded
or collapsed by clicking the disclosure button next to it.

Note When Mulberry opens or displays a new message in an
existing message window with an expanded header, it will
automatically expand or collapse the address fields depending on
whether there is one or more than one address in the list to be
displayed. If there is only one address and its text fits in the single
address field, the disclosure button will be disabled.

The expanded header in the message window also shows the subject of the message and
the date on which it was sent. You cannot edit the text in these fields or any address field.
However, you can select the text and either copy it or drag and drop it to a different
location (for example dragging addresses to an address book, which would add those
addresses to the address book list).

When the header is collapsed, summary message
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5.8.3 Security Information
5.8.4 Parts Header

5.8.4.1 Message Parts Header: Controls

The message parts header area contains a number of controls as shown in Figure 105, and
described in more detail below:

* ’Parts’ disclosure button Expands or collapses the display of the parts table.
e ‘Parts’ number The total number of parts in this message.

* Attachment indicator If present, indicates that the message contains some
attachments. Different icons indicate different types
of attachment:

% Indicates a message which contains styled text and
plain text alternatives.

™ Indicates a messages which contain other types of

attachment.

e ‘Header’ button Toggles the display of the message’s header (see next
section.

e ‘Formatting’ pop-up menu Changes the formatting of the text on display (see
page 213).

* ‘Text Size’ buttons Increases or decreases the size of the text used for

displaying the message content. The current size factor is
displayed next to the buttons.

* ‘Quote Level” pop-up menu Turns on or off the display of quoted text at different levels
of quotation in the message content.

= Farts: 1 = Formatted ﬂ At A~ All Quotes _t]

Figure 105 The message parts header area controls

5.8.4.2 Showing Message Headers

Email headers contain the addressing information and details about the structure of the
message and are used by SMTP servers when a message is sent. The headers are also used
by the IMAP server to determine the addressing information as well as the MIME parts
and structure of the message. Sometimes it is useful to see all the headers in a message and
the header button (shown in Figure 105) is used to toggle the display of the message’s
email header. When it is on, the email header text is displayed at the top of the text display
area. When off, the email header is not displayed.

The style for the header fields displayed in the header can be changed in the ‘Styles’ tab of
the Display preferences panel.
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Note You can choose whether to have the email header displayed
or not displayed when first opening a message window. This
option is controlled by the ‘Show Message Header in Window’
option in the “‘Message’ preferences panel (see page 69).

5.8.4.3 Message Parts Header: Parts Table

The MIME standard allows messages composed of multiple parts to be sent via email.
These parts can be ordinary plain text or more complex ‘binary” data such as images or
even application files. The MIME structure of a message is hierarchical and allows message
parts to be grouped in a ‘multipart’ part.

MIME messages have these features:
* Every message contains one or more parts.

* Each part is described by a type and a related subtype. For example there are three
standard subtypes corresponding to the ‘text’ type. These are:

e ‘plain’ - indicates the part contains plain, unformatted text.

* ‘enriched’ - indicates the part contains text in the special ‘enriched” format which
allows formatted text to be sent.

* ‘html’ - indicates that the part contains HTML (Hyper Text Mark-up Language) text
that is used as the basis for World Wide Web pages.

Other types are used to represent binary data (e.g. ‘image’, ‘audio’, ‘video’,
“application’) and the ‘multipart’ type is used to indicate a group of other parts. A special
‘message’ type also exists and this is used to indicate an encapsulated email message
inside another or other information about a specific email message.

* Mulberry allows you to view any text part, and includes support for viewing enriched
and HTML formatted text as well as plain text (see page 213).

¢ Other parts can be downloaded to any disk on your local computer and then opened
using their appropriate application.

The message MIME parts display can be either collapsed (as shown in Figure 103) or
expanded (as shown in Figure 106). In the collapsed state it just indicates the total number
of different MIME parts in the message. When expanded it displays a either a hierarchical
list of all the MIME parts in the message or a flat (simplified) list, showing the MIME type
and sub-type, the size, and the name of each part. To switch between hierarchic and flat
mode use the flat/hierarchic toggle button. In the flat (simplified) mode Mulberry shows
only those parts which you can actually view or save to disk.
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The expanded view also shows which parts can and cannot be viewed in the text display
area, and whether they have already been seen. This is indicated by the diamond buttons
in the first column of the list:

» % Indicates the part currently on view in the text area below.

% Indicates that the corresponding part is of a type that Mulberry can display in the
text area below. Clicking this button will cause the part to appear in the text area below.

* & Indicates that a part which Mulberry can display has already been seen. Clicking this
button will cause the part to appear in the text area below.

. Indicates a part which Mulberry is unable to display in the message window.

e O Indicates a part that is a MIME sub-message included in the main message. Clicking
this button will open a new message window showing the sub-message.

e B Indicates a MIME sub-message part that has already been seen.

¥ Parts: E = Formatted | ] A~ A~ All Quotes s ]
';.%L!J Content-Type (Hierarchic) Size Mame
L =| text/plain 37 Unnamed part #1

v %multipar:fmixed

> l.:,l multipart/appledouble Mulberry Mailbox Con...
L =| text/plain 0 Unnamed part #2_2
O v @ messagerfcB22 356 Here's the new Mulbe...
L =| text/plain 47 Unnamed part #3_1

Figure 106 The message parts list showing a complex message structure

You can see more detailed information about each part by selecting it and choosing

Details... from the Edit menu. This will display the dialog shown in Figure 107 with the
details for the selected MIME part filled in.
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MIME Part

Name: Unnamed part #1
Type: text/plain
Encoding: 7hit
ID:
Disposition: inline

Description:

Parameters: CHARSET=us-ascii
FORMAT=flowed

Open with: TextEdit

Figure 107 A typical ‘"MIME Part’ dialog that shows detailed
information about a particular MIME part

5.8.4.4 Viewing Attachments

One or more parts can be viewed in another application by selecting them and either
double-clicking them, or selecting View Parts from the Message menu (see page 305).
When an attachment is viewed, Mulberry saves it to a temporary directory on disk, and
then launches the appropriate application to view it, and passes the temporary file to that
application for display. When you quit Mulberry, the temporary files are removed from
the disk provided they are not still in use in the viewer application.

5.8.4.5 Saving MIME Attachments to Disk

One or more parts can be saved to disk by selecting them and either double-clicking them,
dragging them to the Finder, or selecting Extract Parts from the Message menu (see
page 305). When a part has been saved to disk a ' mark appears next to it in the second

column of the list. If you drag a multipart item to disk then all the enclosed parts are
downloaded one after another.

Mac OS X  If you receive a multipart/appledouble part then you should download the
ONLY multipart item rather than the individual sub-parts because the whole
multipart actually corresponds to a single Mac OS X file.
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You can choose how Mulberry behaves when it downloads a part to disk by choosing the
appropriate option in the ‘Save to Disk’ section of the “Attachment’ preferences panel. You
can choose to have Mulberry give you the choice of where to download a part to (when

double-clicking or using Extract Parts from the Message menu) or automatically
download the part to a pre-chosen destination folder.

You can also choose how Mulberry behaves after a part is downloaded to disk. This is
controlled by the choices in the ‘Open after Save’ section in the ‘Attachment’ preference
panel. Mulberry can be set to either automatically open the downloaded part in its
appropriate application, to ask you whether to open the part, or to never open the part. In
addition, it is possible to override this for parts that can be displayed in Mulberry (i.e. text
parts). This allows you to choose not to open parts that you have already seen if all you
want to do is save them for later perusal.

Note You can resize the parts list by clicking and dragging on the
split-pane divider lines between the parts list and the text display
area. When the cursor is over the split-pane divider it changes

shape to ==

5.8.5 Text Display

This displays the text of the currently selected MIME part in the message. Mulberry will
show the first item in the MIME parts list that it is capable of displaying when opening a
new message window. If there are no parts that can be displayed in the text area then this
is left blank. The message’s email header may appear at the top of the text area depending
on whether the header button (see page 209) is on or off.

Note You can use the spacebar to navigate through messages.
When you press the spacebar Mulberry will scroll down the
current text display area one page at a time. When it reaches the
end of the scrollable area it will move on to the next message in
the mailbox list. If you hold down the Option (Mac OS X) or Alt
(Windows) key while using the spacebar, the message being read
will be marked as deleted before the next message is displayed.

5.8.5.1 Working with Styled Text

Mulberry is able to display a number of different formats of styled text. Styled text is text
which has different type-face characteristics, for example a different font or size, or use of
bold or italic text. Styled text normally requires the use of special ‘tags” embedded within
the text itself that are used to mark the start and end of “style runs’. These tags are
interpreted by the application viewing the text and used to created the styled text display.
Mulberry is able to interpret ‘enriched” and “HTML’ styled text. When you receive a MIME
message with text in one of these formats, Mulberry determines what type it is and
displays it accordingly. You can choose to change how Mulberry displays the text by using
the formatting pop-up menu, shown in Figure 108, in the message parts header area (see
page 209).
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* Formatted
Plain Text
Source

as HTML
as Enriched
Fixed Font

Raw Message

Figure 108 The formatting pop-up menu

* ‘Formatted’ — the text is displayed using the styles determined from the tags and
appropriate for the type of styled text being viewed.

e ‘Plain Text - the text is displayed without styles, but with the styled text tags removed.
e ‘Source’ - the text is displayed without styles, with styled tags showing.

e ‘as HTML' - the text is displayed as HTML.

* ‘as Enriched’ - the text is displayed as Enriched text.

* ‘Fixed Font’ — the text is displayed using a fixed-width font.

* ‘Raw Message’ — the entire message body is displayed in its raw MIME encoded format
without any formatting or styling.

For all text types, when ‘Formatted’ text is being displayed, URLs are highlighted using the
style set in the ‘Styles’ tab of the ‘Display’ preference panel (see page 60). When the cursor
is over a URL it changes to a hand icon and you can click on the URL to launch it. Mulberry
only highlights URLs that have a scheme that matches an entry in the “‘Recognize URL
Schemes’ area in the ‘Styles’ tab of the ‘Display’ preferences panel (see page 60). URLs are
not highlighted when viewing ‘Plain’ or ‘Raw Text'.

Mac'OS X Note URLs can only be launched if a suitable ‘Helper’
application is set-up in Internet control panel/settings.

WiNDOWS Note URLs can only be launched if a suitable ‘Helper’
application is available in the Windows Registry.

UNIX

Note URLs can only be launched if a suitable ‘Helper’
application is available in the url.helpers file as described in
the online FAQ:

<http:/ /www.mulberrymail.com/mulberry /unix/fag>.

When the message header is displayed, Mulberry will change the text style of the message
header fields to that specified using the style set in the ‘Styles’ tab of the ‘Display’
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preferences panel (see page 60). When ‘Formatted’ text is being displayed, any URLs in the
message headers will also be styled according to the URL style as described above.

When viewing ‘Source’, Mulberry will change the text style of any formatting tags to that
specified using the style set in the ‘Styles’ tab of the ‘Display’ preferences panel (see page

60).

5.8.5.2 Text alternatives

Sometimes you may receive messages with ‘alternative’ text parts. These usually consist of
a plain text part followed by a styled text part, and are sent to ensure that all email
programs are able to see the text of the message correctly. Since some email programs are
not able to display styled text, they will display the first plain text part to the user. Other
email programs, including Mulberry, that are able to display styled text will choose to
show the second, styled text, part to the user. You can control this behavior in Mulberry by
using the ‘Show Styled” option in the ‘Message’ preferences (see page 69). When turned on,
Mulberry will pick the best styled part in a text alternative message to display. When
turned off, Mulberry will always display the plain text part in an alternative.

5.8.6 Working with Messages

5.8.6.1 Deleting a Message

A message can be deleted by clicking the Delete toolbar button. What you can do with a
deleted message is controlled by two preferences:

Preference
(Message/Options panel)

On

Off

Allow Deleted Messages
to be Opened

A deleted message can be
opened, or otherwise
operated upon in a mailbox
pane. Actions on a message
when it is deleted will
depend on the ‘Close
Message when Deleted’
option.

A deleted message cannot be
opened, or otherwise
operated on in a mailbox
pane. When a message is
deleted, it is removed from
any message preview pane
in which it is displayed, or
any message window which
it is displayed in is closed.

Close Message When
Deleted

When a message is deleted,
it is removed from any
message preview pane in
which it is displayed, or any
message window which it is
displayed in is closed.

Actions on a message when
it is deleted will depend on
the ‘Allow Deleted Messages
to be Opened’ option.

Note If the message comes from a mailbox with read-only
permission you will not be able to delete it and the Delete toolbar
button will not be active.
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Note If the message is a MIME sub-message part within another
message you will not be able to delete it and the Delete toolbar
button will not be active.

5.8.6.2 Replying to Messages

There are two ways to use the Reply toolbar button which depend on whether the Option
(Mac OS X), Alt (Windows) or Control (Unix) key is held down when clicking the button.
The choice of action is determined by the ‘Message’ preference panel setting (see page 69).
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In one case a new draft message window (see page 224) is automatically created in
reply to the current message. The draft message has its “To:” address field filled in with
the ‘Reply-To:" address of the message being replied to. Any other addresses in the
original message are ignored.

In the second case Mulberry will display a dialog (shown in Figure 109) which allows
you to choose which addresses from the original message are to be used in the reply
and where they should appear in the reply. The dialog lists all the addresses in the
original message (it does not display duplicate addresses) and indicates in what field the
addresses were originally in. You can then choose where to put each address in the
reply message by clicking on or off one of the diamond buttons next to the address.
Once the required choice is made click the Create Reply button or press return to
create a new draft message with the requested addresses automatically filled in. The
‘quick select’ buttons immediately below the address list allow typical choices for
different types of replies to be automatically selected by Mulberry, or in the case of the
‘None’” button removes any choice. Use of the Create Reply button will create a draft
in response to the original, and the subject of that reply will have an ‘Re:’ prefix, and the
original message will be quoted using the Quote options specified in the dialog..
Instead, if you use the Create New button, a new draft addressed to the chosen
recipients will be created, with an empty subject and no quoting of the original.
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Reply To

Select Addresses to be used in the Reply:

To Cc Beo Address Originalky
p sp <p Vince Everett <wince®@cyrusoft.come Reply-to
o o vince®Eimap.cyrusoft.com Sender
& ¢ ¢ friend@domain.uk To

& % < somebody@domain.uk Cc

select: © Reply ) (Reply ALY © From 3 [ Sender Y (7 None

Cuate:
E“ Selection : Entire Message : Mothing

.___' Cancel '___. .___' Create New '___. f Create Reply 3

Figure 109 A typical ‘Reply To" dialog used for filling in addresses for a
message in reply to another

Note The default “‘Reply To’ action can be toggled at your option.
The default is to have the dialog appear only when the Option
(Mac OS X), Alt (Windows) or Control (Unix) key is down. To
change this click the appropriate radio button in the ‘Allow
Choice of who to Reply to when’ group in the “‘Message’
preferences panel (see page 69).

5.8.6.3 Quoting Message Text in a Reply

When replying to the message, if you want to have any part of the message text
automatically displayed as a quotation in the reply, select the required text before clicking

the Reply button or using one of the reply commands from the Message menu.
Alternatively, if the ‘Quote Whole Message if no Selection” option is turned on in the
‘Message’ preferences panel (see page 69), the whole of the text on display in the text area
will be quoted in the reply if no selection already exists. If this option is off, no text will be
quoted unless there is an existing selection.
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5.8.6.4 Bouncing, Forwarding and Sending Again

Mulberry gives you three additional ways to ‘reply’ to messages:

‘Redirect’ - allows you to pass the message on to someone else and have it appear as
though it originated from the original sender of the message. This allows the recipient
to reply direct to the original sender.

‘Forward’ - allows you to pass the message on to someone else (who may not be in the
original list of recipients or may not be the original sender). There are various options
related to forwarding that can be configured via the preferences dialog or through a
dialog that appears when forwarding the message.

‘Send Again’ - allows you to resend any messages which were originally sent by you.
This option is only available when Mulberry recognizes the message as having been
sent by you.

5.8.6.5 Forwarding Options

There are two ways to use the Forward button which depend on whether the Option (Mac
OS X), Alt (Windows) or Control (Unix) key is held down when clicking the button. The
choice of action is determined by the “Message’ preference panel setting (see page 69).
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In one case a new draft message window (see page 224) is automatically created to
forward the current message. The draft message has the original message quoted or
attached determined by the setting of the ‘Message’ preference panel setting (see page
69).

In the second case Mulberry will display a dialog (shown in Figure 110) which allows
you to select the forwarding options.

Quote Original When this is selected the text from the original
message is quoted in the forwarded message.

Include Headers in Quote When this is selected, the headers of the
original message are also included in the
forwarded message.

Forward as attachment When this is selected, Mulberry will always
attach the original message to the forwarded
message, even if it only contains text which is
also quoted.

Use Embedded Message When this is selected, Mulberry will attach the
original message as a message / rfc822 part in
the forwarded message. When this is not
selected, the parts of the original message are
attached to the forwarded message ‘in-line’.

Save Options and Skip When this is selected, the options used in the
Dialog in Future dialog will be saved as the default for future
forward operations. The Preferences will be
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changed accordingly, and to ensure the dialog
does not appear next time. To have the dialog
appear again, turn on the Allow Choice of
Forward Options item in the General tab panel
of the Message preferences (see Section 4.6.1).

Forward Message

Forward Options:

E Quote Original
_llnclude Headers in Quote

E Forward as Attachment
™ Use Embedded Message

Cuote:
) Selection ) Entire Message ) Nothing

| Save Options and Skip Dialog in Future

(" Cancel ) { Forward }

Figure 110 The Forward dialog used to set options when forwarding a
message.

Note The default “Forward” action can be toggled at your option.
The default is to have the dialog appear only when the Option
(Mac OS X), Alt (Windows) or Control (Unix) key is down. To
change this click the appropriate radio button in the ‘Allow
Choice of who to Forward Options’ group in the ‘Message’
preferences panel (see page 69).

5.8.6.6 Moving or Copying the Message to Another Mailbox

The message on display can be moved or copied to another mailbox. There are two
different ways to specify the mailbox to copy to. You can choose a mailbox directly from

the Move to/Copy to Mailbox item in the Message menu. Selecting a mailbox from
this menu will immediately carry out the move/copy operation.
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Alternatively you can select a mailbox from the Move to/Copy to toolbar button by
clicking on the left-side to bring up a popup menu. Upon selecting a mailbox from there,
the move/ copy operation is carried out. If you click on the right-side of the Move
to/Copy to toolbar button, the message is moved/copied to the last mailbox chosen via

the popup..

5.8.7 Reference
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OPERATIONS ON MESSAGE WINDOWS

To save the current message
display text

Choose Save from the File

menu or press Command-S
(Mac OS X), Ctrl-S (Windows),

or Meta-S (Unix).

To print the current message
display text

Choose Print from the File

menu or press Command-P
(Mac OS X), Ctrl-P (Windows),

or Meta-P (Unix).

To show the previous
message in the mailbox in the
current window

Click the Read Previous button

Choose Read Previous from
the Message menu or press
Command- [ (Mac OS X), Alt-[
(Windows), or Meta-[ (Unix).

To show the next message in
the mailbox in the current
window

Click the Read Next button

Choose Read Next from the
Message menu or press
Command-] (Mac OS X) Alt-]
(Windows), or Meta-] (Unix).

To delete the current message
and then show the next
message in the mailbox in the
current window

Click the Delete and Read
Next button

Choose Delete & Read Next
from the Message menu or
press Command-/ (Mac OS X),

Alt-/ (Windows), or Meta-/
(Unix).
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To delete the current message

Click the Delete button in the
message window

Choose Delete from the
Message menu or press
Command-D (Mac OS X) or

Ctrl-D (Windows), or Meta-D
(Unix).

Delete the message in its
mailbox window.

To undelete the current
message

Click the Undelete button.

Choose Undelete from the
Message menu or press
Command-D (Mac OS X) or

Ctrl-D (Windows), or Meta-D
(Unix).

To show the message’s email
header

Click the header button in the
message window.

Choose Show Header from
the Message menu or press

Option-Command-H (Mac OS
X), Alt-Ctrl-H (Windows),

CtriI-Meta-H (Unix).

To hide the message’s email
header

Click the header button in the
message window.

Choose Hide Header from the
Message menu or press

Option-Command-H (Mac OS
X), Ait-Ctrl-H (Windows) or

CtrI-Meta-H (Unix).

To reply to the message’s
‘Reply-To:” address
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Click the Reply button in the
message window.

Choose Reply from the
Message menu or press
Command-R (Mac OS X),

Ctrl-R (Windows), Meta-R
(Unix).
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To reply to the message’s
‘Sender:” address

Choose Reply to Sender from
the Message menu.

To reply to the message’s
‘From:” address

Choose Reply to From from
the Message menu.

To reply to the all the
addresses in the messages

Choose Reply to All from the
Message menu.

To forward the message to
someone else

Choose Forward from the
Message menu or press
Command-J (Mac OS X), Ctrl-J
(Windows), or Meta-J (Unix).

Click the Forward button in
the message window.

To redirect the message to
someone else

Choose Redirect from the
Message menu.

To send the message again

Choose Send Again from the
Message menu.

(This feature is only available if the
message was originally sent by you)

To move/copy the message to

a different mailbox

Select the mailbox you want to
copy the messages to from the

Move to/Copy to Mailbox

sub-menu in the Message
menu.

To change any of the flags for

the message

Select the flag to toggle from the
Flags sub-menu in the
Message menu.

To save one or more selected

parts in the parts list

Double-click the selected parts.

Drag the selected parts to the
Finder.

(This feature is only available if Drag
and Drop is supported)

Choose Extract Parts from the
Message menu or press
Command-; (Mac OS X), Alt-;
(Windows), or Meta-; (Unix).
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To see more detailed
information about a selected
part

Choose Details... from the Edit

menu or press Command-I
(Mac OS X), Ctrl-l (Windows), or

Meta-I (Unix).

To decode BinHex embedded
in the message text

Choose BinHex from the
Decode Embedded sub-menu
in the Message menu.

To decode UU embedded in
the message text

Choose UU from the Decode
Embedded sub-menu in the
Message menu.
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5.9 Draft Window

. gl
&S O6 Re: Mulberry is Great!

., T 'ILT' o ||
ZER=E & & B A B
Draft Save Attach Spelling Add Cc Add Bee Sign Encrypt Send

> To friend®@domain.uk

Subject:  Re: Mulberry is Great!

p Attached: Copy to: | imap:INBOX.sent-mail s ]

Hi Vince,
--0n August &, 1998 3:81:43 PM -8488 <vinceBcyrusoft.com= wrote:

Just to let vou know that I think Mulberry is great!

yvirus Daboo

Figure 111 A typical draft message window with the header area in
expanded state

Figure 111 shows a typical draft message window. Draft message windows display the
contents of messages which you are in the process of writing prior to sending (the window
title is the name of the file if the draft message was originally opened from disk).

You can set the default size and location for new draft windows by sizing and positioning a
draft message window to your tastes and then choosing Save Default Window from the
Window menu (see page 311).

Draft message windows are divided into four main sections:
* The toolbar.
* The draft header section can appear expanded or collapsed:

e Expanded: shows the addresses and subject for the new message. It also contains
buttons and a menu listing all available mailboxes for saving a copy of the message
when sent (as illustrated in Figure 111).

e Collapsed: shows a summary of the list of recipients (as illustrated in Figure 112).

* The draft parts section contains a hierarchical list of MIME parts that represents the
structure of the message being sent.

* The message text display section is where you can type text for any text parts you wish
to send in the message.
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These sections are now described in more detail.

5.9.1 Toolbar Buttons

The draft window toolbar contains the following items:

74

Create a new draft window to allow you to compose a new message.

Save the draft to a mailbox or to a file.

Attach files to be sent with the draft.

Draft
Save
&ttach

1Az

Spell check the text shown in the text display section.

Lpelling
O Adds a Cc: address field for including additional recipients.
v
Add Cc
: b Adds a Bec: address field for blind-copying additional recipients.
Add Bce
Digitally sign the message when it is sent. This button is only
@ available if PGP or S/MIME security plugins are installed.
Sign
= Digitally encrypt the message when it is sent. This button is only
fj available if PGP or S/MIME security plugins are installed.
Encrypt
UNIX ONLY UNIX ONLY
€ Edit the current message text in an external text editor.
Eciit
5,—: Send the message.
L
»end
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5.9.2 Header

: ]
e 06 Re: Mulberry is Great!
; =] &L ) J @ A i
74 = ? (e ué_g; = Laal,
Draft Save Attach Spelling Add Cc Add Bec Sign Encrypt Send

Racipients: friend@domain.uk

p Attached: [ Copy to: | imap:IMNBOX.sent-mail o ]

Hi ¥ince,
--0n August &, 1998 8:81:43 PM -8488 <vincefcyrusoft.com= wrote:

Just to let you know that I think Mulberry is great!

Cvrus Daboo

Figure 112 The draft window showing the header area in collapsed
state.

In its expanded state, the window header has three address fields which can be used to
enter the email addresses to which you want to send this message (T0), or to which you
want a copy to be sent (Cc), or to which you want a copy to be sent without revealing
their email address (Bcc). Use of these fields is described in more detail in the next section.
By default the Cc and Bcee fields are hidden. The Add Cc and Add Bcc toolbar buttons

and equivalent Draft menu commands will turn on the display of the corresponding
addpress field. If you want either the Cc or Bec address fields to appear by default in a
draft window, you can change the options in the Outgoing Preferences panel (see
Section 4.7.1 for more details).

The subject of the message should be entered in the Subject field. If this message was
generated as a reply to an existing message, Mulberry will insert ‘Re: ” followed by the
subject from the original message into the subject field (‘Re: ” is not prepended if it is
already there). Similarly, if the message is being forwarded, Mulberry modifies the original
message’s subject and inserts that into the Subject field. The new subject is determined by
the ‘Forward Subject’ setting in the Outgoing Preferences panel (see Section 4.7.1 for more
details);

5.9.2.1 Address fields

Each of these fields can be collapsed to display a single line of text, or expanded to display a
scrolling list of text.

Single addresses can just be typed straight into a collapsed field.
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For multiple addresses, separate the addresses by a comma or put each one on a new line.
You can type legitimate email addresses in a number of different ways:

Example Address Description
mulberry@dial.pipex.com Standard email address format
<mulberry@dial.pipex.com> Standard email address format

“Mulberry Owner” <mulberry@dial.pipex.com> FEmail address with name

mulberry@dial.pipex.com (Mulberry Owner) Email address with comment

<mulberry@dial.pipex.com> (Mulberry Owner) Email address with comment

As you type in addresses, Mulberry attempts to determine whether what you typed was a
complete address or a “partial” address. In the case of a partial address a number of things
might happen when you type Return or move the cursor outside of the address field:

5.9.2.1.1 Nickname Resolution

Address or group entries in address books can contain nick-names (see page 236 for more
about Address Books). Just type the name of the nick-name or group name in place of an
email address. Mulberry will attempt to resolve the nick-name by searching each address
book marked for nick-name resolution (see section 5.10.2 for more details). The first
matching nick-name (if one exists) will then be substituted for the partial address in the
address field.

5.9.2.1.2 Address Expansion

When doing address expansion, Mulberry searches the text in various address fields in an
address book (as specified in the ‘Expansion Tab’ of the “Addresses’ preferences panel — see
page 92) for a match to the partial address. The search is done on each address book
marked for searching (see section 5.10.2 for more details). If there is a single match it will
be substituted in place of the partial address in the address field. If there is more than one
matching address, then Mulberry will display all matches in a dialog box list allowing you
to choose one or more addresses to substitute for the partial address.

5.9.2.1.3 Default Domain

If Mulberry cannot resolve a partial address as a nick-name, or via expansion, it assumes
that the text typed is an ‘unqualified” address. It will then append the “Default Domain for
Outgoing Email’ value, set in the ‘Outgoing’ preferences panel (see page 76), to the typed
text and take that to be the email address. If the ‘Default Domain for Outgoing Email” value
is empty, an error will occur when you attempt to send the message because the typed text
cannot be recognized as a valid email address.
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5.9.2.2 Saving Copies of Sent Messages

If you want to have the draft message copied to a mailbox in the server list after it is
successfully sent, select the required mailbox from the ‘Copy To” pop-up menu.
Alternatively select ‘None’ at the top of the ‘Copy To” pop-up menu.

You can also copy the draft message to any mailbox before sending it by selecting a
mailbox from the ‘Copy To’ pop-up menu and choosing Append Now from the Draft
menu. Alternatively, choose a mailbox from the Append to Mailbox sub-menu.

Note When creating a new draft message, Mulberry will
automatically select the default ‘Copy To” mailbox specified in the
‘Draft’ preferences (see page 76). Also, if ‘Remember Chosen
Copy Mailbox’ is on in the ‘Draft’ preferences then any change to
the ‘Copy To” mailbox in a draft message window is remembered
and the modified value used the next time a draft message
window is created.

If the draft message is in reply to another (or is being forwarded or bounced) then you can
also choose to have Mulberry copy the original message to the ‘Copy To’” mailbox before it

copies the reply by turning on the Also Copy Original Message item in the Draft
menu. This allows you to file messages, relating to the same subject, together in a mailbox
in the correct order (i.e. original before reply).

5.9.2.3 Spell Checking Text

The Spelling button can be used to spell check the text in the draft body area.

5.9.2.4 Sending a Message

The Send button can be used to send the draft message.

After sending a message, an icon appears in the bottom right of the header area to indicate
successful completion (see Figure 113). This will not appear if the message could not be
sent. Since a network related error can occur either while sending the message or while
copying it to a mailbox (if that option is chosen), the icon can be used to confirm that the
message was sent correctly and that the problem arose after sending it (i.e. while copying
to a mailbox). Mulberry automatically closes a draft message window only after
successfully sending the message and copying it to a mailbox (if that option is chosen). This
could mean that the window may disappear before the successful send icon can be seen,
but the message has been sent successfully in this case.

e

a8
e

Figure 113 The symbol used to indicate that sending the draft message
was successful
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5.9.2.5 Attaching Files

The Attach button works together with the parts list and is described in the next section.

5.9.2.6 Using Identities

The From popup can be used to choose the identity used when sending a draft message.
An identity provides a way to set information such as the return address or signature used
with a draft. For more information on the contents of an identity and how to create and
edit them see page 85. When you switch identities using the From popup, or edit the
existing identity set in the popup, Mulberry automatically changes information in the draft
window to reflect the new identity chosen, or the changes made to the currently selected
identity. This includes change any signature, changing the Copy To popup menu setting,
and various other items.

5.9.2.6.1 Tied ldentities

When creating a draft message, Mulberry determines which identity to use based on a set
of rules that use “tied identities’ to determine what to do. An identity can be “tied’ to a
mailbox (see page 144) or a email account (see page 39) such that use of that mailbox or
account will trigger the use of the ‘tied” identity when creating drafts with that mailbox or
account ‘active’. To determine the correct tied identity Mulberry uses the following rules:

‘Choose Identity from Mulberry determines the identity by looking at the original
Original Message” option | messages being replied to or forwarded.

is on in the Identity
Preferences panel (see
section 4.9 for details).

If any To address in the original messages matches the From
address in any identity (searched in the order they appear in
the preferences), then that identity is used in the draft.

If no To addresses match an identity, Mulberry will then try to
match any Cc addresses against identities and will use the first
matching identity found in the preferences.

If no identity match is found, or the preference is off, Mulberry
will use one of the subsequent listed rules to determine the
identity to use.

Server window active, Use the tied identity for the account of the selected server, if it
server row selected exists
or
Use the default identity
Server window active, Use the tied identity for the mailbox, if it exists

mailbox selected
or

Use the tied identity for the mailbox’s account, if it exists
or
Use the default identity
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Mailbox window active

Use the tied identity for the mailbox, if it exists
or

Use the tied identity for the mailbox’s account, if it exists
or

Use the default identity

Message window active

Use the tied identity for the mailbox containing the message, if
it exists

or

Use the tied identity for the account of the mailbox containing
the message, if it exists

or
Use the default identity

Any other case

Use the default identity

Mulberry will then use the tied identity or the default identity based on another set of rules
outlined in the next sections.

5.9.2.6.2 Tied Identities and new drafts

When creating a new draft using the New Message menu command or by clicking a
Draft button in a server or mailbox window, the following rules apply:

‘Use Tied Identities with
New Drafts’

Option (Mac OS | Identity set when draft is created
X) or Alt
(Windows) Key

Off Not used Default identity

Oft Down Tied identity for the active window
(as determined by rules in
section 5.9.2.6.1).

On Not used Tied identity for the active window
(as determined by rules in
section 5.9.2.6.1).

On Down Default identity
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5.9.2.6.3 Tied Identities when replying, forwarding, bouncing, sending again or creating
a digest

When replying, forwarding, bouncing, sending again or creating a digest of messages,
Mulberry will always use the tied identity appropriate for the selected messages as
determined by the rules of section 5.9.2.6.1.

5.9.3 Sending Attachments: Parts Display

Mulberry allows you to create sophisticated MIME-structured messages for sending. As
well as sending any number of text parts, which it allows you to type in, you can also send
any type of file stored on the local file system, complete messages from any mailbox on the
IMAP server, or individual parts of messages on the IMAP server.

By default, the draft message window is created with a single text part. Additional parts can
be added in a number of ways and the hierarchical structure of the MIME message
changed accordingly. Mulberry also allows you to set details for each part being sent such
as the encoding method, the MIME type details, the name of the part and the description of
the part, which could be useful to the recipients.

¥ Attached: 3 E Copy to: | imap:INBOX. sent-mail ﬂ
Mame Size Content-Type
' Getting Started v 907 K application/msword
v @Ilaw are you? 342 message/rfcBld
=|Unnamed part #3_1 42 text/plain
Figure 114 The expanded hierarchical parts list in a draft message
window

The message parts display section contains a hierarchical list (see Figure 114), similar to the
one in the incoming message window, that displays the full hierarchy of the message being
composed.

e The diamond buttons in the first column have the same meaning as in the message
window parts list (see page 207).

* The second column indicates whether the details of the part can be changed. This
includes being able to change the MIME type and encoding used for the part. In
general, all message parts (be they a complete message or a part from within an
existing message) that belong to messages on the IMAP server are read-only.

* The third column lists the MIME type that will be used when the part is sent.

* The fourth column shows the size of the part. Note that the size of the current text part
is only updated when switching the text display to another part.

 The fifth column shows the name of the part. If the part has no assigned name,
Mulberry will generate a default name for display in the hierarchy list. However, this
name is not used when the message is sent.
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* The final column indicates the type of encoding that will be used to send the part. “Text’
and ‘Automatic’ encodings correspond to the standard MIME encodings. Mulberry will
choose the best MIME encoding to use in this case. Other encodings may be used if the
file requires special processing, for example to ensure that the resource fork of the file is
preserved when sent between Mac OS X users.

5.9.3.1 Editing MIME Information

The type, name and encoding of parts can be modified (if the part can be changed) or
viewed (if the part is read-only) by choosing Details... from the Edit menu.

For read-only attachments, the dialog shown in Figure 107 is displayed with the relevant
information filled in. For parts that can be modified, the dialog shown in Figure 115 is
displayed. This allows you to change the name of the part, the MIME type and subtype, the
encoding and add a description to the part. The name and description are sent with the part
and can be viewed by the recipient if they have a suitable application to view the message
with (Mulberry for instance!). The type and subtype should not generally need to be
changed, as Mulberry will generate defaults for these that should suffice.

To change them, either type a new value into the appropriate field or choose one from the
pop-up menu next to each field. Note that the items in the subtype pop-up menu depend
on the value in the type field.

MIME Part

Mame: Getting Started w4

Type: application

=@

Subtype: octet-stream

Encoding: Automatic ﬂ
Description:
Disposition: Attachment ﬂ
Charset: Automatic ﬂ

( Cancel ) {’ OFK \/'r

Figure 115 The dialog used to edit the details of a MIME part before sending it
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5.9.3.2 Creating MIME Multiparts

You can add new levels of parts hierarchy by choosing a suitable ‘Multipart’ item from the

New Multipart sub-menu in the Draft menu. This will create a new hierarchy level into
which you can place single parts or more multipart hierarchies.

When inserting new parts into the parts list, the new parts will always be added as sub-
parts of any selected hierarchy. Thus to create a hierarchy within a hierarchy, select the top
level hierarchy part in the list and then choose the appropriate menu item. If no
hierarchical part is selected in the list, new parts are added at the top level of the hierarchy.

You can move parts around inside the parts list by dragging them to the desired hierarchy
position.

The next sections describe how you can create and use different types of parts in Mulberry.
5.9.3.3 Manipulating Text Parts

You can create new text parts by choosing an item from the New Text Part sub-menu in

the Draft menu. This will add a new text part of the chosen subtype to the parts hierarchy
list and automatically switch the text display area over to viewing this part.

You can switch the text display area between different text parts by clicking the diamond
buttons in the first column of the parts hierarchy list. These buttons have the same
meaning as those used in incoming message windows (see page 207). The size of the text
part displayed in the parts table is only updated when switching to another part.

5.9.3.4 Attaching Files to a Message

To attach files to draft messages so that they get sent along with any other parts, click the
Attach button, and choose the files you want to send from the resulting file open dialog.
This allows you to choose any number of files to be attached to the draft message. You can
also drag files directly from the desktop into the parts list to have those files sent.

5.9.3.5 Whole Message Parts

You can attach a complete message located on the IMAP server to a draft message. To do
this drag the message out of its mailbox window into the draft message’s parts list. This
will produce a ‘message/rfc822" part which contains the parts hierarchy for the original
message. You can delete parts from the sub-message’s hierarchy but you cannot reorder
them or add other parts.

5.9.3.6 Parts from other Messages

You can attach parts from messages located on the IMAP server to a draft message. This
allows you to send particular parts of messages that have been sent to you on to someone
else. To do this, drag the parts from the parts list of the original message window into the
draft’s parts list.

5.9.4 Text Display

This displays the text of the currently selected draft message part. You can type the text for
the message here. Mulberry allows you to create and edit plain, enriched or HTML text.
When a draft is first opened, Mulberry chooses the text style based on the settings in the
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‘Outgoing’ preferences panel (see page 76). When editing enriched or HTML styled text,
Mulberry places a toolbar at the top of the text area to allow you to easily change the
formatting of selected text, as well as show the current format of the selected text.
Formatting can also be changed by choosing a command from the Draft menu (see
page 308).

5.9.4.1 Text Macros

Mulberry allows you to define a set of ‘shortcuts” for use in the text display area. When you
type a shortcut and then immediately type the macro expansion key combination,
Mulberry will expand the ‘shortcut’ into the text you have defined for it. These “text

macros’ can be set via the Text Macros command in the Edit menu. The keystroke used
to expand the macros can also be set there.

5.9.4.2 Spell as you Type

Mulberry can be set to spell check text as you type it into the text display area. Misspelled
words are always given a red wavy underline style and the background color changed to

that specified in the Spelling Options set via the Edit menu.

To correct a misspelled word:

Mac OS X To correct a misspelled word, click the mouse button with the control key
down (Ctrl-click) on the highlighted word and choose a word to replace it
with from the resulting popup menu, or choose Add to Dictionary to save

the word.
WiNDOWS To correct a misspelled word, click the right mouse button on the
UNIx highlighted word and choose a word to replace it with from the resulting

popup menu, or choose Add to Dictionary to save the word.

5.9.5 Reference
OPERATIONS ON DRAFT MESSAGE WINDOWS

To save a draft message Choose Save from the File

menu or press Command-S
(Mac OS X), Ctrl-S (Windows),

or Meta-S (Unix).

To save a draft message using Choose Save As... from the
a different name to the one

previously used

To create additional text parts  Choose New Text Part from
the Draft menu.

File menu.

To create multiparts Choose the appropriate item
from the New Multipart sub-
menu in the Draft menu.
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To attach files to a draft
message

Click the Attach button and add
the files you want to attach.

Drag a file from the Finder into
the expanded parts list.

Drag a file from a parts list in
another draft message window
into the parts list of this draft
message window.

To attach a message from a
server mailbox to a draft
message

Drag the message from its
mailbox window into the parts
list.

To attach one or more parts
from a message in a server
mailbox to a draft message

Drag the parts from the original
message window into the parts
list.

To remove attachments from
a draft message

Select the attachments in the
parts list and press delete.

To include the text of the
message being replied to,
forwarded or bounced

Choose Quote Original

Message from the Draft
menu.

To include text as a quotation
in the draft message

Copy the text to the clipboard
and choose Paste as

Quotation from the Edit menu
or press Command-’ (Mac OS

X), Alt-’ (Windows) or Meta-’
(Unix).

To send the message

Click the Send button.

Choose Send from the Draft
menu or press Command-M
(Mac OS X), Ctrl-M (Windows),

or Meta-M (Unix).
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5.10 Address Book Manager Pane/Window

The address book manager pane/window displays is used to organize local and remote
address books.

5.10.1 Address Book Manager Pane

The address book manager pane, an example of which is shown in Figure 116, is divided
into two main sections:

. Email | Contacts | Calendar - T

L—]E]E”Hame

v (@) Mac Address Book
@@ i) Mac 05 X

v (@) Address Books
o E_) Import

¥ \.Jimsp
G WY ) vince
o W E_) daboo
o W £ daboo.public
Qo W £ daboo.upper

Figure 116 The Address Book Manager pane.

* The items in the Column Header section indicate what type of address book
information is displayed in the corresponding column in the Address Book List section.

* The Address Book List section displays lists of address books.
5.10.1.1 Address Book Window Toolbar Buttons

The address book manager window has a toolbar associated with it, whereas the address
book manager pane in the 3-pane window uses the toolbar in the 3-pane window.
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The address book manager window toolbar contains the following items:

Creates a new address book.

e

Waw

Opens the address book selected in the address book manager pane.

=

Open

Deletes the address books selected in the address book manager
pane.

Delete

Allows searching for addresses in address books.

Search

Shows details about the address books selected in the address book
manager pane, or the address book shown in the address book pane.

E..

Details

Table 7 The Address Book Manager Window Toolbar

5.10.1.2 Column Headers

The column headers indicate what address book information is displayed in each column in
the list below it. The column indicates with text or an icon what the information is:

e ‘Name’ The name of the address book or remote server account.

i) Shows a “‘diamond’ button that can be clicked on or off to have address books
opened on startup.

e 2] Shows a‘diamond’ button that can be clicked on or off to have address books used
for nick-name resolution.

e |2 Shows a‘diamond’ button that can be clicked on or off to have address books used
for searching (see page 244) or address expansion (see page 227).

Mac OS X Hold down the control key and click the mouse button (ctrl-click) on a
column header to change the column type, insert a new column, or delete

the column.
WINDOWS To change a category, or to insert a new category, or to delete an existing
UNIx category click the right mouse button on the category title.

When you do this the menu shown in Figure 117 will appear giving you the choice of what
category to show in the corresponding column. You can also insert a new column before
or after the one clicked, or delete the column that was clicked.
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Open at Start
Resolve Nick-Name
v Allow Searching

Insert Column after
Insert Column before
Delete Column

Figure 117 The pop-up menu used to change column information in the
address book manager window

Note The ‘Name’ column which shows the name of the address
book or address server is always present and cannot be changed
or deleted. You can insert columns before or after it though.

5.10.1.3 Address Book List

The address book manager list shows address books within a hierarchy that represents the
local or remote ‘account’ that handles the address books. The first account is always
‘Address Books’ and represents the local storage of address books on the computer on
which Mulberry is currently running. Subsequent accounts are remote address book
accounts setup in the “‘Accounts’ preference panel (see page 91). Different icons are used to
represent the different types of items displayed in each row:

v/ A remote address book server account.

e A remote address book server account that is available for use in disconnected
mode. This icon is only shown when in disconnected mode.

A Local address book account.
A remote or local address book that can be opened.

A remote address book that has been synchronized for use in disconnected mode.
This icon is only shown when in disconnected mode.

€ @ 0&

A remote address book whose contents are only available while in connected
mode. This icon is only shown when in disconnected mode.

5.10.2 Getting Information on Address Books

Information about address books can be displayed by selecting the address book and then
choosing Details... from the Edit, or clicking the Details toolbar button. This will display
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the dialog shown in Figure 118 which will have two different panels displaying different
information about the address book:

e ‘General’

e “Access’

Address Book: vince

Ceneral

- ©
MName: vince

,EE, Access

Rerver: imsp.cyrusoft.com

Addresses:
Total: 8
Single: 4
Group: 4

| Open on Startup

E Use for Mick-names

E Use for Searching and Expansion
2 synchronise on Disconnect

Figure 118 The Address Book Details dialog showing the ‘General” panel
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5.10.2.1 Address Book Details: General

General

Mame: wince l'*--.--’J

Lerver: imsp.cyrusoft.com

Addresses:
Total: 8
Single: 4
Group: 4

" | Open on Startup
E Use for Nick-names
E Use far Searching and Expansion

"] Synchronise on Disconnect

Figure 119 The Address Book Details ‘General” panel

The items in this panel are:

 ‘Name’ The name of the local address book or full pathname of the remote address
book.

e ‘Server’ The internet address of the server on which this address book is located.

* ‘Addresses’ These items will only be available if the address book is open. This will
always be the case for local address books, but not necessarily for remote address

books which may be listed in the address book manager but may not be open in
Mulberry.

— ‘Total’ The total number of addresses and groups in the address book.
- ‘Single’ The number of single addresses in the address book.
— ‘Groups  The number of groups in the address book.

* ‘Open on Startup’ If turned on, the address book will be opened whenever the
current preference set is opened, including when Mulberry next starts up.

* ‘Use for Nick-names’ If turned on, the address book will be used for nick-name
resolution when typing addresses into an address field in a draft window. If the address
book is local, it must also be open in Mulberry for nick-name resolution to take place. If
it is a remote address book, Mulberry must be logged in to the server, but the address
book need not be open in Mulberry as nick-name resolution can be done remotely.

* ‘Use for Searching and Expansion’  If turned on, the address book will be used for
searching when searching address books (see page 244), or for address expansion (see
page 227).
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* ‘Synchronize on Disconnect’ If turned on, the address book will be synchronized
when disconnecting from the network, provided that address book synchronization
has been requested in the disconnect dialog (see section 5.4.6).

e Address book state icon:

An address book on a remote server.

An address book on a remote server that is available
for use in disconnected mode. This icon is only
shown when in disconnected mode.

L;.J An address book on the local machine.
=
©

5.10.2.2 Address Book Details: Access

Access Control List

Key
User ID L[,k_éﬁ,?l:',_',:luﬂ_r § Lookup
Currant Usear: Y Y BT T AV

() Raad
vince LU J Wirite
daboo ooy e G e G

LA Create

£ Delete

t-;l‘_-r Admin

Add User... x Remowve User 5'[]-'|Ef

Figure 120 The Address Book Details ‘Access’ panel

The “Access’ panel displays information about the access control list for the address book.
This is the list of users who have ‘rights’ to the address book. For address books, there are
a total of six rights or privileges that can be applied to each user. These are:

* & ‘Lookup’ - if set, the user is able to see the address book if they attempt to list it.

e & ‘Read’-if set, the user is able to see addresses or groups in the address book.
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& 'Write’ - if set, the user can change any address or group in the address book, but
not delete them.

e L7 ‘Create - if set, the user can create sub-hierarchies of address books below the
current address book.

e o ‘Delete’ - if set, the user can delete addresses or groups from the address book.

* & ‘Admin’ -if set, the user is able to change the access control list for the address
book.

The rights that you have to the address book are shown in the “Current User:” row at the
top of the access control list table. All users’ rights are then shown in the table below this.
Each row consists of a user id, followed by six icons or buttons representing the state of the
right for that user. This table behaves in exactly the same way as the one used to set the
access control for mailboxes (see page 146).

5.10.3 Reference
OPERATIONS ON ADDRESS BOOKS

242

To view the Address Book
Manager pane in the 3-pane
window

Choose Contacts from the 3-
pane window tabs.

To bring the Address Book
Manager window to the front

Choose Address Book

Manager from the Address
menu.

To create a new address book

Choose New Address Book...

from the Address menu after
selecting an address server, or
click the New button.

To open one or more selected
remote address books

Press return or enter on the
keyboard, or click the Open
button.

Double-click any one of the
selected address books.

To open an address book

Choose Open Address Book...

from the Address menu, or
click the Open button

To rename one or more
selected address books

Choose Rename Address

Book... from the Address
menu.

To import addresses from a
different type of address book
into the selected address book

Choose Import Addresses...
from the Address menu.
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To export addresses in the
selected address book to a
different type of address book

Choose Export Addresses...
from the Address menu.

To delete one or more selected
address books

Choose Delete Address

Book... from the Address
menu, or click the Delete
button.

To login to the selected
remote address book server

Choose Login... from Address
menu.

Double-click the remote address
book server.

To logout from the selected
address book server

Choose Logout from the
Address menu.

To see information about the
selected address book

Choose Details from the Edit
men, press Command-I (Mac
OS X), Ctrl-l (Windows), or

Meta-I (Unix). or click the
Details button.

To search for addresses in
address books marked for
searching

Choose Search... from the

Address menu or click the
Search button.
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5.11 Address Search Window

&S O6 Address Search
Find Items using LDAP F$ server @ whose
 Email Address | :] " Contains | :] isamet

8 || & é

Searchk  Clear Draft
|FuII Name |Err|ail Address |
v EJ Email Address = vince

H Vince Everrett vince®@oyrusoft.com
¥ 2 Email Address = isamet

H Cyrus Daboo daboo®@isamet.com

H John Degory jdegory@isamet.com

H Mariss Mednis mmednis@isamet.com

H Qi He gihe@izamet.com

4
Figure 121 The Address Search window used to search for addresses in

local and remote address books, or using directory services

Figure 121 shows the Address Search window. This is used to perform searches for

addresses either in local or remote Mulberry address books, or using a directory lookup
protocol.

The Address Search window is divided into four main sections:
* The Criteria section is used to specify the criteria for the search operation.
¢ The Button section allows has various buttons for common actions.

* The Column Headers section indicates which information about an address is displayed
in the corresponding column in the list below.

* The Results section displays a list of search results.
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5.11.1 Criteria

The address criteria section allows the search criteria to be specified. It consists of three
pop-up menus and one text field:

* The ‘method’ pop-up menu (shown in Figure 122) allows you to choose between the
various types of address accounts available for searching:

- ‘in Address Books’ will search those Mulberry address books that have the “Use for
Searching’ option turned on (see page 240).

- ‘using LDAP’ will use any LDAP directory accounts selected in the ‘Server choice’
popup menu.

in Address Books
= ysing LDAP

Figure 122 The method pop-up menu used to select the method to use for
the address search

e The ‘server choice’ pop-up menu (shown in Figure 121) only appears when LDAP has
been chosen as the search method. The pop-up allows each individual LDAP server to
be searched in turn if desired.

 The ‘field’ pop-up menu (shown in Figure 123) allows you to choose which address field
to search. These are the fields available in a Mulberry address book (see page 250).

Full Mame
Mick-Mame

*  Email Address
Company
Address
Phone Work
Phone Home
Fax
LELs
Notes

Figure 123 The field pop-up menu used to select which field to search on

when doing an address search

e The ‘match’ pop-up menu (shown in ) allows you to choose which part of the address
field you want to look for text in:

- ‘Is’ will attempt to find addresses with fields exactly matching the search text.
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- ‘Starts with” will attempt to find addresses with fields which have the search text at
the start.

- ‘Ends with” will attempt to find addresses with fields which have the search text at
the end.

- ‘Contains’ will attempt to find addresses with fields which have the search text
contained anywhere within it.

s

starts with

Ends with
* Contains

Figure 124 The match pop-up menu is used to select which part of the
address text to compare with the search text

The text field allows you to enter the text to search for. Pressing return or enter on
the keyboard will initiate the search. You can use a “*’ as a wildcard character to match
one or more occurrences of any character. e.g. ‘cyru® will match ‘cyrus’” and ‘cyrusoft’.
When you use the ‘Starts with’, “‘Ends with’ or ‘Contains’ options for the ‘Contains’
popup menu, Mulberry automatically includes a “* in the appropriate place for the
search. E.g. assuming the text field is set to “search’

— ‘Starts with’: actual text searched “search®’.
— ‘Ends with’ : actual text searched “*search’.

— “‘Contains’ : actual text searched “*search™.

5.11.2 Buttons

The button section contains the following buttons:

246

Search - initiates a search using the criteria provided.
Clear — removes all search results from the results list.

Message — creates a new draft message with its address fields automatically filled in
with any selected entries in the results list. There are two ways to use the Message
button which depend on whether the Option (Mac OS), Alt (Windows) or Ctrl (Unix)
key is held down when clicking the button or not. The choice of action is determined by
the “Addresses’ preference panel (see page 84).

* In one case a new draft message window is automatically created with its “To:’
address field filled in with the selected entries in the active list.

* In the second case Mulberry will display a dialog (similar to the one shown in Figure
109) which allows you to choose which addresses from the selection in the active list
are to be used in the draft message and in which address fields they should appear.
You can choose where to put each address in the draft message by clicking on or off
one of the diamond buttons next to the address. Once the required choice is made,
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click the New Message button or press return to create a new draft message with
the requested addresses automatically filled in.

5.11.3 Column Headers

The column headers indicate what address information is displayed in each column in the
list below it.

Mac OS X To change a category, or to insert a new category, or to delete an existing
category click the mouse button with the command (3) key down (3 -click)
on the category title.

WINDOWS To change a category, or to insert a new category, or to delete an existing
UNIx category click the right mouse button on the category title.

When you do this the menu shown in Figure 125 will appear giving you the choice of what
category to show in the corresponding column. You can also insert a new column before
or after the one clicked, or delete the column that was clicked.

¥ Full Name (Smart Sort)
Full Name (Simple Sort)
Mick-Name
Email Address
Company
Address
Phone Work
Phone Home
Fax
URLs
Motes

Insert Column after
Insert Column before
Delete Column

Figure 125 The pop-up menu used to change column information in the
address search window

The ‘Smart Sort” option for ‘Full Name’ will cause Mulberry to sort the addresses using the
full name, but it will attempt to format the name into ‘First Last’ and sort first by the ‘Last’
text, then the ‘First’ text. The ‘Simply Sort” option for ‘Full Name” will cause Mulberry to
sort addresses using the full name text without any special formatting changes.
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5.11.4 Results

The results lists shows results of searches. Each search is shown in its own hierarchy, with
the hierarchy row shown in gray, and with a description of the search criteria used to
generate that particular set of results. You can collapse or expand a hierarchy by clicking on
the disclosure button next to the description.

The search results will not be deleted when the window is closed, but they will be lost
when quitting from Mulberry. You can remove all the results using the Clear button. You
can delete an entire hierarchy by selecting the hierarchy description row and pressing
delete. You can delete individual search results by selecting them and pressing delete.

Each address can be edited by double-clicking on the address entry. This will display the
dialog shown in Figure 128, which can be used to edit the address.

Addresses in the results table can be copied to an address book or to a draft window

address field either through the clipboard Copy and Paste functions, or by using drag and
drop to drag the addresses of interest to their destination.

5.11.5 Reference
SEARCHING ADDRESS BOOKS

To bring the Address Search  Choose Search... from the
window to the front Address menu.

Click the Search button in the
Address Book Manager
window.

To start a new search Click the Search button.

Press return or enter on the
keyboard after entering text in
the text field.

To delete all search results Click the Clear button.

Press clear on the keyboard.

To delete selected search result Press delete on the keyboard.
sets

To delete selected individual Press delete on the keyboard.
address search results

To change one or more Double-click the selected
selected individual address address, or press return or
search results enter on the keyboard.

To create a draft message Choose New Message from

using one or more selected

the File menu or press
addresses or groups

Command-N (Mac OS X),

CtrI-N (Windows), or Meta-N
(Unix).
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Click the Message button in the
address book window.

To copy one or more selected
addresses to a draft message

Choose Copy from the Edit

menu or press Command-C
(Mac OS X), Ctrl-C (Windows)

or Meta-C (Unix), go to the
address in the draft message and

choose Paste from the Edit

menu or press Command-V
(Mac OS X), Ctrl-V (Windows)

or Meta-V (Unix).

Drag the selected items to the
address field in the draft
message window.

(This feature is only available if Drag
and Drop is supported)

To add one or more selected
addresses to an address book

Choose Copy from the Edit

menu or press Command-C
(Mac OS X) or Ctrl-C (Windows)

or Meta-C (Unix), go to the
address book window choose

Paste from the Edit menu or
press Command-V (Mac OS X)

Ctrl-V (Windows) or Meta-V
(Unix).

Drag the selected items to the
single address table in the
address book window.

(This feature is only available if Drag
and Drop is supported)

Drag the selected items to the
address book listed in the
Address Book Manager
window.

(This feature is only available if Drag
and Drop is supported)
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5.12 Address Book Pane/Window

i) imsp:vince g
¥ Hide Addresses & Add | A New Message to
Full Name |Err|:|il Address
&, A Friend friend®example.com
&, First Customer customer@exmaple.com
E, Happy Customer happy@example.com
E_-‘, somebody Else somebody®example.com
¥ Hide Groups & Add |4 New Message to
> & group
P & ISAMET, Inc.
» & Mailing Lists
P K sites
Addrasses: 4 Groups: 4

Figure 126 A typical address book window

Figure 126 shows a typical address book pane. Address books allow you to store
commonly used email addresses and groups of addresses. Address books can either be
stored locally on the computer running Mulberry, or remotely on a server. Address books
are managed using the Address Book Manager pane/window.

You can assign ‘nick-names’ to addresses and groups, which you can then enter in address
fields in draft message windows. Mulberry will automatically substitute the correct email
address when it sends the message.

Note Nick-name resolution only works if the address book
containing the nick-name has been marked for nick-name
resolution in the Address Book Manager pane /window.

You can specify any number of address books to be opened when a preference set is
opened by turning on the ‘Open at Startup” option for the address book in the Address
Book Manager window.
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An address book pane is divided into three main sections:
* The single address list section shows the list of single addresses in the address book.

* The group list section shows a hierarchical list of groups with their corresponding
addresses.

e The address or group preview area.

In the address book pane, either the address list section or the group list section is active at
any time. The active list has a highlight border around it. Some toolbar buttons and menu
commands operate on the active list only.

5.12.1 Toolbar Buttons

The address book window has a toolbar associated with it, whereas the address book pane
in the 3-pane window uses the toolbar in the 3-pane window.

The address book window toolbar contains the following items:

; Create a new draft window to allow you to compose a new message.
M See section 5.12.1.1 below for a full description of what this button
Draft will do.

O Creates a new address.
Single

: . Creates a new group.

Group

L% Edits the selected addresses or groups.
Edit

Q Deletes the selected addresses or groups.
bk
Delete

Table 8 The Address Book Window Toolbar

5.12.1.1 Creating Messages with the Address Book

The Draft toolbar button is used to create a new draft message with its address fields
automatically filled in with any selected entries in the active list. There are two ways to use
the Draft button which depend on whether the Option (Mac OS X), Alt (Windows) or
Control (Unix) key is held down when clicking the button or not. The choice of action is
determined by the ‘Addresses’ preference panel (see page 84).

* In one case a new draft message window is automatically created with its “To:” address
field filled in with the selected entries in the active list.
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In the second case Mulberry will display a dialog (similar to the one shown in Figure
109) which allows you to choose which addresses from the selection in the active list are
to be used in the draft message and in which address fields they should appear. You can
choose where to put each address in the draft message by clicking on or off one of the
diamond buttons next to the address. Once the required choice is made, click the OK
button or press return to create a new draft message with the requested addresses
automatically filled in. If there are any drafts currently open, those will appear in the
Add to Draft popup menu. If you select an existing draft from that popup, the
addresses will be added to the corresponding fields in that draft, rather than a new one
being created.

5.12.2 Single Address List

The single address list shows single addresses in the address book. The single address list
has a set of column headers that can be used to determine what type of information is
displayed as well as the sort order for the list data.

5.12.2.1 Column Headers

The two pop-up menus are used to determine what information is shown in the single
address field and what method of sorting is used to display the addresses. The menu
choices are shown in

Column headers can be re-arranged, added, or deleted.

Mac OS X Hold down the control key and click the mouse button (ctrl-click) on a

column header to change the column type, insert a new column, or delete

the column.
WINDOWS Click the right mouse button on a column header to change the column
UNix type, insert a new column, or delete the column.

When you do this, the menu shown in Figure 127 will appear.
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v Full Name (Smart Sort)
Full Name (Simple Sort)
Mick-Name
Email Address
Company
Address
Phone Work
Phone Home
Fax
URLs
Notes

Insert Column after
Insert Column before
Delete Column

Figure 127 The pop-up menu for changing column headers in the address
book pane

Creating a New Address

To create a new entry in the single address list, first make sure it is active by clicking inside
it and then click the New button in the address book header. This will display the dialog
shown in Figure 128. Enter the values you desire and then click OK. The ‘Nick-name’ field
can be used as an alias for the email address. This can be entered in any draft message
window and Mulberry will resolve the nick-name to its proper email address provided the
address book containing it is open.
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Address Edit

Full Mame: First Customer Phone Work: +1 412 &05 0000
Mick-Mame: cust] Fhone Home: +1 412 605 0000
Email: customer@exmaple.com Fax: 41 412 605 0000

Company: Email Ltad

Address:| 2821 SMTP Drive,
Protocol Parkway,

Hame Town,
RFC 2822

URLs:| http:/fwww.mulberrymail.com/mulberry

Motes:| First ever Mulberry customer.
Hopefully very satisified.
